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1. Allgemeine Infos fur Ubungen mit ArcGIS

1 Allgemeine Infos fiir Ubungen mit ArcGIS
1.1 Version von ArcGIS

Die Erklarungen und Abbildungen in dieser Anleitung beziehen sich auf das Produkt
ArcGIS 9.3 Service Pack 2.

1.2 Einloggen

Einloggen in den Computerraumen des Departement D-BAUG.
Studenten vom D-BAUG:

Mit eigenen Benutzernamen und Passworter
Andere:

Login werden von den Assistierenden verteilt.

1.3 Daten speichern

Zu Beginn jeder Ubung missen die Daten lokal auf dem Computer gespeichert
werden: Im Windows-Explorer den ganzen Ordner mit den Daten der Ubung von U:
auf die Festplatte C:\temp kopieren.

Normalerweise kann ArcGIlS muhelos auf Daten eines beliebigen Netzlaufwerks
zugreifen. Es wurde jedoch festgestellt, dass es in den Ubungsraume des D-BAUG’s
ab und zu zu Problemen kommt, wenn man auf Daten zugreifen will, welche in den
personlichen Ordner der Studierenden (Z:\) abgespeichert sind. Daher empfehlen

wir die Daten auf eine lokale Festplatte (z.B. C:\Temp) zu speichern.

1.4 Die einzelnen Programme vom ArcGIS-Desktop-Paket starten

Das ArcGIS-Desktop-Paket enthalt verschiede Softwarepakete (siehe Kapitel 2.1),
die alle unabhangig voneinander gestartet werden koénnen. Sie befinden sich im
Start Menlu - Programs > 08 GIS - ArcGIS.

Anschliessend den Namen der gewiinschten Software des ArcGIS-Pakets (zum

Beispiel ArcMap Q ArcCatalog 4‘;', ArcScene kD ...) auswahlen.

1.5 Benennung der Dateien

ArcGIS unterstitzt nur teilweise spezielle Zeichen (&, U, é usw.) und Leerschlage in
den Namen der verschieden Dateien (Geodatabase, Features, Shape, usw.). Das
heisst, dass die Namen der Dateien zwar solche Zeichen und Leerschldge enthalten
kann, dann aber einige Prozesse mit diesen Dateien nicht gestartet werden kdnnen.

Daher ist es zu empfehlen, ohne spezielle Zeichen und ohne Leerschlage zu arbeiten!
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1.6 Online-Hilfe

Fur alle Probleme und Fragen steht eine ausfuhrliche Online-Help zur Verfugung:

Help = ArcGIS Desktop Help.

1.7 Links

Gruppe Geoinformationssysteme und Fehlertheorie, ETH Zlrich:
http://www.gis.ethz.ch
Aktuelle Version dieser Anleitung:
http://www.gis.ethz.ch/education/Anleitung_ArcGIS
ESRI, Hersteller ArcGIS:
http://www.esri.com
http://esri-germany.de

http://esri-suisse.ch
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2 Einfihrung in ArcGIS von ESRI'

ArcGIS ist der Name einer Produktfamilie von aufeinander abgestimmten GIS

Produkten und Entwicklungswerkzeugen der Firma ESRI.

ArcGIS 9
Desktop GIS Embedded GIS Server GIS Mobiles GIS
ArcGIS Desktop ArcGIS Engine ArcGIS Server ArcIMS ArcGIS Mobil
ArcPad
ArcView ArcEddor EI | ] 3

] Vs —]

A A
Nutzerspezifische ‘ o |
Arcinfo PrcReaded Amwendungen Web Templates )

Custom Templates

+ ArcGIS Erweiterungen
Desktop Engine Server Anpassbar mat Anpassbar mit
Development Kit Development Kit Development Kit e i XML+

NET VBScript
NET C++ VB NET C++ VB Java JAVAADF NETADF Ce+ = ArcPad Application
Builder
= - - APls for
= Java
ArcObjects | IR ActiveX (ASP)

4 : : ; ’ 2 / L : JSP

GIS Objekte und aggregierte Komponenten ColdFusion

ArcSDE

| ——
Geodatabase 1 B

; XML
Dateien DBMS

2.1 ArcGIS Desktop

ArcGIS Desktop umfasst eine Reihe integrierter Anwendungen, u. a. ArcCatalog,
ArcMap, ArcGlobe, ArcToolbox und ModelBuilder. Mit diesen Anwendungen und
Schnittstellen kénnen Sie beliebige, einfache oder komplexe GIS-Aufgaben erfullen,
wie beispielsweise das Erstellen von Karten, raumbezogene Analysen,

Datenbearbeitung und -umwandlung, Visualisierung sowie Geoverarbeitung.

211 ArcGlIS Desktop Lizenzierung

ArcGIS Desktop lasst sich an die unterschiedlichsten Anforderungen der Benutzer

anpassen und steht in drei Lizenzierungsebenen zur Verfugung:

1 Quelle: http://esri-germany.de
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e ArcView ist fur eine umfassende Datennutzung, Kartenerstellung und Analyse
geeignet.

e ArcEditor bietet zusatzliche Funktionen zur raumbezogenen Bearbeitung und
Datenerstellung.

e Arcinfo ist ein kompletter professioneller GIS-Arbeitsplatz, der umfassende
GIS-Funktionalitat und zahlreiche Geoverarbeitungswerkzeuge zur Verfigung
stellt.

Die Lizenzierung wird im ArcGIS Desktop Administrator 2 eingestellt. Dieses
Fenster kann uUber folgenden Pfad gedffnet werden: Start Meni -> Programs ->
08 GIS > ArcGIS > Desktop Administrator.

Fur die Einstellung der Lizenzierung mussen alle Programme von ArcGIS

geschlossen werden.

£k ArcGIS Desktop Administrator F I
= B AcGlo-DesmepdGPGIS3)
Select the software product to be used for you AIcGIS
Sl wdbﬂs:

(] Availability

C ArcView [Floating

Jeder Arbeitsplatz kann mithilfe zusatzlicher Erweiterungen zu ArcG1S Desktop von
ESRI und anderen Herstellern um weitere Funktionen ergédnzt werden. Benutzer
kénnen auch unter Verwendung von ArcObjects, der ArcGIS
Softwarekomponentenbibliothek, eigene Erweiterungen fir ArcGIS Desktop
entwickeln. Zur Entwicklung von Erweiterungen und benutzerdefinierten Werkzeugen
kénnen Standardprogrammierumgebungen fir Windows wie Visual Basic® (VB),

.NET, Java und Visual C++ verwendet werden.

212 ArcMap

Datenerfassung, Analyse und Kartografie

ArcMapQ ist die zentrale Anwendung innerhalb ArcGIS Desktop. Fur alle
interaktiven Arbeiten mit Karten, sei es die Datenerfassung, die Analyse, die
Vorbereitung zur Ausgabe oder die Verknupfung mit anderen Informationen und
Medien, steht ArcMap. Bestehende Funktionsgruppen wie Editieren und optionale
Erweiterungen, wie ArcGIS Spatial Analyst, werden in ArcMap als eigene Menus
und als Toolsets in ArcToolbox eingebunden und nur bei Bedarf ein- oder

ausgeblendet — stets Ubersichtlich.
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ArcToolbox und ModelBuilder sind in ArcMap integriert. Berechnungsergebnisse
kénnen direkt der kartografischen Ansicht hinzugefiigt werden. Umgekehrt kdnnen
Datenséatze aus der Legende per Drag & Drop direkt in Werkzeuge oder Modelle
eingefligt werden.

In ArcMap gibt es neben der Datenansicht auch einen Layout-Modus, in dem Sie
kartografische Ansichten fur die Ausgabe auf Drucker/Plotter oder in diversen Grafik-
Formaten erstellen.

Diese konnen Legenden, grafische Elemente und naturlich einen bis mehrere
Kartenausschnitte beinhalten. Auch in dieser Ansicht kdnnen Sie alle Funktionen von

ArcMap nutzen.
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213  ArcCatalog

Ordnung fur die Daten

ArcCatalog & hire Ilhnen, lhre Geodaten zu strukturieren, zu verwalten und zu
dokumentieren.

Mit ArcCatalog erhalten Sie Routinen zum Suchen und Durchsuchen von Geodaten
sowie zur Erfassung und FortfUhrung von Metadaten. Auf Wunsch kdénnen Sie jeden
Datensatz in einer Vorschau sehen und beliebig viele Ansichten der Daten
generieren, die dann je nach Einsatzzweck in ArcMap eingebunden werden.

Auch komplexere Datenmodelle sowie die Eigenschaften, Attribute, Wertebereiche

und Beziehungen von Geodaten untereinander werden in ArcCatalog definiert.
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Katalog

a Folder Verbindung

(Ordner)

Folder

_a Geodatabase

—% Coverage

Shapefile

Achtung: Datensatze konnen nur in ArcCatalog erstellt und restlos geldscht

werden.

21.4 ArcToolbox

Alle Werkzeuge fur die Geoverarbeitung lbersichtlich angeordnet

ArcTooIbox% ist der Werkzeugkasten, in dem die in ArcGIS enthaltenen
Werkzeuge tUbersichtlich zusammengefasst und angeordnet sind.

Die Anzahl der in ArcToolbox enthaltenen Werkzeuge ist abhangig vom
eingesetzten Produkt (ArcView, ArcEditor oder Arclnfo) und Erweiterungen (Spatial
Analyst, 3D Analyst, Geostatistical Analyst). ArcView ohne Erweiterungen enthalt
159 Werkzeuge. In der maximalen Ausbaustufe (Arcinfo mit allen Erweiterungen)

stehen in ArcToolbox 495% Werkzeuge zur Verfiigung.

2 Bei jeder neuen Version von ArcGIS kommen wieder ein paar Werkzeuge zur
ArcToolbox dazu. Die Zahlen, die hier gegeben sind, entsprechen der Anzahl

Werkzeuge der Version 9.1.
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i3 ArcToolbox

@ @ 3D Analyst Tools

- &P Analysis Tools

[+] % Cartography Tools

[+ a Conversion Tools

# & Coverage Tools

&P Data Management Tools
@ @ Geocoding Tools

£3) % Geostatistical Analyst Tools
+ & Linear Referencing Tools
[+ % Spatial Analyst Tools

) & Spatial Statistics Tools

Favorites | Index | Search |

Hier einige Beispiele und ihre Funktionen:
e Analysis Tools: Daten extrahieren, verschneiden, Oberflachenanalyse,
statistische Berechnungen
e Conversion Tools: arbeiten mit unterschiedlichen Formaten
o Data Management Tools: Routen und Regionen erzeugen, generalisieren und
arbeiten mit Tabellen
e My Tool: eigene Werkzeugsammlung
Jedes Werkzeug in der ArcToolbox steht fur eine Funktion, die auf funf
unterschiedliche Weisen angesprochen werden kann:
e Als Dialog/Eingabemaske
e In der Kommandozeile
e Integriert in ein Skript
e Eingebettet in ArcObjects-Programmierung

¢ Kombiniert zu Prozessmodellen im ModelBuilder

21.5  Andere Anwendungen in ArcG/S Desktop

ArcGIS Desktop enthalt zuséatzliche Programme, wie zum Beispiel ArcReader '*5

ArcGlobe @ ArcScene LE usw.

2.1.6 ModelBuilder

Die interaktive Umgebung zur Erzeugung von Prozessmodellen

Etliche ArcView-Anwender kennen das Prinzip bereits aus Spatial Analyst unter
ArcView GIS 3.x: Einzelne Prozessschritte werden zu einem Funktionsmodell
zusammengefasst und kdénnen so mit leicht veranderten Parametern mehrfach

aufgerufen werden - das alles ohne eine Zeile zu programmieren. Dieses Konzept
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wird jetzt auf alle ArcGIS Desktop-Produkte und auf alle Funktionen des jeweiligen
Produktes ausgedehnt.

Modelle kdénnen neben den eigentlichen Funktionen, den Ausgangs- und
Prozessdaten auch Bedingungen, Parameter und Variablen enthalten.

Modelle kdnnen ineinander verschachtelt sein. Das heil3t, ein Prozessschritt in einem
Modell kann in Wahrheit ein komplettes zweites Modell sein. Modelle kdnnen als
Prozessschritte auch Skripte oder externe Anwendungen enthalten.

Modelle kénnen in der Geodatabase und in dateibasierten Toolboxes abgespeichert
und so mit den zugehdrigen Daten auch weitergegeben werden.

Die Anwendung ModelBuilder beinhaltet alle Funktionen fur die Dokumentation der

erstellten Modelle und die Anbindung an eine Online-Hilfe.

2.1.7 Funktionalitdten

In der folgenden Tabelle wird gezeigt, welche wichtigen Funktionalitdten einer GIS-

Software in welchem Programm von ArcGIS verfugbar sind:

ArcCatalog ArcMap ArcToolbox

Datenimport/Export X
Datenerfassung X
Datenorganisation (Metadaten) X

Datenmanipulation (Vektor, Raster)
Datenvisualisierung

Datananalyse (Vektor, Raster)

X X X X

Tabellenmanipulation X

2.1.8 Wie alles zusammenarbeitet

ArcMap, ArcCatalog und ArcToolbox sind so aufgebaut, dass sie in idealer Weise
zusammenarbeiten und die ganze Breite der GIS Funktionalitat abdecken.

So kdnnen Sie zunédchst in ArcCatalog ein Kartendokument nach bestimmten
Kriterien suchen. Mit einem Doppelklick auf das Dokument 6ffnen Sie automatisch
ArcMap und das Dokument wird geladen. Jetzt editieren Sie Daten, analysieren
diese oder erstellen eine neue Karte. Wenn Sie hierfur eine weitere Datenebene
bendtigen, werden Sie diese erneut in ArcCatalog suchen und dann per Drag &
Drop in lhre Darstellung in ArcMap aufnehmen.

Es muss jedoch beachtet werden, dass eine Datei, wenn sie von einem Programm
des ArcGIS-Packets geodffnet ist (z.B. ArcCatalog), nicht in einem anderen

Programm des Packets (z.B. ArcMap) verandert werden kann.
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Genauso kdnnen Sie den gefundenen Geodatensatz per Drag & Drop an eines der
Werkzeuge in ArcToolbox ubergeben, um ein Shapefile beispielsweise Ihrer
Personal Geodatabase flr dieses Projekt zuzufiigen.

Geht es um mehr als eine einzelne Funktion, so setzen Sie in der Anwendung
ModelBuilder aus Daten und Werkzeugen lhre gewtnschten Workflows zusammen.
Alle Modelle und Prozessschritte kbnnen Sie in ModelBuilder mit einem integrierten
Editor XML-konform dokumentieren.

Auch in ArcCatalog nutzen Sie abschlieBend den Metadaten-Editor, um die neu
erzeugten Daten, Karten und Datensétze in der Geodatabase nach lhrem eigenen
Schema oder I1SO-konform zu dokumentieren.

Wenn Sie lhr Projekt auch anderen zur Verfugung stellen wollen - mit ArcReader
existiert ein kostenfreier Viewer zur Ansicht, Abfrage und Ausgabe aufbereiteter

Kartendokumente.

2.1.9 ArcGlS Erweiterungen (Extensions)

Die ArcGIS Erweiterungen sind Funktionsgruppen, die bei bestimmten
Anwendungen zusatzlich geladen werden und dann in der Oberflache zur Verfigung
stehen. Im Rahmen unserer Ubungen werden wir folgende Erweiterungen
verwenden:

e Spatial Analyst: Eine Erweiterung im Bereich der Rasterfunktionalitat. Diese
Erweiterung stellt eine grosse Palette von Funktionen zur raumlichen
Modellierung und Auswertung zur Verfugung.

e 3D Analyst: Die Erweiterung ArcGIS 3D Analyst erlaubt es dem Benutzer
Oberflachendaten zu erzeugen, diese zu analysieren, modifizieren und
visualisieren. Dazu gehoéren Oberflachenberechnungen durch
Interpolationsverfahren, Oberflachenanalysen (Neigung, Exposition,
Schummerung, ...), Berechnung von Profilen, ...

e Network Analyst t: Auf einem definierten und erzeugten Netz kdnnen
verschiedene Analysenfunktionen angewandt werden, wie z.B. Routensuche,
Zuordnung von Lokationen zu Einrichtungen, Erstellen von Servicebereichen,
Errechnen von Kostenmatrizen

e Geostatistical Analyst: Analyse Geostatistischer Daten

e Informationen zu den weiteren Erweiterungen unter:

http://www.esri.com/software/arcgis/about/desktop_extensions.html
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Wie Erweiterungen aktiviert und deaktiviert werden kdénnen, ist im Kapitel 4.9

erklart.

2.1.10 Datenformate

2.1.10.1 Geodatabase

Das Geodatabases (Kurzform fiur ,geographic database”) Modell ist ahnlich wie
Coverages und Shapefiles in der Lage, verschiedene Objektstrukturen in Ebenen zu
verwalten, fligt aber noch zusatzliche Mdoglichkeiten hinzu. So kdnnen beispielsweise
Z-Werte (dritte Dimension) und M-Werte (ortsbezogene Messwerte) gefuhrt werden.
Echte Kurven sind ebenso abbildbar wie komplexe Netzwerke und die Beziehungen
einzelner Datenebenen untereinander. Eine vereinheitlichte Form der Speicherung
von Rasterdaten ist ebenfalls Bestandteil der Geodatabase. Hier kdnnen neben den

Daten auch die Beziehungen zwischen Datenebenen abgebildet werden.

Ej GEODATABASE

TP reature pATASET... &

[
=]

FEATURE (

[

FEATURES ATTRIBUTES

TABELLE

Eine Geodatabase ist eine Datenbank fiir ein selbststandiges Projekt. Einige Vorteile
einer Geodatabase:
e Definiert ein generisches Modell fur geografische Information und alle Daten
sind in einer Datenbank gespeichert
e Erlaubt die Erstellung von benutzer- und applikationsspezifischen

Datenmodellen
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Gibt die Moglichkeit eines hohen Strukturlevels, vergleichbar mit dem

Konzeptionellen Madell

Unterstitzt ein objektorientiertes Vektordatenmodell aus folgenden

Bestandteilen:

o Feature Classes

0 Beziehungen

0 Topologieregeln

0 Projektionssysteme

0 Geografische Netzwerke

Die geografischen Grenzen und das Koordinatensystem werden definiert

Die Datenerfassung ist genauer, in doppelter Hinsicht:

o wegen der koordinatenméssigen Festlegung des Arbeitsgebietes
(X/Y-Domain)

0 wegen den Konsistenzbedingungen (Topology, Subtyp, Domain und

Beziehungen)

Die abgespeicherten Daten werden in drei Klassen unterteilt: Feature Classes,

Feature Datasets ] und Object Classes. Eine Feature Class ist eine Geoobjektklasse.

Feature Classes mit gemeinsamem Raumbezug kdénnen zu einem Feature Dataset

zusammengefasst werden.

2.1.10.2 Weitere grundlegende Datenformate

Shapefiles: Objekte (enthalt entweder Punkte, Linien oder Flachen)
Coverages: Gruppierte Objekte um Topologie zu speichern
CAD: Sammlung von Objekten

Grid: Zellenrasterdaten
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3 Das Programm ArcCatalog

3.1 ArcCatalog starten

Das Programm ArcCatalog kann auf verschiedene Arten gedffnet werden:
e Uber das Start Menii = Programs = 08 GIS - ArcGIS > ArcCatalog h.**'

e Uber den Button Launch ArcMap \*—' im Programm ArcMap

3.2 Aufbau

Das Programmfenster von ArcCatalog besteht aus den Toolbars, aus dem Catalog

Tree und aus den Tabs Contents, Preview und Metadata.

Hauptmen —
Toolbar w2 BY L HE e aen-w adq
Toolbars —-§ = == E

Metadata
Preview

Catalog Tree Contents

3.21 Toolbars (Werkzeugleisten)

Die verschiedenen Programme von ArcGIS enthalten alle per default einige Toolbars
(Werkzeugleisten). Oft sind jedoch zusatliche Toolbars nétig um gewisse Arbeiten zu
machen. Siehe Kapitel 4.10 um Toolbars ein- oder auszublenden.

Toolbars sind eine themenabhangige Sammlung von Funktionen und Befehlen, um
bestimmte Aufgaben losen zu kénnen. Die Hauptmenu-Toolbar besteht aus einigen
Menu-Befehlen (z.B. File, Edit, View etc.). Die anderen Toolbars bestehen meistens
aus verschiedenen Buttons. Toolbars kdnnen entweder als eigenes Fenster auf dem
Bildschirm angezeigt werden, oder beim Hauptfenster im oberen, unteren oder
seitlichen Teil angedockt sein. Die ,,angedockten* Toolbars kénnen durch Klicken und
gedruckt halten der linken Maustaste im vorderen Bereich der Toolbar gefasst und

verschoben werden.
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3.2.2 Catalog Tree

Der Catalog Tree erinnert mit seiner Baumstruktur an den Windows Explorer. Hier
werden Links auf Verzeichnisse im Netzwerk angelegt. So kann auf diese

Verzeichnisse zugegriffen werden ohne dass man sich immer durch die ganzen
Ordner klicken muss. Mit dem Button Connect to Folder 9 kénnen diese
Verbindungen hergestellt und mit dem Button Disconnect From Folder =3 wieder

entfernt werden. Mit dem Button Up One Level B kann man in der Baumstruktur im
Catalog Tree um eine Hierarchiestufe nach oben gehen.
Der Catalog Tree kann Uber das Meni Window - Catalog Tree ein- und ausgeblendet

werden.

3.2.3 Contents

Hier wird der Inhalt des im Catalog Tree ausgewahlten Verzeichnisses angezeigt.

3.24 Preview

Unter Preview erhalten Sie eine kleine Vorschau auf die Datei. Dabei kdnnen Sie
unter der Option Preview unterhalb des Datenfensters zwischen der graphischen
Darstellung (Geography, 3D View oder Globe View) oder der Attributtabelle (Table)

auswahlen.

Preview: [Geograph)- LI
Globe View
iU View
Table
Geography

3.25 Metadata

Unter Metadata® befinden sich die Daten Uber die Daten: Das sind z. B.
Informationen (Uber das Koordinatensystem, die raumliche Ausdehnung, die
Attribute, der Ersteller....

Um diese Metadaten zu erstellen oder zu bearbeiten, kann die Metadata Toolbar

verwendet werden.

3 Metadaten sind ,Daten uUber Daten“ d.h. sie geben Auskunft tber die Existenz von
Datensatzen, deren Inhalt und Qualitat. Die Dokumentation kann sich auf eine ganze
Datenbank, einen Datensatz oder ein individuelles Datenobjekt beziehem. Je genauer die
Metadaten sind desto weniger Probleme entstehen bei der Datensuche oder Datenintegration.
Zur Beschreibung der Metadaten gibt es nationale (Interlis) und internationale (ISO, FGDC)
Standards, welche berucksichtigt werden kénnen.
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Metadata

]

Sylesheet: [FCELINNNNN -] 4 5 @

AL

el

Unter Edit Metadata kbn,ﬁ1 die Metadaten verandert werden.
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4 Das Programm ArcMap
4.1 ArcMap starten

Das Programm ArcMap kann auf verschiedene Arten gestartet werden:
e Uber das Start Menii = Programs = 08 GIS = ArcGIS > ArcMap Q
e Uber den Button Launch ArcMap Q in den Programmen ArcCatalog,
ArcScene und ArcGlobe

e Durch Offnen eines bestehenden ESRI ArcMap Dokuments (.mxd)

Pro geotffnete ArcMap-Session lasst sich jedoch nur ein einziges ArcMap
Dokument bearbeiten. Ein gedffnetes ArcMap Dokument muss also gespeichert
und geschlossen werden, bevor ein anderes in der gleichen Session ged6ffnet werden
kann. Um trotzdem mehrere ArcMap Dokumente gleichzeitig anzeigen zu kdnnen,
muss das Programm ArcMap ein weiteres Mal auf eine der drei oben beschriebenen

Arten gestartet werden.

Nach dem Starten des Programms ArcMap erscheint ein Dialogfenster. In diesem
kann ausgewahlt werden, ob eine neue Karte (A new empty map), eine Vorlage
(A template) oder ein bestehendes ArcMap Dokument (An existing map) getffnet

werden soll.
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[ h'
Q ArcMap ﬁ

Start using ArcMap with

Q) Enew emply map

g " Atemplate

Templates provide ready-to-use layouts and base maps for
various geographic regions.

é (" An existing map:

Browse for maps... -

m

[~ Immediately add data
[~ Do not show this dialog again 0K
[~ Load last map on startup

b A

Durch Aktivieren des Feldes Immediately add data konnen die Daten direkt bei der
Erstellung oder beim Laden eines Projektes hinzugefugt werden (siehe auch Kapitel
4.5.1).

Falls man nicht will, dass dieses Dialogfenster jedes Mal beim Offnen des Programms
ArcMap erscheint, kann man es durch Setzen eines Hakchens bei der Option Do not
show this dialog again deaktivieren.

Wahlt man die Option Load last map on startup, so wird beim Starten des
Programmes ArcMap immer automatisch das Projekt geladen, an welchem man

zuletzt gearbeitet hat.

4.2 Aufbau

Die Benutzeroberflache des Programms ArcMap besteht neben den Toolbars aus

einem Karten- und einem Legendenteil, der sogenannten Table of Contents.
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Hauptmeni
Toolbar

Toolbars

Table of
Contents

Karte

Anzeitemodi
(Quelle/Anzeige)

1N

——————ra =
Toolbars»l Diwngv k (163 0 A~ Z|[ah ][ ] B L O|[A~ Sl =~

4.21 Die Toolbars

Siehe Kapitel 3.2.1.

4.2.2 Der Legendenteil TOC (Table of Contents)

Im Legendenteil Table of Contents, kurz TOC, werden die getffneten Datensatze und
die dazugehorigen Legenden aufgelistet.
Diese geladenen Datensatze werden als Layer® (dt. Schicht, Ebene) bezeichnet.

4.2.21 Tables of Contents ein- und ausblenden

Die Table of Contents kann Uber das Menu Window - Table Of Contents ein- und

ausgeblendet werden.

4.2.2.2  Anzeigemodi

Drei Anzeigemodi stehen zur Verfiigung:

4 Ein Layer ist eine Datenebene. Er enthélt eines oder mehrere Objekte (Features), welche die
reale Welt abbilden.
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Der Display-Modus listet alle Layer auf, die
darstellbare Vektor- oder Rasterdaten enthalten (z.B.
Punkt-, Linien- oder Flachengeometrien). Die
Sichtbarkeit der Layer wird durch die Reihenfolge
bestimmt, in der sie aufgelistet sind: Je weiter oben
ein Layer in der Liste aufgefihrt ist, desto weiter im
Vordergrund werden seine zugehorigen Geometrie-
daten in der Karte dargestellt. Die Layer kénnen durch
Drag & Drop neu angeordnet sowie gruppiert werden
(siehe Kapitel 4.6.4).

= £ layers

B Bergspitze
°

= Fluesse

= M Gebaeude

MNutzung

[ Dienstleistungen
[ Uebernachtung
[]Wohnen

[] unbestimmt

_Display [ Source | Selecton

Im Source-Modus werden alle Daten aufgelistet, die
im aktuellen ArcMap Dokument verwendet werden.
Zusatzlich zu den Layern aus dem Display-Modus
werden auch Datenquellen angezeigt, welche nicht
kartographisch darstellbar sind (z.B. Tabellen mit
Sachdaten). In diesem Modus sind zudem die Pfade
aller geladenen Daten und, falls diese in einer
Geodatabase abgelegt sind, auch ihre Struktur
ersichtlich.

Wenn eine Tabelle (engl. Table) geladen wird,
wechselt ArcMap automatisch in diesen Modus.
Achtung: Die Reihenfolge der Layer ist hier nach
Datenquelle geordnet und entspricht nicht der
Darstellungsreihenfolge. Die Elemente kdnnen nicht

durch Drag&Drop verschoben werden.

& B z\daten\Adelboden.gdb
= O TOURISMUS
= [ Bergspitze
*
= @ Gebaeude
MNutzung
[] Dienstleistungen |E
[ Uebernachtung
[C]1Wohnen
[] unbestimmt
= P ABIOTISCHE_UMWELT
B Fluesse

T Betreiber

= £ layers o

Display Source | Selection |
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Der Selection-Modus erlaubt eine  einfache
Verwaltung der Selektierbarkeit der Layer. Ein
Hakchen vor einem Layer bedeutet, dass dieser Layer
selektierbar ist, d.h. die Geometrien dieses Layers
lassen sich mit Hilfe des Buttons Select Feature der
Toolbar Tools oder Uber das MenlU Selection - Select
by Graphics auswahlen (diese Layereigenschaft ist
auch Uber das Menu Selection > Set Selectable Layers X

M Bergspitze
verfugbar). Ist der Name des Layers fett geschrieben, O Fluesse

Bl b d 1100
& UE0atudT L3

bedeutet das, dass in diesem Layer Objekte selektiert
sind. Die Anzahl der selektierten Elemente steht in | "5 souce selection
Klammern hinter dem Namen. Mit Rechtsmausklick auf o
den Namen des Layers kdnnen Optionen zum L&schen
der Selektion des Layers oder zum Erstellen eines
neuen Layers mit den selektierten Elementen etc.
geo6ffnet werden.

Im Selection-Modus werden nur die Layer des aktiven

Data Frames aufgelistet.

4.2.3 Der Kartenteil

Der Kartenteil ist ein Fenster, in welchem die geladenen und aktivierten Daten
angezeigt werden. Dabei kann zwischen zwei Ansichten gewahlt werden, der Data

View und der Layout View.

4.2.3.1  Woechsel zwischen Data View und Layout View

Wenn ein neues Projekt in ArcMap geotffnet wird, befindet man sich per Default in

der Data View. Man kann unter View - Layout View oder mit Hilfe der Buttons 20

unterhalb des Kartenfensters zwischen der Data View und der Layout View wechseln.

4.2.3.2  Unterschiede zwischen Data View und Layout View

Die Data View ist fur die Vorbereitung und die Analyse von Daten gedacht. In der
Data View werden Daten editiert und ausgewertet. In der Data View kann nur ein
Data Frame (Data Frame — siehe auch Kapitel 4.4) auf einmal dargestellt werden.
Um einen anderen Data Frame verarbeiten oder anzeigen zu kénnen, muss er zuerst
aktiviert werden (siehe Kapitel 4.4.1).

Um eine Karte gestalten zu kénnen, muss man in die Layout View wechseln. Die

Layout View enthélt alle Data Frames auf einer ,virtuellen Seite“, die dem Output
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Format (Papier oder digital) entspricht. Sie erlaubt die Anordnung der verschieden
Data Frames und der zusatzlichen Elemente wie Legende und Nordpfeil (siehe
Kapitel 5.2).

In der Layout View sind im Hauptmeni andere Optionen verfugbar (z.B. um eine

Legende oder ein Nordpfeil einfiigen) als in der Data View (siehe Kapitel 5.1).

4.3 Projekt speichern
4.31 ArcMap Dokumenteigenschaften setzen

Unter dem Menu File > Document Properties... kdnnen die Eigenschaften des
ArcMap Dokuments wie Titel, Autor etc. eingetragen werden. Unter Hyperlink base
kann der Pfad oder die URL zu Dokumenten abgelegt werden, welche aus einer
Tabelle des ArcMap Dokumentes referenziert werden (siehe auch Kapitel 4.15.1
Feldbasierte Hyperlinks).

Uber den Button Data Source Options... kann man einstellen, ob der gesamte oder
nur der relative Pfad zu den Datenfiles gespeichert und ob diese Einstellung fur alle
Projekte verwendet werden soll (Make relative paths the default for new map
documents | create). Wenn der absolute Pfad gespeichert wird, muss darauf
geachtet werden, dass das Projekt immer Uber das gleiche Laufwerk geotffnet wird
(z. B. T:\MeinProjekt ) und die Daten unter dem im Projekt gespeicherten Pfad
abgespeichert sind. Sonst kdnnen die Pfade nicht gefunden und somit die Dateien

nicht mehr dargestellt werden (siehe Kapitel 4.5.4 Referenzfehler).

Data Source Options A i

In this map document:
_ Cancel |

(" Store full path names to data sources

(¢ Store relative path names to data sources

[~ Make relative paths the default for new map documents | create

43.2 Speichern als ArcMap Dokument (.mxd)

Unter dem Meni File > Save, Save As... oder Save a Copy... kann ein Projekt als
ArcMap Dokument (.mxd) abgespeichert werden.

Es ist zu beachten, dass das abgespeicherte ArcMap Dokument nur
Darstellungseinstellungen (Legende, Farben,...) beinhaltet. Es werden nicht die

Daten selbst, sondern nur die Pfade zu den verwendeten Daten abgespeichert.

Anleitung ArcGIS FS11 “GIS 4-6



4. Das Programm ArcMap

Eine Anderung der Darstellung eines Layers wird also im ArcMap Dokument
abgespeichert. Werden jedoch die Geometrie- oder Sachdaten eines Layers
verandert, so wird diese Veranderung direkt im zu Grunde liegenden Datenfile

gespeichert.

4.3.2.1  Fir alte Versionen von ArcGIS speichern

Mit ArcGIS 9.3 erzeugte oder gespeicherte Dokumente kénnen nicht direkt mit
zurtckliegenden Version gelesen oder verwendet werden.
Unter dem Menu File > Save A Copy... kann ein Projekt unter einem alten Format

von ArcGIS gespeichert werden (z.B. ArcMap 9.2 Document).

4.3.3 Speichern als ArcMap Template (.mxt)

Unter den Menus File > Save As... und File > Save A Copy... kann ein Projekt als
ArcMap Template (.mxt) gespeichert werden. Uber ein Template (dt. Vorlage)
kénnen z.B. Voreinstellungen fir das Layout einer Karte vorgegeben werden (z.B.
Position und Aussehen des Nordpfeils, Anordnung der Karten fiir den Druck usw.).
Eine so erzeugte Vorlage kann dann als Grundgerust fir ein neues ArcMap

Dokument verwendet werden.

4.4 DataFrame

Ein Data Frame ist der Grundbaustein eines Projektes und wird im Inhaltverzeichnis
TOC im Display- und Source-Modus mit dem Symbol £ dargestellt. In einem Data
Frame werden Informationen wie Koordinatensystem, Einheit, Massstab,
Ausdehnung etc. gespeichert. Diese Informationen gelten immer fur alle Layer,
welche im Data Frame enthalten sind. Wenn man ein neues Projekt erstellt, enthéalt
dieses immer einen default Data Frame, der ,Layers“ heisst. Zusatzliche Data
Frames kénnen tUber den MenlUpunkt Insert - Data Frame hinzugefligt werden.

Neu erstellte Data Frames haben zu Beginn noch kein Koordinatensystem (siehe
Kapitel 4.7.1 Definition Koordinatensystem). Wird eine Datei geladen, fur welche ein
Koordinatensystem definiert ist, so Ubernimmt der Data Frame automatisch dieses
System. Alle weiteren Datensatze, die geladen werden, werden in dieses System
projiziert.

Die einzelnen Data Frames sind im TOC untereinander aufgelistet:
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- £ Layers 1 Aktiver
® Datal > Data
# M Data2 ) Frame

=) £% New Data Ftarne\ Inaktiver
+ Datal » Data
# Data3 ) Frame

In der Data View kann nur ein Data Frame auf einmal im Kartenteil dargestellt
werden, in der Layout View hingegen kdénnen mehrere Data Frames miteinander
angezeigt werden (Siehe Kapitel 4.2.3 Der KartenteilDer Kartenteil). Ein Datensatz

(Layer) kann in einem oder mehreren Data Frames enthalten sein.

441 Finen Data Frame aktivieren

Um einen Data Frame zu aktivieren, kann man entweder im TOC auf den
gewilnschten Data Frame Rechtsmausklicken und Activate wahlen, oder den
entsprechende Data Frame in der Layout View selektieren.

Welcher Data Frame gerade aktiv ist, erkennt man daran, dass der Name im TOC

fett dargestellt ist.

4.5 Datensitze laden und entfernen
451 Laden von Datensétzen

Die Daten kann man direkt bei der Erstellung eines Projektes hinzufliigen. Dazu muss
im Dialogfenster, welches beim Starten von ArcMap erscheint, unter Immediately

add data ein Hakchen gesetzt werden.
I

[v Immediately add data
[~ Do not show this dialog again

[~ Load last map on startup

Anschliessend erscheint ein Fenster, in welchem die gewilnschten Dateien
ausgewahlt werden kénnen.
Wenn ein Projekt bereits geoéffnet ist, kdnnen Datensatze entweder Uber das

Hauptmeni mit dem Befehl File > Add Data... oder direkt Gber den Button Add Data

\t’ geladen werden. Falls der gewlinschte Ordner nicht in der Auswabhlliste erscheint,

kann er Uber Connect to Folder 2 verbunden werden.

Es kénnen auch mehrere Datensatze gleichzeitig selektiert und geladen werden.
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4.5.1.1  Fehlendes Referenzsystem

Wenn einem Projekt noch kein Referenzsystem zugeordnet wurde, erscheint beim
Laden von neuen Daten die Meldung: One or more layer is missing spatial reference.
Das Referenzsystem des Projektes kann wie in Kapitel 4.7.1 beschrieben definiert
werden.

4.5.2 Entfernen von Datensédtzen

Um einen Layer oder einen ganzen Datensatz wieder aus dem Projekt zu entfernen,
klickt man mit der rechten Maustaste auf den oder die zu entfernenden Layer und
wéhlt dann die Option Remove.

45.3 Laden von Rasterdaten

Rasterbilder werden wie in Kapitel 4.5.1 beschrieben geladen.

4.5.3.1  Erstellen von Pyramiden bei Rasterdaten

Wenn ein Rasterbild geladen wird, fir welches noch keine Pyramiden erstellt

wurden, erscheint folgende Meldung:

Create pyramids for 2mio_kantonskolc

This raster data source does not have pyramids. Pyramids allow for rapid display at
varying resolutions.

Pyramid building may take a few moments.
Would you like to create pyramids?

Help | Yes I No

[~ Use my choice and do not show this dialog in the future.

Pyramiden-Ebenen sind zusatzliche Dateien fur Raster. Wenn das Bild auf dem
Bildschirm in kleinem Massstab ausgegeben werden soll, kann ein Bild mit einer
kleinen Auflosung dargestellt werden. Mit einem solchen Bild geht der Bildaufbau viel
schneller. Je mehr reingezoomt wird, desto feiner wird die Auflésung des Bildes.
Pyramids ermoglichen somit bei einem Wechsel der Massstabsebene eine schnellere
Darstellung der Bildvorlage in den Programmen ArcMap, ArcCatalog und
ArcScene. Dementsprechend empfiehlt sich die Erstellung von Pyramids besonders
bei grossen Bilddateien.

Bei der Bildung von Pyramids geschieht ein Resampling (Neuberechnung der
Rasterdaten). Dabei wird eine Auflésungsreduktion durchgefuhrt. Es wird eine

zusétzliche Datei mit allen nétigen Pyramiden-Informationen erzeugt, welche am
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selben Ort wie das Bild gespeichert wird und die Endung .rrd hat. Die urspringlichen
Rasterdaten werden bei der Erstellung von Pyramiden jedoch nicht verandert.

Die Pyramiden kénnen auch nach dem Laden eines Rasters noch gebildet werden: in
der ArcToolbox > unter Data Management Tools > Raster - Raster Properties >

Build Pyramids.

454 Referenzfehler

Erscheint beim Offnen eines bereits bestehenden Projektes ein rotes Ausrufezeichen
vor dem Namen des Layers im TOC, so sind die Daten nicht mehr am urspringlichen

Ort abgespeichert oder der Name der Datei wurde verandert.

CF =/ Layers
+ [ Einzelpunkte
@ [ Strassen

# [I' Bodenbedeckung
Um die Daten wieder ins Projekt einzufiigen, muss der Pfad aktualisiert werden. Dies
geschieht am einfachsten durch Rechtsmausklick auf den entsprechenden Layer 2
Data 2 Repair Data Source....Falls mehrere Dateien den gleichen Pfad haben und
dieser geandert hat, muss diese Methode nur fur eine Datei angewendet werden;
das Programm passt alle anderen Pfade automatisch an.
Diese Methode funktioniert jedoch nur, wenn lediglich der Pfad der Daten geandert
hat. Wurde auch der Name der Datei gedndert, muss wie in Kapitel 4.8.2.1
Datenpfad anpassen beschrieben, vorgegangen werden.
Um Referenzfehler zu verhindern, ist es deshalb sinnvoll, bei Projekten, welche
weitergegeben werden, nur den relativen Datenpfad zu speichern (siehe Kapitel
4.3.1).

4.6 Arbeiten mit Layern

4.6.1 Inhalt eines Layers

Jeder Layer kann nur Daten eines bestimmten Typs enthalten, d.h. der Layer enthalt
entweder Punkte, Linien, Flachen (Vektordaten) oder Bilddateien (Rasterdaten).

4.6.2  layer ein- und ausblenden

Durch Setzen und Entfernen des Hakchens im Kastchen vor dem Themennamen

kann ein Thema ein- und ausgeblendet werden.

- £ Layers
Thema einblenden: + Name

-] £ Layers
Thema ausblenden:  ® [0 Name
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Ist kein oder nur ein Layer selektiert, werden durch Driicken der Taste <Ctrl> und
gleichzeitigem Klicken auf ein Kastchen alle aufgelisteten Layers auf einmal
ausgeblendet (respektiv eingeblendet). Wenn mehr als ein Layer selektiert ist (mit
Hilfe der Taste <Ctrl> oder <Shift>), dann werden beim Dricken der Taste <Ctrl>
und gleichzeitigem Klicken auf ein Kastchen nur die selektierten Layer ein-

respektive ausgeblendet.

4.6.3  Darstellungsreihenfolge dndern

Wird ein neues Thema geladen, so erscheint dieses in der Legende automatisch an
oberster Stelle. Es kann sein, dass so andere Layer Uberdeckt werden. Mit der
Drag & Drop Technik (Maustaste gedriickt halten und Layer gegentber den anderen
Layern nach oben oder unten verschieben) kdnnen die Layer in die gewilnschte
Reihenfolge gebracht werden (generell gilt: Punkte vor Linien vor Flachen).
Rasterdaten stehen normalerweise ganz unten in der Reihenfolge, da sie
flachenfullend sind. Um Flachen und Rasterdaten gemeinsam anzuzeigen, kdnnen
entweder die Rasterdaten oder die Flachen transparent dargestellt werden. Die

Anleitung dazu finden Sie im Kapitel 4.8.5.3 Transparenz einstellen.

4.6.4  layer gruppieren

Wenn mit vielen Layern gearbeitet wird, kann es zur Ubersichtlicheren Gestaltung
sinnvoll sein, dass die Layer zu Gruppen zusammengeschlossen werden. Dazu
mussen die gewiunschten Layer selektiert werden (Taste <Ctrl> gedruckt halten
wéhrend man mit Linksmausklick auf die gewilnschten Layernamen klickt). Mit
Rechtsmausklick auf die selektierten Layer > Group wird ein neuer Group Layer
erstelit.

Copy

X Remove

¢ EX I

Turn Off
<& Zoom To Layers

Visible Scale Range »

Mit Rechtsmausklick auf den Data Frame oder einen Group Layer > New Group
Layer kann auch direkt ein neuer Group Layer erstellt werden. Die einzelnen Layer

kdnnen dann mittels Drag & Drop in den Group Layer verschoben werden.
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Mit Rechtsmausklick auf den New Group Layer > Properties... kbnnen die Group
Layer Properties getffnet werden. Darin kann im Tab General der Name des Group
Layers angepasst und eine massstabsgesteuerte Darstellung ausgewahlt werden. Im
Tab Group koénnen neue Layer hinzugefigt, Layer entfernt und die
Darstellungsreihenfolge der Layer angepasst werden. Ausserdem kbnnen
Anderungen der Eigenschaften der einzelnen Layer direkt uber den Button
Properties... im Tab Group vorgenommen werden. Im Tab Display werden der

Kontrast, die Helligkeit und die Transparenz fur die ganze Gruppe eingestelit.

4.6.5 Layer kopieren

Layer, welche bereits in einem Data Frame sind, kdnnen durch Rechtsmausklick auf
den Layer > Copy kopiert werden. Mit Rechtsmausklick auf den Data Frame oder
den Group Layer - Paste Layer(s) kann man die Layers am gewilnschten Ort wieder
einfiugen. Es kdnnen auch mehrere Layers gleichzeitig kopiert werden.

Diese Funktion wird oft gebraucht, wenn mit mehreren Data Frames gearbeitet wird.

So mussen die Daten nur einmal hinzugefugt werden.

4.6.6 Zu einem Layer zoomen

Durch Rechtsmausklick auf den Layer und Auswahl der Funktion Zoom to Layer wird
die Gesamtausdehnung des entsprechenden Layers im Kartenfenster dargestelit.

E £ lLayers

SR Fluesee

= Copy
X Remove
i Open Attribute Table

Joins and Relates

R zoom Tolayer——

4.6.7  Anderung der Legendendarstellung

Die geladenen Daten werden automatisch mit einer ,,zufélligen“ Signatur dargestellt.
Diese Darstellung kann durch Doppelklicken auf das Symbol unterhalb des
Layernamens im TOC verandert werden.

Die Signatur kann auch in den Layer Properties angepasst werden (siehe Kapitel
4.8.6).
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4.7 Eigenschaften eines Data Frames setzen

Der Dialog, in welchem die Eigenschaften eines Data Frames gesetzt werden kdnnen,
wird entweder Uber das Menu View - Data Frame Properties... oder durch

Rechtsmausklick auf den Data Frame - Properties... getffnet.

4.7.1 Definition Koordinatensystem

Das Koordinatensystem wird im Tab Coordinate System definiert. Fir Projekte in der

Schweiz wird meist folgendes Koordinatensystem verwendet:

Annotation Groups | Dxeskdestasgles |  Frame | Size and Posttion
General | Deta Frame Buminaton | Gnds | Map Cache |
Current coordinate system:

CH1503_LV03 Clear
Projecton: Hotine_Oblique_Mercator_Azimuth_Center
False_Easting: 600000.000000

False_Northing: 200000.000000

Scale_Factor: 1.000000

Azimuth: 90.000000

Longitude_Of_Center: 7.439583
Latitude_Of_Center: 46.952406

Linear Unit: Meter

GCS_CH1503
Datum: D_CH1903

4 Transformations... J

Select a coordinate system:

~{] Favorites
543 Predefined
[#-{Z]] Geographic Coordinate Systems
=4 Projected Coordnate Systems
@3 ARC (equal arc-second)
{23 continental
w4

{23 Australia

'Arc
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4.7.2 Definition von generellen Eigenschaften

Bdert Rectangles | Frame | Sizeand Postion |
P Data Frame | Coordinate System | lumination | Gnds | Map Cache I

: >Data View tab for additional
options for displaying coordinates in the status bar

<MNone > -
Rotation: o

Label Engine: |ESRI Standard Label Engine >

[v Simulate layer transparency in legends

4.7.2.1  Name des Projektes éndern

Im Tab General ® kann der Name @ des Projektes geandert werden. Zuséatzlich kann

eine Beschreibung des Projektes verfasst werden.

4.7.2.2 Definition Einheiten

Die Masseinheit wird ebenfalls im Tab General © definiert. Mit der Wahl des
Koordinatensystems im Tab Coordinate System wird die Einheit ® fur das Projekt
automatisch festgelegt. Die Einheit, welche fur die Darstellung im Kartenfenster

verwendet werden soll, kann unter Units - Display @ ausgewéhlt werden.

4.7.2.3 Definition Reference Scale

Unter Reference Scale ® kann ein Massstab definiert werden, bei welchem Symbole
und Texte in ihrer wahren Gridsse erscheinen sollen. Ab diesem Massstab werden
dann die Symbole und Texte beim rauszoomen kleiner und beim reinzoomen

grosser. Ist keine Reference Scale definiert (Eintrag <None>) werden Symbole und
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Texte unabhangig vom gewahlten Darstellungsmassstab immer in der gleichen
Grosse dargestellt.

Eine Reference Scale zu definieren ist nutzlich, wenn ein kartographisches Produkt
wie z.B. eine Papierkarte erstellt werden soll. Dann ist es sinnvoll, dass die
Grossenverhéltnisse auf der Karte, mit der am Bildschirm gearbeitet wird, auch
gleich sind wie die auf dem Papierausdruck.

Mittels Rechtsmausklick auf den Data Frame -> Reference Scale = Set Reference
Scale lasst sich der aktuell angezeigte Massstab als Reference Scale festlegen. Mit
Rechtsmausklick auf den Data Frame - Reference Scale - Clear Reference Scale
kann die Option wieder ausgeschaltet werden und durch Klicken auf Reference Scale
- Zoom to Reference Scale wird der Zoom der Karte auf den unter Reference Scale
definierten Massstab gesetzt.

Ob diese Option fur die einzelen Layer angewendet werden soll, kann direkt bei den
Layern in den Layereigenschaften gesteuert werden (siehe Kapitel 4.8.5.2 Scale

Symbols).

4.7.3 Definition Hintergrundfarbe fir das Kartenlayout

Unter dem Tab Frame koénnen Hintergrundfarben, Kartenrdnder sowie deren
Schattierungen definiert werden. Hinweis: Kartenrander und Schattierungen sind nur

in der Layout View sichtbar.

4.8 Eigenschaften eines Layers setzen

Die Eigenschaften eines Layers kdénnen im Fenster Layer Properties angepasst
werden. Dieses Fensters kann entweder durch selektieren eines Layers und dricken
der Taste F12, durch Doppelklicken des Layers oder durch Rechtsmausklick auf den
gewulnschten Layer - Properties... getffnet werden.

Achtung: Die Darstellung eines Layers ist nicht bei den Daten selbst gespeichert,
sondern im Projekt. Das heisst, wenn Sie die Darstellung eines Layers in einem
Projekt angepasst haben und den gleichen Layer in einem anderen Projekt &ffnen,
wird dieser Layer im neuen Projekt nicht automatisch die angepasste Darstellung aus
dem ersten Projekt haben. Um die Darstellung eines einzelnen Layers Ubernehmen
zu kdénnen, muss sie in einem Layer File (.lyr) gespeichert werden (siehe Kapitel
4.8.12).
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4.8.1 Tab General

General | Source | Selection | Display | Symbology | Fields | Defintion uery | Labels | Joins & Relates | HTML Popup |

Layer Name: I My Layer [V visible

Description:

Credits:

Scale Range

You can spedify the range of scales at which this layer will be shown:
" Show layer at all scales
{* Don't show layer when zoomed:

Out beyond: |1:10‘ooo j (minimum scale)

In beyond: | v| (maximum scale)

4.8.1.1  Name eines Layers d&ndern

Im Tab General kann der Namen des Layers gedandert werden. Diese Umbenennung
gilt jedoch nur fir die Darstellung in ArcGIS, der Name der Datei andert nicht.
Durch setzen und entfernen des Hakchens hinter dem Namen kann der Layer ein-
und ausgeblendet werden (gleicher Effekt wie Hakchen setzen und entfernen im

TOC, mehr dazu im Kapitel 4.6.1 Inhalt eines Layer).

4.8.1.2  Massstabgesteuerte Darstellung

Fur gewisse Objekte ist es sinnvoll, dass sie ab einem gewissen Massstab nicht mehr
dargestellt werden. Deshalb kann man Layer auch massstabsabhangig ein- und
ausblenden. Im Bereich Scale Range kann unter Don’'t show layer when zoomed:
eine obere und/oder eine untere Grenze des Massstabbereiches definiert werden, in
welchem der Layer dargestellt werden soll. Dies funktioniert jedoch nur, wenn vorher

in den Data Frame Properties eine Einheit definiert wurde (siehe Kapitel 4.7.2.2).

4.8.2 Tab Source

Dieser Tab sieht fiir Vektor- und Rasterdaten unterschiedliche aus. Bei beiden kann

unter Extent die raumliche Ausdehnung des Layers abgelesen werden. Bei
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Rasterdaten sind ausserdem noch diverse weitere Eigenschaften wie Farbtiefe,
Kompressionsart, Rastergrésse usw.angegeben.
Unter Data Source werden Informationen wie der Datentyp, der Datenpfad, das

Koordinatensystem etc. eines Layers angezeigt.

4.8.2.1 Datenpfad anpassen

Wenn ein Datensatz an einen anderen Ort verschoben wurde oder der Name einer
Datei geandert wurde, muss auch der Datenpfad im Projekt angepasst werden (siehe
auch Kapitel 4.5.4 Referenzfehler). Dies kann im Tab Source uUber den Button Set

Data Source... durchgefuhrt werden.

4.8.3 Tab Extent

Dieses Tab ist nur bei Rasterdaten vorhanden.
Im Tab Extent kann ausgewahlt werden, ob der ganze oder nur ein Teil eines Raster-
Layers dargestellt werden soll. Diese Option ist sehr nutzlich, wenn die Ausdehnung

des Raster-Layers viel grosser ist als das Arbeitsgebiet.

4.8.4 Tab Selection

Dieses Tab ist nur bei Vektordaten vorhanden.

Grundsatzlich wird die Farbe, mit welcher selekierte Objekte dargestellt werden,
Uber das Menii Selection » Options... definiert. Uber den Tab Selection der
Layereigenschaften lasst sich diese Einstellung jedoch fir einen einzelnen Layer
separat Uberschreiben.

Es kann entweder eine spezifische Farbe oder ein spezielles Symbol gewahlt werden,

welche nur fur die Selektionen im gewahlten Layer gelten.

4.8.5 Tab Display

Im Tab Display kdnnen Einstellungen gemacht werden, welche die Darstellung des
Layers im Kartenfenster beeinflussen. Die angezeigten Optionen sind davon

abhangig, ob in einem Layer Raster- oder Vektordaten angezeigt werden:
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Fur Vektordaten:

General | Source | Selection Display | Symbology | Fields | Defintion Query | Labels | Joins & Relates | HTML Popup |

I Show MapTips (uses primary display field)
[V Scale symbols when a reference scale is set

|D'z.

FUr Rasterdaten:

General | Source | Extent Display | Symbology | Fields | Joins & Relates |

I~ Show Map Tips (uses primary display field)
[~ Display raster resolution in table of contents
[~ Allow interactive display for Effects toolbar
Resample during display using:

|Nearest Neighbor (for discrete data)

Contrast: [_IJ %

Brightness: [ 0 %
Transparency: [_0 %

[ Display Quality - 9
Coarse  Medium Normal

Arc
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4.8.5.1 MapTips erstellen

Das Anzeigen von MapTips ist eine zusatzliche Mdglichkeit Infarmationen uUber
Objekte in der Karte zu erhalten. Der MapTip zeigt beim Uberfahren eines Objektes
mit dem Mauszeiger jeweils den Wert eines ausgewahlten Attributes (Primary
Display Field) an.

Damit die MapTips in der Karte dargestellt werden, muss im Tab Display die Option
Show MapTips aktiviert werden.

Das Primary Display Field wird im Tab Fields ausgewahlt (siehe Kapitel 4.8.7).

4.8.5.2  Scale Symbols

Um die Grosse der Symbole des Layers abhéngig vom Darstellungsmassstab
anzuzeigen, muss die Option Scale symbols when a reference scale is set aktiviert
sein. Defaultmassig ist diese Option aktiviert. Die Reference Scale wird flr jeden
Data Frame unter den Projekteigenschaften definiert (siehe Kapitel 4.7.2.3 Definition
Reference Scale)

Diese Option ist nur bei den Vektordaten vorhanden.

4.8.5.3  Transparenz einstellen

Im Tab Display kann auch die Transparenz veréndert werden.

Eine andere Moglichkeit Flachen transparent darzustellen, ist die Option Adjust

Transparency 0 in der Effects-Toolbar.
Bei Rasterdaten kénnen zusatzlich zur Transparenz noch der Kontrast (Contrast) und

die Helligkeit (Brightness) eingestellt werden.

4.8.5.4  Hyperlinks

Um feldbasierte Hyperlinks mit dem Hyperlinktool (Kapitel 4.11.1) aufrufen zu
kénnen, miuissen diese aktiviert werden und es muss festgelegt werden, unter
welchem Attribut der Link abgelegt ist. Um die Links zu aktivieren, setzt man ein
Hakchen bei der Option Support Hyperlinks using field. Anschliessend wird das Feld
ausgewahlt, in welchem Hyperlinks erfasst wurden und dazu die Art des Hyperlinkes.
Mehr zum Thema feldbasierte Hyperlinks im Kapitel 4.15.1.

Diese Option ist nur bei den Vektordaten vorhanden.

4.8.6 Tab Symbology

Die geladenen Daten werden automatisch mit einem zufalligen Symbol dargestelit.

Diese Farben und Symbole kdnnen im Tab Symbology geandert werden. Dies
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geschieht entweder durch Doppelklicken auf das Symbol im TOC oder durch
Rechtsmausklick auf den Layer - Properties... > Symbology.

Fur die Darstellung eines Layers mit Vektordaten stehen folgende Mdoglichkeiten zur
Verfugung:

e Features: Alle Objekte eines Layers werden mit dem gleichen Symbol
dargestelit.

e Categories: Die Objekte werden anhand eines bestimmten Attributes
unterschieden und unterschiedlich dargestellt (siehe Kapitel 4.8.6.1).

e Quantities: Es werden verschiedene Wertebereiche flr ein Attribut definiert
und die Objekte werden je nach Wertebereich, in welchem sie liegen,
dargestelit.

e Charts: Verschiedene Attribute kdénnen in einem Diagramm dargestellt
werden.

e Multiple Attributes: Objekte kdnnen anhand von mehreren Attributen
unterschiedlich dargestellt werden.

Far die Visualisierung eines Layers mit Rasterdaten stehen folgende Mdglichkeiten
zur Verfugung (Anzahl Darstellungsarten ist abhdngig vom Typ der Rasterdaten):

e Unique Values: Jedem Wert einer Rasterzelle wird eine individuelle Farbe
zugeordnet.

e RGB Composite: Zur Verwendung mit mehrkanaligen Rasterdaten (z.B.
Satellitenbilder). Einzelne Farbkanéle kénnen ausgeblendet oder vertauscht
werden.

e Classified: Der gesamte Wertebereich wird in statistische Klassen unterteilt,
denen Farben zugeordnet werden kodnnen (siehe Kapitel 10.4.3.1
Reklassifizierung OHNE Veranderung der Daten).

e Stretched: Zur Verwendung mit einkanaligen Rasterdaten, die sich durch
einen grossen Wertebereich auszeichnen (z.B. Flugbilder in Graustufen).

e Colormap: wie Unique Values, jedoch kdnnen den Rasterdaten vordefinierte,
wieder verwendbare Colormaps (dt. ,Farbpaletten”“) zugewiesen werden, in

denen die Zuordnung Wert - Farbe abgespeichert wird.

4.8.6.1 Klassifizierung eines Themas nach eindeutigen Werten bei Vektordaten

Zur Ubersichtlicheren Darstellung kdnnen Daten eines Layers in Klassen unterteilt
werden.
e Im Tab Symbology unter Categories die gewinschte Option auswahlen.

e Im Value Field das gewlinschte Attribut auswahlen.
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e Add all Values klicken.
Durch Klicken eines Wertes in der Spalte Label kann die Beschriftung in der Legende,
welche im TOC angezeigt wird, geandert werden. Es ist zu beachten, dass die
Attributwerte nicht verandert werden, sondern nur die Bezeichnung in der Legende:
eine thematische Abfrage (siehe Kapitel 9.2.1.1) muss also mit den Werten in der

Tabelle, d.h mit den Werten in der Spalte Value, gemacht werden.

s | Defintion Guery | Labels | Joins & Relates | HTML Popup |

Draw categories using unique values of one field. Import... |

Vi 1 —Color Ramp 1

Kasse = | [ — N -
- R Y3 any |
c"mc_ht“’“b""“’ Symbal | Value | Label [ Count |
Charts <all other values> <all other values>
Multiple Attribut <Heading> Kasse

ple rbutes | o3 Fols
2 Fels_Wald
etz 1 Geroell
Gletscher
See
Siediung
Uebng
Unbestimmt

e R S R I B S RS )

4.8.7 Tab Fields

Dieser Tab ist fur Rasterdaten und Vektordaten verschieden.

4.8.71 Tab Fields bei Vektordaten

Unter Primary display field wird das Attribut definiert, welches als MapTip erscheinen
soll (siehe auch Kapitel 4.8.5.1) oder welches bei Abfragen mit dem Identify-Tool im
Resultatsfenster angezeigt wird (siehe Kapitel 4.11.1).

Die einzelnen Attribute des Layers kdnnen durch Setzen und Entfernen des Hakchens
vor dem Attributsnamen ein- und ausgeblendet werden. Ausserdem kann dem
Attribut ein Alias-Name zugeordnet werden, d.h. ein Name, der die Bedeutung des

Attributes besser beschreibt.

'Arc
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4.8.7.2 Tab Fields bei Rasterdaten

Dieser Tab ist nur bei Integer-Grids vorhanden (siehe Kapitel 10.2). Wie bei den
Vektordaten kann ebenfalls ein Primary display field gewahlt werden und die

entsprechenden Attribute werden in der Karte angezeigt.

4.8.8 Tab Definiton Query

Dieses Tab ist nur bei Vektordaten vorhanden.
Hier konnen Kriterien (Abfragen) definiert werden, denen Objekte des Layers

genlgen mussen, damit sie dargestellt werden.

4.8.9 Tab Labels

Dieser Tab ist nur bei Vektordaten vorhanden.

4.8.9.1 Label erstellen

ILabEI all the features the same way.

Al features will be labeled using the options specied.

.
Clabei Feid [Name

Teat Symbol

[ 70a =F

A B e|z|ul smo

Pre-defined Label Style
Scale Range. Label Styles...

Um Labels (dt. Objektbeschriftungen) im Kartenfenster darzustellen, muss man
zuerst die Label-Option aktivieren: Hakchen bei Label features in this layer setzen.
Es kann zwischen zwei Label-Methoden ausgewahlt werden:
e Label all the features in the same way: Alle Objekte werden auf die gleiche
Art und Weise beschriftet.
o Define classes of features and label each class differently: Es werden
verschiedene Klassen definieren und diesen Klassen werden unterschiedliche

Label-Eigenschaften zuordnen.
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Unter Label Field kann das Attribut ausgewéhlt werden, welches als Label dargestellt
werden soll.
Die Darstellung der Labels kann mit Rechtsmausklick auf den gewlinschten Layer ->

Label Features ein- und ausgeschaltet werden.

4.8.10 Tab Joins & Relates

Dieser Tab bietet eine komfortable Méglichkeit, um die Sachdaten-Tabelle eines
Layers mit anderen Tabellen in Beziehung zu bringen. Kapitel 4.16 Joins & Relates

befasst sich ausfuhrlich mit diesem Thema.

4.8.11 Tab HTML Popup

Durch Setzen eines Hakchens unter Show content for this layer using the HTML
Popup tool kénnen die Attribute des Layers in der Karte in einem HTML Popup-
Fenster angezeigt werden. Durch Klicken auf ein Objekt mit dem HTML Popup
Werkzeug der Toobar Tools kann das entsprechende Popup-Fenster getffnet werden

(siehe auch Kapitel 4.11.1 unter HTML Popup).

4.8.12  lLayer file speichern .lyr

Um die gesamte Darstellung (Formatierung, Legende, Farben, usw.) eines Layers
oder einer Layergruppe (siehe Kapitel 4.6.4) fiur kinftige Anwendungen zur
Verfigung zu haben, kdnnen deren Parameter ausserhalb des Projektes in einem
Layerfile = gespeichert werden: Rechtsmausklick auf den gewilinschten
Layer/Layergruppe > Save as Layer file (.lyr).

Mit ArcGIS 9.3 erzeugte oder gespeicherte Layer Files kdnnen nicht direkt mit
zurtckliegenden ArcGIlS-Version gelesen oder verwendet werden. Beim Speichern
kann jedoch das Layer File unter einem alten Format von ArcGIS gespeichert
werden.

Achtung: In einem Layerfile wird nur die Darstellung und nicht die Daten selbst

gespeichert.

4.9 Erweiterungen (Extensions) aktivieren

Mittels Erweiterungen lasst sich ArcGIS gezielt um zusatzliche Funktionalitaten
bereichern. So gibt es eine Erweiterung fur militdrische Auswertungen (Military
Analyst), fur eine intelligente Beschriftungsplatzierung (Maplex), fir komplexe
rdumliche Analysen (Spatial Analyst) und viele mehr. Weitere Informationen zum

Thema Erweiterungen finden sie im Kapitel 2.1.9.
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Die Erweiterungen werden unter dem Meni Tools &> Extensions... durch setzen und
entfernen von Hakchen aktiviert und deaktiviert (ArcCatalog und ArcMap).
Zusatzlich zum Aktivieren der Erweiterungen muss die zur Erweiterung zugehoérige

Toolbar eingeblendet werden (siehe auch Kapitel 4.10).

4.10 Toolbars (Werkzeugleisten) aktivieren

Um eine Toolbar im Programm ArcMap einzufugen, klickt man View - Toolbars
(oder Rechtsmausklick an einer beliebigen Stelle auf den grauen Rand). Durch
setzen und entfernen von H&kchen koénnen die einzelnen Toolbars ein- und
ausgeblendet werden. Damit das Programm ArcMap Ubersichtlich bleibt, sollte man
immer nur diejenigen Toolbars einblenden, welche gerade verwendet werden. Auf
die gleiche Art und Weise kdonnen die Toolbars in den anderen Programmen von
ArcGIS ein- und ausgeblendet werden. Siehe Kapitel 3.2.1 fur weitere

Informationen zum Thema Toolbars.

4.11 Navigation in der Karte
4.11.1  Die ToolbarTools

In der Toolbar Tools sind die wichtigsten Werkzeuge zum interaktiven Arbeiten im
Kartenfenster zusammengefasst.

Sie befindet sich entweder in einem extra Fenster mit dem Namen Tools oder in der
Menuleiste. Falls sie dort nicht vorhanden ist, muss sie zuerst eingeblendet werden

werden (siehe Kapitel 4.10).

Zoom In Zoom Out

Fixed Zoom In Fixed Zoom Out

Pan

Go Back To
Previous Extent

\| Full Extent
Go to Next Extent

Select Features Clear Selected Features

Select Elements Identify
Find Go To XY
Measure Hyperlink
HTML Popup Create Viewer Window

Zoom In: Vergrosserung der Karte durch Klicken in die Karte oder durch Aufziehen

eines Rechteckes mit gedrickter Maustaste
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Zoom Out: Verkleinerung der Karte durch Klicken in die Karte oder durch Aufziehen
eines Rechteckes mit gedrickter Maustaste
Fixed Zoom In: Vergrésserung der Karte um einen fixen Massstabs-Faktor
Fixed Zoom Out: Verkleinerung der Karte um einen fixen Massstabs-Faktor
Pan: Sichtbaren Kartenausschnitt verschieben
Full Extent: Zoom auf Gesamtansicht aller aktivierten Layer
Go Back To Previous Extent: zum vorhergehenden Zoomausschnitt zurtickkehren
Go to Next Extent: den nachfolgenden Zoomausschnitt wiederherstellen
Select Features: Durch Klicken auf ein Objekt wird dieses markiert (blaue
Umrandung; die Markierfarbe kann jedoch angepasst werden, siehe dazu
Erlauterungen im Kapitel 4.8.4). Falls mehrere Objekte markiert werden sollen, kann
entweder wahrend des Klickens auf die Objekte die Shift-Taste gedruckt oder mit
gedruckter Maustaste ein Rechteck aufgezogen werden. Um gewisse Operationen in
ArcMap anzuwenden, mussen Objekte selektiert sein. Die verschiedenen Arten um
die Markierung wieder aufzuheben sind in Kapitel 6.4.5 beschrieben.
Clear Selected Feature: Selektionen in allen Layern léschen (siehe auch Kapitel
6.4.5)
Select Elements: Selektieren und verschieben von Grafik-Elementen
Identify: Durch Klicken auf ein Objekt 6ffnet sich ein Info-Fenster, in welchem die
in der Sachtabelle gespeicherten Informationen des angewéhlten Objektes angezeigt
werden. Auf der linken Seite des Resultatfensters wird das im primary display field
festgelegt Attribut angezeigt (siehe Kapitel 4.8.7).
Find: Im Tab Features kann nach einem bestimmten Wert in allen sichtbaren Layern
(Visible layers), allen selektierbaren Layern (Selectable layers), allen Layern (All
layers), allen Layern aus allen Data Frames (All layers in all data frames) oder einem
bestimmten Layer gesucht werden. Die Suchergebnisse werden im Fenster
aufgelistet. Durch Rechtsmausklick auf ein Suchergebnis erscheint das Kontextmen
mit folgenden mdoglichen Befehlen:

e Flash: Objekt blinkt auf.

e Zoom To: Kartenausschnitt zoomt zum Objekt. Der Massstab verandert sich.

e Pan To: Kartenausschnitt bewegt sich zum Objekt, der Massstab veréandert

sich nicht.
e Create Bookmark: Position des Suchergebnisses wird gespeichert und kann
Uuber View > Bookmarks wieder gedffnet werden.
¢ Identify...: Info-Fenster 6ffnet sich (siehe Funktion Identify oben).

o Select: Selektiert Objekt (siehe Funktion Select Features oben).
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e Unselect: Selektion aufheben.

e Add To My Places: Suchergebnis wird der Data Frame- und Projekt-
Ubergreifenden "My Places" Liste hinzugefugt.

e Manage My Places: Datenrahmen- und Projekt-Ubergreifenden "My Places"
Liste verwalten.

e Find Nearby Places: Suchergebnis mit der kostenfreien ESRI Online Place
Finder Web-Service suchen.

e Add As Network Location: Suchergebnis als Input in einem Network Analyst
Layer hinzuftigen.

Weiter kdnnen aus bestehenden und/oder eigenen Datenbanken nach Orten (Tab
Places) und Adressen (Tab Addresses) gesucht werden. Mit Hilfe des Tabs Route
Locations kénnen Standorte entlang einer Route gesucht werden.

Go To XY: Koordinaten in verschieden Formaten (Dezimalgrad, Grad Minuten
Sekunden, MGRS, usw.) kénnen eingegeben und so zu diesen Koordinaten navigiert
werden. Der Ort kann dann in der Karte mit einem Punkt oder einem beschrifteten
Punkt markiert werden.

Measure: Messen von Strecken und Flachen durch Klicken in der Karte. Die
Masseinheitenn fur die Messungen kdnnen ausgewahlt werden.

Es kann aus funf Messwerkzeugen fiur Distanzen und Objekte ausgewahlt werden:

e Measure Line: Linien messen. Es werden die Langen der einzelnen Segmente
sowie die Gesamtlange aller Segmente angezeigt.

e Measure An Area: Flachen messen: Es werden die Ldngen der einzelnen
Segmente sowie die Flache und der Perimeter angezeigt.

e Measure A Feature: Durch Klicken auf ein Objekt werden entweder
Punktkoordinaten, Linienlange oder Flache des Objektes angezeigt.

Ausserdem kdnnen die beiden folgenden Optionen ein- und ausgeschaltet werden:

e Snap To Features: Wahrend des Messvorgangs werden wohldefinierte Punkte
(Schnitt-, End- und Zwischenpunkte von bestehenden Objekten) angezeigt,
die als Messpunkte in einem vordefinierten Umkreis der aktuellen
Mauszeigerposition in Frage kommen (siehe auch Kapitel 8.2.3).

e Show Total: Zeigt zusatzlich das Total der gemessenen Strecken an.

Unter Choose Units kénnen die Einheiten fur die Distanzen und Flachen ausgewéhlt
werden. Defaultmassig werden die Einheiten des Projektes tibernommen.
Mit dem Button Clear and Reset Results kdnnen die Resultate wieder geldscht

warden.
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Hyperlink: Alle sichtbaren Objekte, bei welchen Hyperlinks definiert wurden,
werden blau umrandet. Wenn sich der Mauszeiger Uber einem Objekt befindet, fur
welches ein Hyperlink definiert ist, verwandelt sich der Cursor in eine Hand und es
erscheint ein Popup mit dem Namen des Ziels (Mehr zum Thema Hyperlinks siehe
Kapitel 4.8.5.4 und Fehler! Verweisquelle konnte nicht gefunden werden.).
HTML Popup: Wurden in den Layer-Properties im Tab HTML Popup unter Show
content for this layer using the HTML Popup tool ein Hakchen gesetzt, so kdnnen mit
Hilfe des Buttons HTML Popup die Attribute des entsprechenden Layers in der Karte
in einem HTML Popup-Fenster angezeigt werden (siehe auch Kapitel 4.8.11).

Create Viewer Window: Durch Klicken auf den Create Viewer Window und durch
Aufziehen eine Rechteckes in der Karte kann auf sehr einfache Art und Weise ein

Viewer-Fenster erzeugt werden (Viewer siehe auch Kapitel 4.14.2).

4.11.2  Kartennavigation mit der Tastatur

Taste Funktion
Kartenausschnitt in eine Richtung verschieben
Pfeiltasten < ©+ 4 = (Achtung: Ist ein graphisches Element selektiert, dann

wird dieses verschoben)

Um einen fixen Betrag rein- und rauszoomen. Gleiche
+ /- Funktion wie die Buttons Fixed Zoom In und Fixed
Zoom out der Tools-Toolbar
Zoom auf Gesamtansicht aller aktiven Layer. Gleiche
Funktion wie der Button Full Extend der Tools-Toolbar
Bewegen den Kartenausschnitt um eine ,,Seite* nach
links bzw. rechts
Bewegen den Kartenausschnitt um eine ,,Seite” oben

Insert-Taste

Home- und End-Taste

Page Up- und Page Down-Taste

bzw. unten
Ctrl- und Tab-Taste gleichzeitig Von einem Tab zum anderen wechseln
ESC-Taste Setzt den Fokus auf die Karte
Shift- und F1-Taste gleichzeitig Kontextsensitive Hilfe
F2-Taste Aktives File umbenennen
F3-Taste Setzt den Fokus auf die Legende
F4-Taste Offnen einer Auswabhlliste
F5-Taste Kartenausschnitt aktualisieren
Wechselt zwischen vergrdssern, verkleinern und
i-Taste verschieben wenn eine der Tools Zoom In, Zoom Out

oder Pan aktiv ist
Unterbricht den Zeichenvorgang in der Karte bzw. setzt
ihn fort

F12- und Eingabe-Taste Den Eigenschaftendialog eines Elementes 6ffnen

F9-Taste

4.11.3  Kartennavigation mit dem Mausrad

Tastenkombination Funktion

Rad vorwarts drehen (weg vom Anwender) Vergrossern

Rad ruckwarts drehen (hin zum Anwender) Verkleinern

STRG+Rad drehen Wie oben, feinere Abstufung
@arc
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Klick auf/mit Mausrad/mittlere Maustaste Karte zentrieren
Mausrad/mittlere Maustaste festhalten, Maus bewegen Bildausschnitt verschieben
STRG+ Klick auf/mit Mausrad/mittlere Maustaste Zentrieren und vergrossern

4.11.4  Aus einem beliebigen Werkzeug kurzzeitig in den Navigationsmodus wechseln

Taste Funktion

Z festhalten, links klicken oder Box aufziehen Vergrossern

X festhalten, links klicken oder Box aufziehen Verkleinern

C festhalten, links klicken Zentrieren

B festhalten - linke Maustaste Dynamisches Vergréssern/Verkleinern

412 Massstab

Im Feld Map Scale in der Standard-Toolbar unterhalb des Hauptmenis wird immer
der aktuelle Massstab angezeigt. Andert man den Kartenausschnitt, wird der
Massstab automatisch aktualisiert.

1:25000 ]

Der Massstab kann aber in diesem Textfeld auch direkt eingestellt werden. Entweder
wahlt man einen Massstab aus der Dropdown-Liste aus oder man gibt einen Wert
ein. Bei der Eingabe von 2000 wird der Massstab automatisch zu 1:2'000 erganzt
und der Kartenausschnitt direkt auf diesen Massstab angepasst.

Unter <Customize This List..> kénnen Werte der Dropdown-Liste und die Art der

Darstellung verandert werden.

4.12.1  Koordinaten Zeigerposition anzeigen

Die Koordinaten der Zeigerposition werden unten rechts angezeigt. Bei jeder
Anderung der Zeigerposition werden diese Koordinaten angepasst.
'608060.82 142286.27 Meters

Das verwendete Koordinatensystem und die Masseinheit werden von den
Einstellungen, die in den Data Frame Properties (siehe Kapitel 4.7) gemacht wurden,

ubernommen.

4.13 Kartenausschnitt als Bookmark speichern

Kartenausschnitte, die immer wieder verwendet werden, konnen als Spatial
Bookmark gespeichert werden: Bookmarks > Create.. und den Name des
Bookmarks eingeben.

Unter Bookmarks kdnnen die gespeicherten Bookmarks direkt aufgerufen und unter

Bookmarks - Manage... kdnnen sie verwaltet werden.

Anleitung ArcGIS FS11 “GIS 4-28



4. Das Programm ArcMap

Bookmarks kénnen auch mit Hilfe des Find-Tools (siehe Kapitel 4.11.1) erstellt

werden.

4.14 Magnifier, Viewer und Overview

Das Programm ArcMap bietet drei zusatzliche Mdglichkeiten, um die raumlichen
Daten in der Karte anzuschauen: das Magnifier-, das Viewer- und das Overview-
Fenster. Mochten Sie ein Detail etwas genauer anschauen, einen grédsseren
Ausschnitt der dargestellten Daten sehen oder einen Uberblick tber die Lage des
Ausschnittes im gesamten Gebiet bekommen ohne den aktuellen Ausschnitt zu
verédndern, dann kénnen Sie eines dieser Fenster verwenden.

Diese Fenster kénnen jedoch nur in der Data View (und nicht in der Layout View,
siehe Kapitel 5.1) verwendet werden. Es kénnen jedoch mehrere dieser Fenster

gleichzeitig gedffnet sein.

4.14.1  Magnifier

Mit Window > Magnifier (Lupe) kann ein Fenster geéffnet werden, das wie ein
Vergrosserungsglas arbeitet: durch Verschieben des Fensters Uber die Daten kann
man einen vergrosserten Ausschnitt der Daten sehen, welche unterhalb des Fensters
liegen. Der aktuelle Ausschnitt der Hauptkarte wird dabei nicht verdndert.

Der Vergrosserungsfaktor kann aus der Dropdownliste ausgewéhlt werden. Durch

Klicken auf den Button "

oder Rechtsmausklick auf die Titelleiste werden einige
nitzliche Shortcuts eingeblendet. Unter Properties... kann auch ein fixer Massstab
definiert werden. Ausserdem kann das Magnifier-Fenster in ein Viewer-Fenster

umgewandelt werden.
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4.14.2 Viewer

Das Viewer-Fenster ist wie eine unabhangige Sicht auf die Karte. Es kdnnen auch
alle interaktiven Werkzeuge des Programmes ArcMap in diesem Fenster verwendet
werden. Es kann z.B. zu einer bestimmten Stelle gezoomt und dann der Ausschnitt

mit der Hauptkarte verglichen werden. Objekte kénnen selektiert und das ldentify-

Tool verwendet werden. Durch Klicken auf den Button ' * oder Rechtsmausklick auf
die Titelleiste werden einige nutzliche Shortcuts eingeblendet. Es kdnnen
Einstellungen veradndert oder das Viewer-Fenster in ein Magnifier-Fenster

umgewandelt werden. Das Viewer-Fenster wird Uber Window - Viewer geotffnet.
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4.14.3 Overview

Das Overview-Fenster zeigt den gesamten Ausschnitt der geladenen Daten eines
Layers an. Das Fenster wird Uber Window - Overview gedffnet. Der auf der Karte
dargestellte Ausschnitt erscheint im Overview-Fenster als Rechteck. Wird dieses
Rechteck verschoben, wird auch der Ausschnitt der Karte verschoben. Durch
Verkleinern und Vergrossern der Flache kann in der Karte auch rein- und
rausgezommt werden.

Durch Rechtsmausklick auf die Titelleiste > Properties... kdémnen z.B. das

Erscheinungbild des Rechteckes und die Hintergrundsfarbe des Fensters eingestellt

und der dargestellte Layer ausgewéhlt werden.

4.15 Hyperlinks

Mit Hilfe von Hyperlinks kénnen den Features zusatzliche Informationen wie
Homepages, Dokumente, Bilder etc. zugeordnet werden.
Es gibt drei verschiedene Hyperlink-Typen:
1. Document: Wenn Sie auf den Hyperlink klicken, 6ffnet sich eine Datei. Diese
wird mit dem Programm geo6ffnet, mit welchem sie momentan verknupft ist.
2. URL: Wenn Sie auf den Hyperlink klicken, offnet sich eine Homepage im

Default-Webbrowser.
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3. Macro: Wenn Sie auf den Hyperlink klicken, wird der aktuelle Attributwert an
ein Makro Ubergeben. Diese Option ermdéglicht es, massgeschneiderte
Hyperlinkverhalten zu erstellen.

Es gibt zwei Mdglichkeiten um Hyperlinks fur Features in einem Layer zu definieren:

e Feldbasierte Hyperlinks

¢ Dynamische Hyperlinks

4.15.1  Feldbasierte Hyperlinks

Bei diesem Typ von Hyperlink wird der Pfad zu einem Dokument, einer URL oder
einem Macro flur jedes Feature eines Layers in einem Attribut in der Datenbank
festgelegt. In diesem Feld kann entweder der ganze Pfad zum Dokument oder die
ganze URL abgespeichert werden oder nur der Name. Falls nur der Name abgelegt
wird, muss in den Map Properties... unter Hyperlink Base (siehe Kapitel 4.3.1) der
Pfad abgelegt werden, wo die Dokumente oder die URL’s abgelegt sind. So kdnnen
die Hyperlinks einfacher verwaltet werden. Wenn der Ort wechselt, wo die Hyperlinks
abgespeichert sind, muss so nur einmal der Pfad angepasst werden (statt anpassen
des Pfades in jedem Feld).

Um den Hyperlink mit Hilfe des Werkzeuges Hyperlink aus der Toolbar Tools (siehe
Kapitel 4.11.1) offnen zu kdnnen, muss das Hyperlinkfeld wie in Kapitel 4.8.5.4

beschrieben, festgelegt werden.

4.15.2  Dynamische Hyperlinks

Mit dieser Methode wird das Zieldokument oder der URL fur ein bestimmtes Feature
direkt festgelegt (Achtung: funktioniert nicht fur Makros). Es muss also kein Feld in
der Attributstabelle des Layers festgelegt werden.

Um einen dynamischen Hyperlink festzulegen, klickt man mit dem Identify-Tool
(Kapitel 4.11) auf das gewinschte Objekt. Durch Rechtsmausklick auf den Namen
des Objektes erscheint die Option Add Hyperlinks.... Dort kann der gewunschte Pfad
zu einem Dokument oder einer URL eingegeben werden.

Es kdnnen mehrere Hyperlinks fur ein Objekt abgelegt werden. Falls mehrere
Hyperlinks definiert wurden, erscheint beim Aufrufen der Hyperlinks mit dem

Hyperlink-Tool ein Fenster mit der Auswahl der definierten Links.
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416 Joins & Relates

4.16.1 Joins
4.16.1.1 Join tiber ein gemeinsames Attribut erstellen

Daten kbnnen aus verschiedenen Quellen stammen. Es kann vorkommen, dass die
Daten, welche Sie am Bildschirm darstellen wollen, nicht direkt mit einer Geometrie
abgespeichert sind. Wenn die gewinschte Information in einer Tabelle abgelegt ist,
kann sie mit einem vorhandenen geometrischen Feature durch ein gemeinsames
Attribut mit einem Join verknupft und so graphisch dargestellt werden. Die Tabelle
wird durch den Join um die Attribute der verknupften Tabelle erweitert. Wird der Join
wieder geldscht, werden auch die zuséatzlichen Attribute in der Tabelle wieder
entfernt. Die Verknupfung wird im Projekt gespeichert (d.h. sie wird wieder erstellt,
wenn das Projekt getffnet wird). Die Tabellen werden aber nicht verandert. Um das
Ergebnis eines Joins in einer Tabelle zu speichern, muss der Layer exportiert werden
(siehe Kapitel 6.7).
Join erstellen:
1. Rechtsmausklick auf den Layer, welcher durch die Attribute erweitert werden
soll = Joins and relates - Join...
2. Unter ,,What do you want to join to this layer” die Option Join attributes from
a table wéhlen.
3. Attribut der ersten Tabelle auswéahlen, Uber welches die beiden Tabellen
verbunden werden sollen.
4. Die zu verbindende Tabelle auswéhlen.
5. In der zu verbindenden Tabelle das Verbindungsattribut auswahlen.
Mit der Option Joins and relates > Remove Join(s) kénnen die erstellten Joins wieder
entfernt werden.
Alternativ zum oben beschriebenen VVorgehen zum Erstellen und Entfernen von Joins

lassen sich diese auch in den Layereigenschaften bearbeiten (siehe Kapitel 4.8.10).

4.16.1.2 Join iiber die raumliche Beziehung erstellen (Spatial Join)

Ein raumlicher Join (Spatial Join) verbindet die Attribute zweier Layer anhand der
Lage der Objekte in den Layers. Dabei kann man folgende Resultate finden:

¢ Das nachstgelegenste Feature von einem anderen Feature

e Was befindet sich innerhalb eines Features

e Schnittpunkte mit anderen Features

e Wieviele Punkte hat es innerhalb jedes Polygons
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Diese Resultate kann man auch durch eine topologische Selektion bekommen (siehe
Kapitel 9.2.2). Der Vorteil eines raumlichen Joins ist, dass die Resultate inkl. allen
Attributen von beiden Datensatzen direkt in einen neuen Layer geschrieben werden.
Hier die verschiedenen Methoden:

Das am nachsten gelegene Feature finden:

¢ Rechtsmausklick auf den Layer, welchem die Attribute hinzuzufigen sind ->
Joins and relates - Join...

e Unter ,What do you want to join to this layer” die Option Join data from
another layer based on spatial location wahlen.

¢ Name des Layers wahlen, von welchem die Attribute verkntpft werden sollen.
Wenn der Layer noch nicht im Projekt getffnet wurde, kann er Uber den
Browse Button gesucht werden.

e Wahlen Sie Each point will be given all the attributes of the line that is closest
to it, and a distance field showing how close that line is.

e Geben Sie den Namen und den Pfad fur das Output Shapefile oder Feature
Class und klicken Sie OK.

e Ein neuer Layer wird dem Projekt hinzugefugt.

Was befindet sich innerhalb eines Polygons:

e Rechtsmausklick auf den Layer, welchem Sie die Attribute hinzufiigen
mdochten - Joins and relates - Join...

e Unter ,What do you want to join to this layer” die Option Join data from
another layer based on spatial location wahlen.

¢ Name des Layers wahlen, von welchem die Attribute verkntpft werden sollen.
Wenn der Layer noch nicht im Projekt getffnet wurde, kann er Uber den
Browse button gesucht werden.

e Wahlen Sie: Each polygon will be given a summary of the numeric attributes
of the points that fall inside it, and a count field showing how many points fall
inside it.

e Auswahlen, wie Sie die Attribute zusammenfassen méchten

e Geben Sie den Namen und den Pfad fir das Output Shapefile oder Feature
Class und klicken Sie OK.

e Ein neuer Layer wird dem Projekt hinzugefugt.

4.16.2 Relates

Mit Relate werden Beziehungen zwischen zwei Tabellen erzeugt: Rechtsmausklick auf

den Layer - Joins and relates > Relate...
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Mit der Option Remove Relate(s) kdnnen die erstellten Relates wieder entfernt

werden.

417 Labels als Annotations

Die Position von einzelnen Labels, welche wie in Kapitel 4.8.9 beschrieben
eingeblendet werden, kann nicht verédndert werden. Sie wird nach einem
vorgegebenen Algorithmus bestimmt (Toolbar Labeling).Um die Labels z.B. fur eine
kartographische Darstellung positionieren zu kdénnen, gibt es die Mdglichkeit, Labels
als Annotations (von den Features losgeldste Textfelder) abzuspeichern. So werden
die Labels in einen eigenen Layer abgelegt und kdnnen einzeln verschoben und
geloscht werden. Dazu klickt man mit der rechten Maustaste auf den Layer, fur

welchen die Annotations erstellt werden sollen 2 Convert Labels to Annotation.
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5 Kartenlayout

Das Layout einer Karte wird im Programm ArcMap, in der so genannten Layout View
erstelit.
Wie Sie von der Data View in die Layout View wechseln kdnnen und was die

Unterschiede zwischen diesen beiden Ansichten sind, erfahren Sie im Kapitel 4.2.3.

5.1 Layout View

Der Kartenausschnitt, welcher in der Layout View dargestellt wird, bezieht sich
immer auf den Ausschnitt, der in der Data View zu sehen ist. Also muss zuerst in der
Data View der gewunschte Kartenausschnitt gewéhlt und aufbereitet werden
(Beschriftung, Symbole, Farben, Darstellungsreihenfolge...). Umgekehrt ist es genau
so: Wenn man den Ausschnitt in der Data View &ndert, &ndert sich der Ausschnitt in
der Layout View automatisch auch.

Mit dem Wechsel in die Layout View andert sich im Kartenfenster entsprechend auch
die Sicht auf das Projekt. Die aktuelle Karte wird nun als virtuelle Seite (einer Art
Druckvorschau) angezeigt, wobei jeder Data Frame als eigenstandiges, rechteckiges
Objekt erscheint, das sich frei platzieren lasst.

In der Layout View erscheint neben den Koordinaten der Zeigerposition (siehe

Kapitel 4.12.1 ) zusatzlich die Positionsangabe auf der virtuellen Seite:

609833.233 148639.657 Meters 1212 17.88 Centimeter: !I

5.1.1 Layout Toolbar

In der Layout View lasst sich ebenfalls mit der normalen Tools Toolbar navigieren
(siehe Kapitel 4.11). Werden jedoch die Werkzeuge aus dieser Tools Toolbar
verwendet, verandert sich der Ausschnitt gleichzeitig auch in der Data View (d.h. der
Kartenausschnitt verandert sich).

Wenn man nur auf der virtuellen Seite der Layout View navigieren mdchte, muss die
Layout Toolbar benutzt werden:

et . 000 [
EEEEEEEEEEEIEEIR)

Diese enthélt ahnliche Werkzeuge wie die Tools Toolbar, ist aber nur in der Layout

View aktiv. Der Kartenausschnitt bleibt dabei bestehen.
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i
Uber den Button @@ in der Layout Toolbar kann ein anderes Template gewahlit
werden (siehe Kapitel 4.3.3). ArcMap stellt dazu eine Reihe von Vorlagen zur
Verfugung. Es kdnnen aber auch selbst erstellte Vorlagen verwendet werden. Nach

Auswahl der gewiinschten Vorlage lasst sich die Anderung des Layouts ausfiihren.

5.1.2 Data Frame Toolbar

Mit der Data Frame Toolbar kann die Orientierung (Rotation) eines Data Frames auf
der Karte geédndert werden:

'_Data Frame Tools - -‘

® @20 <

Diese Toolbar kann in der Data View und in der Layout View verwendet werden. Wird

der Data Frame gedreht, so wird die Ausrichtung des Nordpfeiles in der Layout View

automatisch auch angepasst (Nordpfeil einfiigen siehe Kapitel 5.2.3).

5.2 Hinzufiigen von Kartenelementen in der Layout View

Einzelne Elemente (Beschriftung, Nordpfeil, ...) koénnen in der Layout View
hinzugefliigt werden. Diese Objekte sind in der Data View nicht sichtbar. Mit einem
Doppelklick auf ein eingefliigtes Element koénnen die Einstellungen des Objektes
angepasst werden (Art, Grosse, Lage, usw.).

Werden Anderungen in der Data View gemacht (z.B. ein Zoom), wird das
dazugehoriges Element (in diesem Fall das Massstab und der Massstabstext) in der

Layout View automatisch aktualisiert.

5.2.1 Titel und Text

Um der Karte einen Titel zuzuweisen, klickt man auf das MenU Insert > Title.
ArcMap flgt automatisch ein Textfeld in das Layout ein. Mittels Doppelklick auf das
Textfeld gelangt man in ein Dialogfenster, in welchem der Text bearbeitet werden
kann (z.B. Schriftgrosse und —art anpassen).

Um ein Textfeld in die Karte einzufugen, klickt man auf das Menu Insert > Text.

Dieses Textfeld kann ebenfalls durch Doppelklicken bearbeitet werden.

5.2.2 Legende

Fur die Erstellung einer Legende stellt ArcMap den Legend Wizard zur Verfligung,
der aus den bestehenden Layer-Symbologie eine Kartenlegende erstellt. Uber das

Menu Insert 2> Legend... kann eine Legende hinzugeflgt werden:
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1. Layer auswéhlen, welche man in die Legende einfigen moéchte und ihre
Reihenfolge festlegen.
Verschiede Einstellungen fur den Titel der Legende definieren
3. Rahmen und Hintergrund der Legende definieren.
Die Darstellungsart der Objekte (Punkte, Linien und Flachen) der
verschiedenen Layer konfigurieren.
5. Absténde zwischen den verschieden Elementen wéhlen.
Um die Herstellung der Legende zu vereinfachen, kann bei jedem Schritt Gber den
Preview-Button eine Vorschau der Legende angezeigt werden. Nach der Bestatigung
der vorgenommenen Einstellungen wird die Legende in das aktuelle Layout
eingefugt. Wenn spater noch Anpassungen vorgenommen werden mdchten, so kann
durch Doppelklick auf die Legende der Legend Wizard erneut getffnet werden.
Werden im TOC Anderungen gemacht, so werden diese Anderungen in der Legende
automatisch angepasst.
Entspricht die Legende grundsatzlich nicht den Vorstellungen, so kann diese mittels
Rechtsmausklick auf die Legende > Convert to Graphics in eine Grafik umgewandelt
werden. Die Gruppierung wird mittels Ungroup aufgehoben. Damit kdnnen die

Bestandteile einzeln bearbeitet und den Bedilrfnissen angepasst werden.

5.2.3 Nordpfeil

Uber das Menii Insert & North Arrow... kann ein Nordpfeil in die Karte eingefugt
werden. Uber den Button Properties... kann der gewahlte Nordpfeil angepasst und
Uber den Button More Styles koénnen weitere Bibliotheken wvon Nordpfeilen
dazugeladen werden. Die Grosse kann durch Ziehen der Ankerpunkte verédndert

werden.

5.24 Massstabsleiste

Uber das Meni Insert = Scale Bar... kann eine Massstabsleiste hinzugefiigt werden.
Uber den Button Properties... kann die gewahlte Massstabsleiste angepasst und Uber
den Button More Styles kdnnen weitere Bibliotheken von Massstabsleisten ein- und

ausgeblendet werden.

5.2.5 Massstabstext

Uber das Meni Insert > Scale Text.. kann ein Massstabtext entweder in
ausgeschriebener Form (,,dcm equal to 250 meters*) oder in Form eines
Verhéltnisses (,,1:25'000“) eingefiigt werden. Dieser Massstabstext wird bei

Anderungen des Zoombereiches laufend angepasst.
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5.2.6 Tabelle einfiigen

Um eine Tabelle in der Karte darstellen zu kédnnen, muss die Tabelle zuerst getffnet
werden (siehe Kapitel 6.2). Die Tabelle kann dann uber Options > Add Table to

Layout in die Karte eingefuigt werden.

5.2.7 Bild einfiigen

Bei Bedarf kann auch Uber Insert > Picture... ein Bild dem Layout hinzugefligt
werden. Importierbar sind alle Graphikobjekte (Fotos, Logos,..) in den géangigen
Bildformaten (JPG, GIF, TIF,..).

5.3 Arbeiten mit mehreren Data Frames

Wie bereits beschrieben koénnen in der Layout View mehrere Data Frames
gleichzeitig dargestellt werden. Die verschiedenen Data Frames kénnen beliebig auf
der virtuellen Seite in der Layout View verschoben, verkleinert und vergrossert
werden (Mehr zum Thema Data Frames siehe Kapitel 4.4).

Da die einzelnen Data Frames verschiedene Massstabe, Nordrichtungen etc. haben
koénnen, ist es oft sinnvoll, fir jeden Data Frame einzeln die Layout View-Elemente
wie z.B. der Nordpfeil oder Massstab einzufigen (Elemente einfigen, siehe
Kapitel5.2). Das heisst, dass es mehrere Elemente vom gleichen Typ in einer Karte
geben kann (z.B. zwei Nordpfeile). Beachten Sie beim Einfigen der Elemente, dass
der richtige Data Frame ausgewahlt ist. Sonst besteht die Gefahr, dass Sie z.B. unter

einen Data Frame einen falschen Massstab schreiben.

5.4 Karte speichern und exportieren
5.4.1 Karte als Template abspeichern

Nach der Fertigstellung des Layouts kann die Karte als Vorlage (ArcMap Template
.mxt) fur weitere Karten abgespeichert werden (siehe Kapitel 4.3.3 Speichern als

ArcMap Template (.mxt)) .

5.4.2 Karte exportieren

Man kann in der Layout View aus verschiedenen Export-Formaten auswahlen: File >
Export Map... (Filetypen: JPEG, PDF, EPS, ...).
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6 Mit Sachdaten arbeiten

Zu jedem geladenen Vektordatensatz gehoért auch eine Tabelle mit Sachdaten. Diese

erhalt immer mindestens eine eindeutige Objekt-1D (OBJECTID).

6.1 Tabelle 6ffnen

Um eine Tabelle zu o6ffnen,

klicken Sie mit der rechten Maustaste auf den

Layernamen im TOC und wahlen Open Attribute Table. Es 6ffnet sich das Attributes

of xxx Fenster.

Jede Zeile in der Tabelle entspricht einem Objekt, jede Spalte einem Attribut
dieses Objektes. Die Spalte mit der Objekt-ID (OBJECTID) und die Spalte Shape

werden vom System automatisch erzeugt.

6.2 Tabellenoptionen

Nutzun

selected) mﬁ%

44

a
sQL

&l

W

Find & Replace...
Select By Attributes...

Clear Selection
Switch Selection
Select All

Add Field...

Turn All Fields On
Show Field Aliases

Restore Default Column Widths
Joins and Relates

Related Tables

Create Graph...

Add Table to Layout

Reload Cache

Print...

Reports
Export...

Appearance...

e Find & Replace... — Zeichenfolgen in der Attributstabelle finden und/oder mit

einer anderen Zeichenfolge ersetzen

e Select By Attributes... — Abfrage anhand von Attributen (siehe Kapitel 6.4.2)

e Clear Selection — Selektion I6schen (siehe Kapitel 6.4.5)

6-1
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6.3

Switch Selection — Selektion umkehren (siehe Kapitel 6.4.3)

Select All — Alle Elemente selektieren (siehe Kapitel 6.4.4)

Add Field... — der Tabelle neues Attribut hinzufiigen (siehe Kapitel 6.5)

Turn All Fields On — Alle Attributsfelder einblenden (Felder ausblenden siehe
Option Turn Field Off Kapitel 6.3)

Show Field Aliases — Anstatt Feldnamen werden Alias-Namen angezeigt.
Zwischen Alias- und Feldnamen kann auch mit Hilfe der Tastenkombination
Ctrl + Shift + N hin und her gewechselt werden.

Restore Default Column Widths — Fur alle Attributsfelder wird die Default-
Breite wiederhergestellt

Join and Relates — Gleiche Optionen wie unter 4.16 Joins & Relates

Related Tables — Auflistung der Tabellen, welche als “Related tables” mit der
aktuellen Tabelle verbunden sind

Create Graph... — Graph erstellen

Add table to Layout — Tabelle in eine Karte in der Layout View einfligen (siehe
Kapitel 5.2.6)

Reload Cache — Tabelle wieder neu laden, wenn Anderungen gemacht wurden
Print — Tabelle drucken

Reports... — Bericht erstellen

Export — Exportiert die Tabelle oder eine Selektion der Tabellenelemente als
.dbf Datei

Appearance... — Darstellungsart der Tabelle andern (z.B. Schriftart und —

grosse der Tabelle, Farbe der Markierung der selektierten Elemente...)

Spaltenoptionen

Durch Klicken auf den Spaltennamen kann eine Spalte markiert werden (wird

eingefarbt). Durch Rechtsmausklick auf den grauen Rand der markierten Spalte

kénnen folgende Optionen aufgerufen werden:

Spalte aufsteigend (Sort Ascending), absteigend (Sort Descending) oder nach
Werten aus verschiedenen Spalten (Advanced Sorting...) sortiert

Erstellen einer neuen Tabelle, in welcher gleiche Elemente einer Spalte auf
einer Zeile zusammengefasst werden (Summarize...)

Statistiken erstellen (Statistics...)

Werte berechnen (Field Calculator...)...)

Geometrische Attribute (L&nge, Flache, Umkreis oder Koordinaten des

Zentroids) der Objekte rechen (Calculate Geometry...)
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o Attributsfelder ausblenden (Turn Field Off), Attributsfelder wieder einblenden
siehe Kapitel 6.2

e Spalte fixieren und Fixierung einer Spalte wieder auflésen (Freeze/Unfreeze
Column)

e Spalte lI6schen (Delete Field)

e Attribute ein- oder ausblenden, Alias und Primary Display Field definieren
(Properties...). Diese drei Optionen findet man auch im Tab Field (siehe
Kapitel 4.8.7). )

[ |

. & Sort Ascending
|- F Sort Descending
': %J‘ Adyanced Sorting...

Summarize...
': 2} Statistics...

Option Turn Field Off
e ——————
T — Freeze/Unfreeze Column

X Delete Field

Properties...

6.4 Obijekte selektieren

Unter Options im Attribute of xxx Fenster befinden sich einige Befehle, welche fur
das Arbeiten mit der Tabelle sehr hilfreich sind. Selektierte Objekte sind in der
Attribute Tabelle defaultmé&ssig blau markiert (diese Einstellung kann unter

Options 2 Appearance... veradndert werden, siehe auch Kapitel 6.2):

IEH] Attributes of Bodenbedec ; L =
OBJECTID* | SHAPE | Klasse | SHAPE_Length SHAPE_Area -
1 | Polygon Uebrig | 135678.975467 | 34072257.294684 [
2 | Polygon Wald 5042 470371 602717 692555
3 | Polygon Wald 1396210059 89161.203542 }
4| Polygon | Geroel 1438.312992 49979.448609 Selektierte
5 | Polygon Fels 27177.86439 4067652 03256 .
& |Polygon | Geroel 885797939 28770.781 } Objekte
7 | Polygon Uebrig 2552.684591 293655.913
& | Polygon Geroel 462.906614 9007 769569
9 | Polygon Uebrig 257.207873 2T27.2725 -

Record: ﬂl]l 1 ﬂﬂ SI'DW:W Selected | Records (5 out of 128 Selected) Options =

Arc
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6.4.1 Objekt von Hand markieren

Um ein Objekt auszuwahlen, klicken Sie auf den linken grauen Rand der
entsprechenden Tabellenzeile. Dieses Element ist nun sowohl in der Tabelle als auch
im Kartenfenster selektiert. Es konnen auch mehrere Elemente gleichzeitig selektiert

werden (mit Hilfe der Shift- oder der Ctrl-Taste).

6.4.2  Abfrage anhand von Attributen

Um Eintrdge, welche gewisse Attribute beinhalten, in einer Datei zu selektieren,
macht man eine thematische Abfrage (unter Options > Select by Attributes...).
Dort kann man die Bedingungen eingeben, welche die ausgewdahlten Elemente
erfullen sollen. Mehr zum Thema thematische Abfragen finden Sie im Kapitel 9.2.1
(Grundlagen) und 9.2.1.1 (Befehle in ArcGIS).

6.4.3 Selektion umkehren

Um eine Selektion umzukehren, wahlt man in der Attributtabelle Options - Switch

Selection.

6.4.4 Alle Elemente selektieren

Alle Elemente einer Tabelle kbnnen mit Hilfe von Options = Select All ausgewahlt

werden.

6.4.5 Selektion I6schen

Es gibt mehrere Méglichkeiten um eine Selektion in einem Layer zu I&schen:
e Im Attributes of xxx Fenster unter Options - Clear Selection
e Im Selection Anzeigemodus (siehe Kapitel 4.2.2.2)
e Mit Rechtsmausklick im TOC auf dem selektierten Layer Selection - Clear
Selected Features
Um alle Selektionen in allen Layern gleichzeitig zu léschen gibt es folgende
Mdoglichkeiten:
e Im Hauptmeni Selection - Clear Selection kénnen alle Selektionen (von allen
Layern) auf einmal geléscht werden

e Button in der Toolbar Tools (siehe 4.11)

6.4.6 Zur Selektion zoomen

Uber das Meni Selection = Zoom To Selected Features in der Hauptmeniileiste kann

zum selektierten Element gezoomt werden.
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6.4.7 Ansicht der Sachdaten

Unter Show kann ausgewahlt werden, ob alle oder nur die selektierten Elemente in

der Tabelle angezeigt werden sollen.

Show: | Al Selected I Records (13 out of 119 Selected)

6.5 Neue Attribute in Tabelle hinzufiigen

Durch Klicken auf Add Field... kann in die Attributtabelle ein neues Feld hinzugeflgt
werden. Es muss jedoch darauf geachtet werden, dass der Editor gestoppt (siehe
Kapitel 8.2.1) und das Programm ArcCatalog geschlossen sind. Mit einem
Rechtmausklick auf den Spaltennamen und Delete Field kann man ein Attribut
wieder l6schen (siehe Kapitel 6.3).

Es kann aus verschieden Attributstypen ausgewahlt werden:

Name Bereich, Lange Grosse
oder Format (Bytes)
Short Integer -32'768 bis 32'767 2 Ganze Zahlen
-2'147'483'648 bis
Long Integer 2'147'483'647 4 Ganze Zahlen
Float Ungefahr
ésgir:gclifr;e&srl)on floating _3.4E38 bis 1.2E38 4 Fliesskommazahlen
Double Ungefahr
[()C(I)?:]th:’]eufr:sg:’s)lon floating -2 2E308 bis 1.8E308 8 Fliesskommazahlen
Text bis 64'000 Kennzeichen variabel
Date ;\n/?hl/ltt/uu, hh:mm:ss, 8 Datum und/oder Zeit
BLOB variable variabel Komplexe Objekte wie
Binary Large Objects Bilder, Multimedia-Dateien

6.6 Werte in einer Tabelle a&ndern

Um Werte in eine Tabelle eingeben zu kdnnen, muss immer der Editor gestartet
werden (siehe Kapitel 8.2.1). Der Befehl um den Editor zu starten, heisst Start
Editing und befindet sich in der Toolbar Editor. Diese Toolbar kann Uber View >

Toolbars > Editor getffnet werden (siehe Kapitel 4.10).
Die Anderungen konnen mit Editor — Save Edits gespeichert werden.
Am Ende der Editierung muss der Edit-Modus mit Editor — Stop Editing geschlossen

werden.
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6. Mit Sachdaten arbeiten

6.6.1 Tabelle fillen
6.6.1.1 Manuell

Zuerst muss der Editor gestartet werden. Dann konnen die Werte manuell

eingegeben werden.

6.6.1.2  Berechnung

Anstatt einer manuellen Eingabe kodnnen die Attribute auch z.B. aus anderen
Datensatzen berechnet werden. Rechtsmausklick auf dem Spaltenamen - Field

Calculator... anklicken, jetzt entsprechende Formel eingeben.

6.6.2 Werte dndern

Mit einem Doppelklick in das gewlnschte Feld kénnen Werte in einer Tabelle

geéndert werden.

6.6.3 Objekte I13schen

Wenn ein Objekt (Zeile) einer Tabelle selektiert ist, kann dieses mit der Taste Delete
geldéscht werden.
Achtung: um Konflikte mit dem Lock von Daten zu vermeiden, muissen vor dem

Ldschen von Daten die anderen Programme von ArcGIS geschlossen werden!

6.7 Daten/Abfragen exportieren

Das Ergebnis einer Selektion kann in einen neuen Layer (Shapefile oder Feature
Class) exportiert werden. Dazu mit der rechten Maustaste auf den Layer > Data >
Export Data... klicken. Dort kann dann gewéhlt werden, ob alle Daten des Layers, nur
die selektierten Daten oder All Features in View Extent (die zurzeit sichtbaren Daten)
exportiert werden sollen.

Ausserdem kann gewahlt werden, ob das Koordinatensystem vom Layer oder vom

Data Frame verwendet werden soll.

Anleitung ArcGIS FS11 " GIS 6-6



7. Logische Modellierung

7 Logische Modellierung
7.1  Allgemeines

Beim Entwurf einer GIS-Anwendung wird ein Ausschnitt der realen oder fiktiven Welt

modelliert. Dies geschieht in vier Schritten (Vierschalen-Modell):

— —— Raumliches Modell

Konzeptionelles Modell

Logisches Modell

Physikalisches Modell

711 Riaumliches Modell

Die benétigten raumbezogenen und ergdnzenden Informationen werden als
rdumliches Modell verbal beschrieben. Diese Beschreibung ist eine idealisierte

Diskretisierung der realen Welt.

7.1.2 Konzeptionelles Modell

Das raumliche Modell wird in eine formal eindeutige Sprache Ubersetzt, um alle
Elemente der raumbezogenen Information mit ihren Attributen und Beziehungen
festzulegen. Dieses Modell kann in Textform oder mit graphischen Symbolen

beschrieben werden. Das konzeptionelle Modell ist software-unabhéngig.

713 Logisches Modell

Das konzeptionelle Modell wird in das vorhandene GIS-Programm eingefuhrt. Um
das logische Datenmodell zZu beschreiben, wird die systemeigene

Datendefinitionssprache verwendet.

7.1.3.1  Physikalisches Modell

Das Physikalische Modell beschreibt die Art der Datenspeicherung und die

zugehdorigen Zugriffsmechanismen.

7.2 lLogische Modellierung in eine ArcGIS-Geodatabase

Bei der logischen Modellierung in ArcGIS will man ein bestehendes konzeptionelles

Modell in das ArcGIS-System einfligen:
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KonzeptionellesModell LogischesModell
[manspoRT nETwoRK |
o 8 GEODATABASE
'E! l@ FEATURE DATASET
]
FEATURES ATTRIBUTES
... | =
SN A
. i
- e
e ‘ %m; “'“;.g TABELEE

Dabei hat man im System ArcGIS die Mdglichkeit eine Geodatabase 3 zZu
erstellen. Diese Geodatabase organisiert die geographischen Informationen in einer
Objekthierarchie.

Eine Geometrieebene heisst Feature Class (Objektklasse) 2l & Sl 4 B | A
Darin sind Features (Objekte) mit demselben Geometrietyp und denselben
Attributen enthalten. Mehrere Feature Classes kénnen zu einem Feature Dataset
gy gruppiert werden. In den Tabellen (engl. Tables) Zl sind nur thematische
Informationen (Sachdaten) gespeichert.

Diese Einteilung erleichtert in komplexen GIS-Datenbanken die Datenorganisation.

Achtung: Wenn die Grundeinstellungen (wie z.B. das Koordinatensystem und die
Ausdehnung) von Feature Classes und Feature Datasets einmal definiert sind,

kénnen sie nicht mehr abgeandert werden.

Konsistenzbedingungen gehdren auch zur logischen Modellierung und sind im Kapitel
7.5 erklart.

7.21 Geodatabase erstellen

Die Geodatabase (.gdb/.mdb) u | wird in ArcCatalog mit Rechtsmausklick auf den
gewlnschten Ordner angelegt: New > File Geodatabase oder New - Personal
Geodatabase. Eine File Geodatabase ist eine Alternative zur Personal Geodatabase

und ist erst seit ArcGIS 9.2 verfigbar. Da File Geodatabases nicht mit
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7. Logische Modellierung

zurtckliegenden Versionen von ArcGIS gelesen werden koénnen, sollten sie nur

verwendet werden, wenn man ausschliesslich mit ArcGIS-Versionen ab 9.2 arbeitet.

SRF 17:\Daten
2
Rename F2
5@ Disconnect Folder
< Refresh

23 Folder
€A\ Search.. g

Properties ) Personal Geodatabase

O Layer...

7.2.2 Feature Dataset erstellen

Ein Feature Dataset o ist eine Sammlung von Feature Classes (2l 2 =] etc., siehe
Kapitel 7.2.3), die das gleiche Referenzsystem, denselben rdumlichen Bereich und
dieselbe Genauigkeit haben. Ein Feature Dataset kann zuséatzlich noch Netzwerke (
’glGeometric Network), Beziehungen ("«-3: Relationship Class), Topologieregeln (
EITopology), Beschriftungen (i] Annotation) und Bemassungen (!“_"I Dimension)
enthalten.
g Geodatabase.mdb
iij @ Feature Dataset
=7 Ppoints
] Lines
__. - Polygones
5 EI Topology

?.E. Relationship

E' c@) Network

1. Rechtsmausklick auf die Geodatabase und ein neues Feature Dataset

erstellen: New - Feature Dataset....
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=-(@ Z:\Daten
Bmegrims

X Delete
Rename F2

C' Refresh

| Nev el esture potaset.. |
Import » [ Feature Class...
Export » Table...
Compress File Geodatabase... % Relationship Class...
Uncompress File Geodatabase... % Schematic Dataset

@ Compgéc Database I & Toolbox

9 Search... @ Raster Catalog...

38 Publish to ArcGIS Server.. . '
Distributed Geodatabase » ; i::;:::m

B Properties... l

T

Dem Feature Dataset einen Namen geben.

Koordinatensysteme auswahlen. Dabei kann entweder ein Koordinatensystem

aus der Liste ausgewahlt, das Koordinatensystem einer anderen Datei

importiert (Import...), ein neues erstellt (New) oder ein bestehendes

abgeandert werden (Modify).

. 'Arc
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!Neerature Dataset il |

Choose the coordinate system that will be used for XY coordinates in this data.

Geographic coordinate systems use lattude and longitude coordinates on a spherical model
of the earth's surface. Projected coordinate systems use a mathematical conversion to
transform latitude and longitude coordinates to a two-dimensional linear system.

Name: |CH1903 LvV03

< Back Next > Cancel

4. Im né&chsten Fenster kann ein Koordinatensystem fur die H6he ausgewahlt
werden.
5. Anschliessend kdénnen die Toleranzen von X und Y, von Z und von M

eingestellt werden.

@arc .
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, |
o rose oo i)

XY Tolerance

F The XY tolerance is the minimum distance between coordinates before they are
considered equal. The XY tolerance is used when evaluating relationships between
features.

[o.001 Meter

Z Tolerance

[0,001

M Tolerance

|6.001 Unknown Units

Reset To Default About Setting Tolerance

[V Accept default resolution and domain extent recommended)

Definition der raumlichen Ausdehnung

Haufig verwendetes Koordinatensystem fiir Projekte in der Schweiz
Projected Coordinate Systems — National Grids > CH1903LV03

Haufig verwendetes Hohensystem fur Projekte in der Schweiz:
Vertical Coordinate Systems — Europe — LN 1902

7.2.3 Feature Classes erstellen

Ein Feature Class ist eine Sammlung von geografischen Objekten mit dem gleichen
geometrischen Typ, gleichen Attributen und der gleichen rdumlichen Ausdehnung.

Ein Feature Class kann entweder in einem Feature Dataset oder direkt in einer
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Geodatabase® hergestellt werden. Die Features konnen vom Typ Punkte =, Linien 2

oder Polygone & etc. sein.

Rechtsmausklick auf dem Feature Dataset oder der Geodatabase und eine neue
Feature Class erstellen: New - Feature Class...:

¢ Name (und eventuell Alias) eingeben @.

Name: IMy_Fealu‘eQaSS @

Alias: l

~ Type
Type of features stored in this feature class:

IPongon Features

[ Coordinates include M values. Used to store route data.
[ Coordinates include Z values. Used to store 3D data.

e Type auswahlen ®:
o Polygon Features: Vielecke.
o0 Line Features: Linien.
o Point Features: Punkte.
o0 Multipoint Features: Objekte die aus mehreren Punkten gemacht werden.

LIDAR-Daten sind typische Multipath Features.

5 Fur eine ubersichtlichere Verwaltung der Daten wird empfohlen, Feature Classes in einem
Feature Dataset zu erstellen.

'Arc
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o Multipath Features: eine 3D-Geometrie fur die Flachendarstellung von
Flachen oder Volumen in 3D.

o Dimension Features: Wie Annotation Features, aber stellt eine Distanz oder
eine Lange dar, die automatisch angepasst wird, wenn sich die Objekte
&ndern (Bemassung).

0 Annotation Features: Text mit Formatierung und Platzierung (Siehe auch
Labels als Annotations Kapitel 4.17).

Unter Geometry Properties ® kann auch definiert werden, ob die Feature

Class Routing Daten (M values) oder H6hen (Z values) enthélt.

Durch Eingabe des Attributnames in ein leeres Feld kdnnen die Attribute der

Reihe nach angelegt werden. Definieren Sie fur jedes Attribut den Datentyp

(z.B. Date). Unter den Field Properties kdnnen ausserdem noch ein Alias-

Name, die Zulassung von NULL-Werten und ein Default-Wert, welcher allen

Objekten bei der Erstellung automatisch zugewiesen wird, definiert werden.

Ferner kann man hier, wenn erforderlich, die auf diesem Attribut zu

verwendende Domain auswéhlen (siehe Kapitel 7.3.1 Domain). Die beiden

Attribute OBJECTID und SHAPE werden vom System erzeugt und sind bei der

Erstellung einer Feature Class bereits in der Auflistung der Attribute

enthalten.

Anleitung ArcGIS FS11 " GIS 7-8



7. Logische Modellierung

P
New Feature Class

Field Name

OBJECTID

YA

Short Integer

Long Integer

Click any field to see its properties.

~ Field Properties

Alas

Aliow NULL values

Yes

Default Value

Length

S0

To add a new field, type the name into an empty row in the Field Name column, click inthe
Data Type column to choose the data type, then edit the Field Properties.

e Dialog mit Finish abschliessen.

7.2.4 Tabellen erstellen

Eine Tabelle Zl ist ein Objekt ohne Koordinaten (Geometrie), deshalb kann sie in

keinem Feature Dataset enthaltet sein,

Geodatabase hergestellt werden:

1. Rechtsmausklick auf die Geodatabase und eine neue Tabelle erstellen: New >

Table....

< Back Finish Cancel

sondern muss auf der Ebene der

Name (und eventuell Alias) eingegeben.

Durch Eingabe des Attributnames in ein leeres Feld kbnnen die Attribute der
Reihe nach angelegt werden. Definieren Sie fur jedes Attribut den Datentyp
(z.B. Date). Unter den Field Properties kdnnen ausserdem noch ein Alias-
Name, die Zulassung von NULL-Werten und ein Default-Wert, welcher allen

Objekten bei der Erstellung automatisch zugewiesen wird, definiert werden.

7-9
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4.

7.3

Ferner kann man hier, wenn erforderlich, die auf diesem Attribut zu
verwendende Domain auswéahlen (siehe Kapitel 7.3.1 Domain). Da eine
Tabelle keine Geometrie enthalt, wird im Unterschied zur Erstellung einer
Feature Class bei der Erstellung einer Tabelle nur das Attribut OBJECTID vom
System erzeugt.
Dialog mit Finish abschliessen.

- @ Geodatabase.mdb

+ @ Feature Dataset

Table

Wertebereichsdefinitionen

Es gibt zwei Moglichkeiten Wertebereiche fir die Attribute zu definieren: Domains

und Subtypes.

7.31

Domain

Die Domain ist ein definierter Bereich von Werten, der fir mehrere Attributfelder

eingesetzt werden kann.

Sie wird auf der Ebene einer Geodatabase definiert und kann in allen Feature Classes

der gesamten Geodatabase von mehreren Feature Classes gleichzeitig benutzt

werden.

1.
2.

Rechtsmausklick auf der Geodatabase - Properties... > Tab Domain.
Zuerst muss der Name der Domain definiert werden oder man wahit den
Namen einer bereits bestehenden Domain aus. Es kbnnen mehrere Domains
in einer Geodatabase definiert werden ©.
Die Werte einer Domain kdnnen auf zwei verschiedene Arten eingegeben
werden @:
¢ Range Domain
In einer Range Domain bestehen die ,Werte' aus numerischen Werten. Es
werden eine obere und eine untere Grenze definiert. Anschliessend
kénnen nur noch Werte aus dem definierten Bereich ausgewahlt werden.
Damit werden die Werte automatisch wahrend der Eingabe validiert.
e Coded Value Domain
Eine Coded Value Domain kann jeden Datentyp enthalten (Text,
numerische, Datum etc.).
Schliesslich mussen die verschiedenen Werte der Domain eingegeben werden
Q.
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Die Domain kann dann

Database Properties -
General Domains |
Domain Name Description -
W Eetricbszeil ,o] Wann geoeffnet
Dienstiedungen
Einkaufen Einkaufsmoeglichketten
Uebernachten Uebernachtungsmoeglichkeiten
Domain Properties:
Field Type A
Domain Type Coded Values ( 2 ] :
Spit policy Range
Merge policy nded
Coded Values:
Code Description »
1 —~ | 9anzjaehriich 4
(3 ) | Wintersaison
3 N/ | Sommersaison
OK | Concel | Aoply

in den einzelnen Feature Classes in einem spateren

Arbeitsschritt in den Feature Class-Eigenschaften auf dem Reiter Fields gesetzt

werden, indem man das gewulnschte Feld markiert und unter den Field Properties die

Domain auswahlt.

7-11
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XY Coordinate System ] Tolerance | Resolution | Domain
Indexes I Subtypes |  Relationships I Representations

Field Name Data Type -
| OBJECTID Object D
Shape Geometry
Name Text
Betriebszet Long integer

Click any field to see its properties.

Field Properties
Alias Betricbszeit
Allows NULL values Yes

Valu
<Domain ; = '

Betriebszeit
Dienstietungen
To add a new field, type the namfl Einkaufen
the Data Type column to choose jjUebernachten

Der Benutzer kann dann bei der Erfassung der Daten in einer Dropdown-Liste aus

den vordefinierten Werten der Domain auswahlen.

73.2  Subtype

Ein Subtype wird fur eine bestimmte Feature Class definiert und ist nur innerhalb
dieser brauchbar.

1. Rechtsmausklick auf die Feature Class oder Tabelle, flir welche ein Subtype
erstellt werden soll > Properties...

2. Im Tab Subtype aus der Dropdown-Liste das gewilnschte Subtype Field
auswahlen. Es werden nur diejenigen Attribute angezeigt, welche als Long
Integer oder Short Integer definiert wurden.

3. Anschliessend in die Code-Felder die Subtype-Werte (Integerzahlen) und im

Feld Description den dazugehdrigen Text einfligen.

'Arc
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4. Unter Default Subtype muss noch ein Subtype Wert ausgewahlt werden,
welcher beim Erstellen eines neuen Objektes automatisch als Wert eingefligt

wird.

-
Feature Class Properties

General | XY Coordinate Sygtam Tolerance | Resotion | Domain
Fieds | Indexes Subtwes )| Relationships |  Representations N

Subtype Field: |nm L| ||

Default Subtype: |unbestimmt >
Defaultwert

Subtypes: (fuir neue erfasste Objekte)

Code Deseription | B
Geroell | (I
Fels_\Wald
s
Gletscher
See
Siedluna
J L

o LGRS

Default Yalues and Domains:
Field Mame
SHAPE_Length

Default Value

7.4 Beziehungen definieren

Mit den Beziehungen % konnen Abhangigkeiten zwischen verschiedenen Feature
Classes definiert werden.
1. In ArcCatalog Rechtsmausklick auf die Geodatabase oder das Feature
Dataset: New > Relationship Class....
2. Der Beziehung einen Namen geben und die zwei Tabellen (origin und
destination) identifizieren.
3. Zwischen composite und simple wahlen. In den Simple-Beziehungen

existieren die Objekte unabhangig voneinander, wahrend in den Composite-

'Arc
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Beziehungen die Objekte in ihrer Existenz voneinander abhangen. Eine m:m
Beziehung ist mit einer composite-Beziehung nicht méglich.

4. Die zwei Rollennamen (labels) eingeben, die zu einer Beziehung gehéren.
Diese Beschreibungen sind im Eigenschafts-Fenster (Attributes) eines
Objektes dargestellt (siehe Kapitel 8.3.2.2 Punkt 2). Je nach dem, ob ein
destination oder origin Objekt angeschaut wird, erscheint das forward oder
das backward path label.

Man kann dazu eine Meldung (message) zwischen den Tabellen einfiigen, die
wéhrend der Datenerfassung und Datenanalyse weitergegeben wird.

Die Kardinalitat auswéhlen (1:1, 1:m oder m:n).

Falls gewiunscht kdnnen noch zusatzliche Attribute der Beziehung eingegeben
werden.

7. Im Fall einer m:n-Beziehung muss eine Zwischentabelle mit den
Fremdschlusseln der beiden Tabellen erstellt werden. Die Namen der Felder

dieser Verknupfungstabelle kbnnen im nachsten Fenster definiert werden.

Wanderwege

IOBJ ID_Jlaenge I Bergrouten
1

E FID Name
L

Zwischentabelle

Bei 1:1 und 1:m-Beziehungen miuissen nur die Attribute angegeben werden,
Uber welche die Tabellen zueinander in Beziehung stehen.
8. Einstellungen in der Zusammenfassung nochmals Uberpriufen und mit Finish

abschliessen.

7.5 Konsistenzbedingungen

Im Bereich der Geoinformatik spricht man von konsistenten Daten, wenn innerhalb
eines Datenbestandes (z.B. einer Datenbank) geometrische und sachlogische
(semantische)  Widerspruchsfreiheit  gewahrleistet  wird. Innerhalb  eines
Datenmodells mussen die vordefinierten Konsistenzbedingungen (engl. Constraints)

erfullt sein. Es durfen beispielsweise keine doppelten Primarschlissel existieren und
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redundante Datenhaltung sollte vermieden werden, da sie zu Inkonsistenz und damit
zu Fehlentscheidungen fuhren kann.

Die Konsistenzbedingungen ermoéglichen vorhandene Daten auf ungiltige Werte in
den Attributen oder in der Geometrie (Topologie) zu Uberprifen. Damit wird die

Attributierung effizienter und Fehleingaben werden verhindert.

7.5.1 Topologie definieren (rdumliche Konsistenzbedingugen)

Mit topologischen Regeln werden geometrische Beziehungen und Regeln zwischen
Feature Classes definiert. Dazu missen die Feature Classes im gleichen Feature
Dataset sein (dasselbe Raumbezugssystem). Ein Feature Dataset kann mehrere
TopoIogie—SetsEI enthalten und jedes Set kann mehrere Topologie Regeln haben.
Aber jede Feature Class kann jeweils nur in einem Set sein.
1. In ArcCatalog Rechtsmausklick auf einem Feature Dataset: New - Topology
2. Der Topologie einen Namen geben und die Cluster Tolerance einstellen (es
wird empfohlen die Standardeingabe zu behalten)
3. Die Feature Classes auswahlen
Das Ranking einstellen. Ranks kontrollieren, wie die Objekte wahrend der
Validierung zusammensnappen. Eine Feature Class mit einer besseren
raumlichen Genauigkeit sollte deshalb einen hdoheren Rank bekommen als
Feature Classes mit einer tieferen Genauigkeit. Der hochste Rank ist 1. Bei
der Validierung werden Eckpunkte von Feature Classes mit einem tieferen
Rank zu benachbarten Eckpunkten von Feature Classes mit einem hd&heren
Rank snappen, falls der Abstand innerhalb der angegebenen Cluster

Tolerance liegt:

Endpunkte verschieben

Ausgangshge: sich auf Mittellage

-™q

ﬁ_‘_" ’

v N

' | I 1’
\ ¢ L4
\~ g

Cluster-Toleranz

gleichrangig

Crackpunkte verschieben
sich auf Endpunkte
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Linie L verschiebt sich zu LinieH

ungleich

H = hdchster Rang
L = niedrigster Rang

Ist der Abstand zwischen zwei Eckpunkten von Objekten mit gleichem Rank
innerhalb der Cluster Tolerance, so wird die Position dieser Punkte

geometrisch gemittelt und zu einem Punkt zusammengefasst:

Cluster-Tolerance

Nach der Validierung

5. Die topologischen Regeln einfiigen (Add Rule ...)
6. Einstellungen in der Zusammenfassung nochmals Uberprifuen und mit Finish

abschliessen

Das Priifen der Topologie ist im Kapitel 8.4 erklart. Fir eine Ubersicht Uber die
verschiedenen Topologieregeln siehe unter: ArcGIS Desktop Help, ,topology rules

poster*.
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8 Datenerfassung

Der Gesamtablauf von der Datenbeschaffung bis zur Datenerfassung gliedert sich in
mehrere Phasen:

e Die Informations-Bedarfseinschatzung behandelt die Fragen nach dem
Datenbestand (welche Daten existieren, wie aktuell sind sie, usw.) und dem
zusatzlichen Datenbedarf (wo und wie sind diese Daten erhaltlich) sowie nach
den Daten, welche sich durch die Verarbeitung ergeben sollen.

e Die Sammlung und Evaluation der Datenquellen und
Erfassungsmethoden (Qualitat, Bedeutung, Eignung, Nutzung,
Metainformation, usw.).

e Die eigentliche Datenerfassung.

Die Geometrie kann durch verschiedene Verfahren erfasst werden. Dabei stehen in
ArcGIS folgende Quellen zur Verfigung:

e ArcGIS Feature Class, Shapefile, usw. (direkte Anwendung)

e Rasterdaten (als Hintergrundbild fiirs Digitalisieren)

e Digitale Tabellen (Importieren / Konvertieren)

e Fremdformate (Transferieren / Importieren / Konvertieren)

8.1 Daten importieren / exportieren (ArcCatalog)
8.1.1 Spezifische Geodatenformate erfassen (Shape, Coverage, usw.)
8.1.1.1  Import eines Geodatenformates in eine Geodatabase

Diese Methode wird verwendet, wenn die gewlnschten Geodaten in einem anderen
Format bereits vorhanden sind.® Es kann der gesamte Datensatz oder mittels
Selektion nur ein gewinschter Ausschnitt aus den Daten in eine Feature Class einer
Geodatabase importiert werden.
Vorgehen:

1. Rechtsmausklick auf die Feature Class, in welche die Daten importiert werden

sollen — Load — Load Data...
2. Eine oder mehrere Dateien auswéhlen, aus welchen die Daten importiert

werden sollen und diese mit Add in der Liste hinzufiigen.

% In diesem Kapitel geht es nur um die Erfassung von Daten in einer Geodatabase. Wie Daten
ausserhalb einer Geodatabase erfasst werden kénnen, wird nicht behandelt.
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3. Geodatabase und Feature Class auswahlen, in welche die Daten importiert
werden sollen. (Diese Einstellung ist meistens schon festgelegt und kann
nicht verandert werden). Falls die Feature Class einen Subtype enthélt, kann
in dieser Maske ausgewahlt werden, ob alle Daten in einem Subtype
zusammengefasst werden sollen oder nicht.

4. Definieren, welches Feld der Ursprungsdatei in welches Feld der Feature Class

eingefugt werden soll:

5mee v Lo o

For each target field, select the source field that should be loaded into it

Target Field Matching Source Field —l <
Name [string] P | NAME [string] L3
ilasse [int] P KL A in
Brete [float] P | BREITE [int)

5. Auswahlen, ob der gesamte Datensatz oder nur ein Teil der Daten
tbernommen werden soll. Uber den Button Query Builder kann der Import

eingeschrankt werden.

'Arc
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You can load all of the features from your source data into the target
feature class or you can limit what is loaded by defining an attribute query.

" Load all of the source data
{% Load only the features that satisfy a query

"GEWISSNR"
"ABSCHNIT"
"NAME"
"BREITE"
"KLASSE"
"OBJORIG"

= | <>| Lkel
> | >=| Ancl|

< | <-| Orl
%] _0 | et

Is I [ Get Unique Yalues IGOTo: I—

SELECT * FROM fluesse WHERE:
"KLASSE" =7

0

Farc .
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7. Die Zusammenfassung uUberprifen und falls noch Fehler worhanden sind,
diese durch zuriickgehen in den Masken korrigieren. Sonst Import mit Finish

abschliessen.

8.1.1.2  Export aus einem Geodatenformat in eine Geodatabase

Mit Rechtsklick auf eine bestehende, dateibasierte Feature Class (z.B. Shapefile)
kann diese in eine Geodatabase exportiert werden: Export > To Geodatabase
(simple).... Im sich darauf o6ffnenden Dialog kann eine Geodatabase als Ziel
ausgewahlt werden. Unter Output Feature Class ist ein Name fiUr die neu zu
erstellende Feature Class anzugeben. Zudem lasst sich die Liste der zu
exportierenden Attribute sowie deren Benennung anpassen und der Datenumfang
durch eine Abfrage (Query) einschranken

Mit der Option Export > To Geodatabase (multiple)... kbnnen mehrere dateibasierte
Feature Classes gleichzeitig in eine gemeinsame Geodatabase exportiert werden. In
diesem Falle lassen sich jedoch weder Einstellungen zu den Attributen noch Abfragen

vornehmen.

8.1.1.3  Daten zwischen zwei Geodatabases kopieren

Mit den Befehlen Load Data... (siehe Kapitel 8.1.1.1) und Export - To Geodatabase...
(siehe Kapitel 8.1.1.2) kdnnen auch Daten zwischen zwei Geodatabases importiert

oder exportiert werden.

8.1.2 Koordinaten aus einer Tabelle oder einem Textfile importieren

Um eine Tabelle’ oder ein Textfile mit X- und Y-Koordinaten (oder X-, Y- und Z-
Koordinaten) importieren zu koénnen, muss sie/es zuerst in ArcCatalog in ein
Shapefile umgewandelt werden:
1. Rechtsmausklick auf die Tabelle oder das Textfile > Create Feature Class >
From XY Table...

7 Seit ArcGIS 9.2 kénnen nebst Tabellen im .dbf Format auch Microsoft Excel-Dateien (.xls) in
eine Geodatabase importiert werden.
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e — " Iy
Create Feature Class From XY Table M
2w

Input Fields
X Field:

FCoon:Iinate System of Input Coordinates... |

Output
Specify output shapefile or feature class:

|C:\'ny5hape.shp

Advanced Geometry Options... I

2. Aus den Dropdown-Listen die Felder auswahlen, in welchen die X- und Y-
(und optional die Z-) Koordinaten abgespeichert sind.

3. Output-File angeben. Die Daten kénnen entweder in ein Shapefile, eine File
oder Personal Geodatabase Feature Class oder eine SDE Feature Class
abgespeichert werden. (Achtung: um die neu erstellte Datei im ArcCatalog
zu sehen ist ein Refresh (Rechtsmausklick auf den Ordner -> Refresh)
notwendig.)

Anschliessend kann das erzeugte Shapefile wie in Kapitel 8.1.1 beschrieben

importiert werden.

Um ein Textfile in ein Shapefile oder direkt in eine Feature Class umwandeln zu
kénnen, muss die Datei folgende Struktur aufweisen:
1. In der ersten Zeile mussen die Bezeichnungen der verschiedenen Spalten
aufgelistet sein.
2. Die einzelnen Spalten mussen entweder durch einen Tabulator oder durch
Kommas getrennt sein.® Wichtig ist, dass in der ersten Zeile das gleiche

Trennungszeichen verwendet wird wie bei den nachfolgenden Daten.

8 Weitere Hilfe zum Einlesen von Textdateien enthilt die Online-Hilfe von ArcGIS unter dem
Suchkriterium ,,delimited text file“.
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X y Name

603892.8 147635.41 Seerolehore
604020.88 146917.39 Tielberg
605072.69 143447.57 Regenbotdshorn
606054.64 140637.57 Ammertenhorn
606624.3 142430.69 Ammertenspitz

8.1.3 Inhalt von Tabellen l6schen

Siehe Kapitel 6.6.3 Objekte l6schen.

8.2 Daten digitalisieren (ArcMap)

Eine Vielzahl von raumbezogenen Daten liegt noch als analoge Karten, Plane,
Zeichnungen etc. vor. Damit diese Daten auf dem Computer weiterverarbeitet oder
gespeichert werden kdénnen, muss man sie in eine vom Computer lesbare Form
bringen. Diese Umwandlung von analogen Daten in eine digitale Form nennt man
digitalisieren. Dies geschieht mittels Digitalisiertisch, Tablett, Cursor oder Scanner.
Fur einfachere Aufgabenstellungen wird oftmals auch die Maus als Digitalisier-
Werkzeug verwendet.
Um die Digitalisierung effizient und gut durchfuhren zu kdnnen, sollte man sich die
Digitalisierumgebung entsprechend einrichten. Folgende wichtige Punkte sind zu
beachten:

1. Eine ,gute” Digitalisiergrundlage suchen (bezlglich der Genauigkeit, der

Bildqualitat und des Koordinatenbezugs).

2. Die Snappingumgebung einrichten (siehe Kapitel 8.2.3).

8.2.1 Editieren beginnen

Unter View > Toolbars die Editor-Toolbar 6ffnen.
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= i 2
u) Stop Editing 3
By Save Edits (8]

Move...
& Buffer...
Merge...
Union

Intersect

More Editing Tools  §

@ Validate Features
I Spapping... (4
I Options... (5

1. Um Daten erfassen oder &ndern zu kdnnen, muss der Editor unter Editor >
Start Editing @ aktiviert und der zu editierende Datensatz unter Target ®
ausgewahlt werden.

WICHTIG: Immer kontrollieren, dass unter Target ® der richtige Layer
ausgewabhlt ist. Sonst wird im falschen Layer editiert. Zudem kdénnen mehrere
Layer dieselbe Datengrundlage (Feature Class) besitzen: Eine Anderung im
einen Layer hat in diesem Fall auch Auswirkungen auf die anderen Layer

Den Task @ auf Create New Feature einstellen.

Unter ® wird das gewinschte Digitalisierwerkzeug ausgewéhlten (meistens
Sketch tool).

v Task | C
4 = Intersection Tool

Sketch ToO| === 2 (== Arc Tool
Midpoint Tool — (" { ===Tangent Tool
Distance-Distance TOO| wm==&| & £J=r—Trace Tool

End Point
Arc Tool Direction-Distance
Tool

Features zeichnen

5. Die erfassten Features kdnnen wéahrend des Editierens mit Save Edits
gespeichert werden.

6. Wenn die letzten Features erfasst wurden, muss der Editor mit Stop Editing ®
wieder beendet werden. Dabei kann man wéhlen, ob die Anderungen (seit

dem letzten Speicherungsvorgang) abgespeichert werden sollen oder nicht.
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8.2.2 Attribute erfassen

Den erfassten Objekten sind nun die Attribute zuzuweisen. Um die Attribute von
Objekten zu setzen sind zwei Vorgehensweisen madglich:
1. Die Attribute kdnnen direkt beim digitalisieren im Attribut-Fenster erfasst
werden @
2. Die Attribute werden nachtraglich in der Attributtabelle eingegeben.
Rechtsmausklick auf den entsprechenden Layer - Open Attribute Table.
Die Attribute kdnnen einzeln eingetippt oder es kébnnen mehrere Reihen mit Hilfe des
Befehls Field Calculator erfasst werden (siehe Kapitel 6.6).
WICHTIG: Die Edit-Session muss beim Erfassen geotffnet sein. Die Anderungen

kénnen auch wahrend des Editierens mit Save Edits ® gespeichert werden.

8.2.3  Snappingumgebung

Mit Hilfe der Editierfunktion Snapping kann sichergestellt werden, dass Punkte, die
innerhalb einer festgelegten Distanz von bestehenden Punkten und Linien abgesetzt
werden, koordinatenmassig auch auf diese Punkte und Linien zu liegen kommen. So
kann gewéhrleistet werden, dass sich Knoten auf einem Endpunkt eines Abschnittes
befinden oder aufeinander folgende Abschnitte denselben End- wie Anfangspunkt

haben.

Abschnitte

° Knoten

N
4

Keine

Verbindung zwischen

den Abschnitten Knoten liegt -[ ° |

nicht auf Endpunkt N
einesAbschnittes

8.2.3.1 Snapping-Toleranz

Die Snapping-Toleranz ist der Abstand, innerhalb welchem der Mauszeiger zu einem

bestehenden Feature (Knoten, Kante oder Endpunkt) snappt.
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General | Topology | Versioning | Units | Edit Tasks | Annotation | Attributes |

Il
Display measurements using I 3 decimal places

I Snapping tolerance: | 7 Ipixels ;] I

Sticky move tolerance: | 0 pixels

I stretch geometry proportionately when moving a vertex

™ Show snap tips
Stream Mode

Stream tolerance: | 0 map units

Group l 50 points together when streaming

Unter Editor > Options... ® kann im Tab General der gewlnschte Wert fur die
Snapping-Toleranz in Pixel oder Map Units eingegeben werden.
Wahrend dem Editieren kann die eingestellte Toleranz mit der Taste T graphisch

dargestellt werden:
P e

(&)

8.2.3.2  Snapping-Eigenschaften und —Prioritat

Uber die Funktion Snapping ® kann das Snapping-Umgebungsfenster geoffnet
werden. Dort kann durch aktivieren und deaktivieren der Checkbox eingestellt
werden, auf welche Knoten (Vertex), Kanten (Edge) und Endpunkte (End) der
vorhandenen Layer der neu zu erfassende Punkt einrasten soll.

Durch das Verschieben eines Layernamens nach unten oder oben wird die

Snappingreihenfolge der Layer verandert.

Arc
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' Snapping Environment L -
Layer Vertex | Edge End
huette O O O
spitzen O O O
wanderwege v v vl
bergroute O O O
bergbahnen O O O
strassen O O O
fluesse O O 0
gebaeude O O O
Bodenbedeckung O O O
=[] Edit Sketch &

1 Fdit cketrh verticee >

8.3 Erfassung komplexer Objekte

Um die die Erfassung komplexer Objekte besser erklaren zu kénnen, wird sie anhand
eines konkreten Beispiels erlautert. Das Beispiel besteht aus Abschnitten und SBB-
Strecken, wobei die SBB-Strecken die komplexen Objekte sind. Eine SBB-Strecke

wird aus verschiedenen Abschnitten zusammengestellt.

SBB-Strecke

Name
Nummer

0..*

0.:F
Abschnitt

Nummer

O Abschnitt
— SBB'StFECke A
sannnnnnns SBB-Strecke B

8.3.1 Modellierung der komplexen Objekte (ArcCatalog)
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8.3.2
8.3.21

1.

8.3.2.2

Erfassung der komplexen Objekte (ArcMap)
Objekt erfassen

Um Objekte zu erfassen, muss die Edit-Session gedffnet sein Editor > Start
Editing.

Das komplexe Objekt (in unserem Beispiel SBB-Strecke) als Target
auswahlen.

Anhand einer Abfrage oder manuell mit dem Select Features-Werkzeug der
Toolbar Tools die einzelnen Abschnitte selektieren, die zusammen ein
komplexes Objekt, d.h. eine SBB-Strecke bilden.

Das komplexe Objekt (die SBB-Strecke) wird durch die Vereinigung (Union)
der selektierten Abschnitte gebildet: Editor > Union. So entsteht ein neues
Objekt in der Tabelle, welche unter Target ausgewahlt ist.

Uber Editor > Save Editing den neuen Eintrag speichern.

Beziehung zwischen einfachen und komplexen Objekten erfassen

Im Kapitel 7.4 haben wir gesehen, wie man Beziehungen zwischen zwei
Feature Classes definiert. Um diese Beziehung zu erfassen, missen die
einzelnen Objekte aus beiden Feature Classes selektiert sein, welche
miteinander verknipft werden sollen (d.h. die SBB-Strecke und die
dazugehorigen Abschnitte).

Dazu selektiert man zuerst das gewilinschte komplexe Objekt. Anschliessend
moéchte man alle Objekte selektieren, aus welchen dieses komplexe Objekt
gebildet wurde. Dies macht man am Einfachsten mit Hilfe folgender
topologischen Abfrage (Selection - select by location):

select features from Abschnitte that share a line segment with SBB-Strecke.
Wichtig: Damit nur die Abschnitte selektiert werden, welche zur selektierten
SBB-Strecke gehdren, muss Use selected features ausgewahlt werden.

Man selektiert also alle Objekte aus dem Layer Abschnitte, welche aus den
gleichen Linienstiicken bestehen wie die selektierte SBB-Strecke.

Wenn man nun die Tabelle Abschnitte 6ffnet, sieht man, dass die zur SBB-
Strecke gehérenden Abschnitte selektiert sind.

Unter Attributes @ in der Editor-Toolbar kdnnen nun die beiden Feature
Classes und ihre Beziehungen untereinander angeschaut werden. In diesem
Fenster werden auch die Rollennamen sichtbar, welche man bei der Erstellung
der Beziehung erteilt hat (Kapitel 7.4, Schritt 4). Man sieht, dass die beiden

Feature Classes noch nicht voneinander abhangig sind. Diese Abhangigkeit
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erstellt man mit Rechtsmausklick auf den Rollennamen der komplexen
Feature Class - Add Selected.

e

[=- SBB_Strecke + | Property | Value
- Strecke B | OBJECTI

& [r—

Add Selected kngth
Add New

AL —

Remove All

Y

- -

- 387
338
= Abschnitt
=339
[=)- gehort zu
Strecke A
Strecke B

340

-

7 features

So werden die selektierten Objekte der Feature Class Abschnitte tUber eine
Beziehungs-Zwischentabelle mit dem entsprechenden Objekt der Feature
Class SBB-Strecke und umgekehrt verknupft. Diese Zwischentabelle wurde
durch ArcGIS automatisch bei der Erstellung der Beziehung (Kapitel 7.4,
Schritt 7). Sie kann entweder in ArcMap geladen und als Tabelle angeschaut

oder in ArcCatalog in der Preview-Ansicht betrachtet werden.

8.4 Topologie priifen

Nach der manuellen Digitalisierung von Objekten kann Uberpruft werden, ob die
verschiedenen Topologieregeln eingehalten werden (Topologieregeln erstellen siehe
Kapitel 7.5.1). Dabei muss die Edit-Session geotffnet sein: Editor — Start Editing
(siehe Kapitel 8.2.1).

1. Unter View - Toolbars die Topology-Toolbar 6ffnen:

Map Topology  Show Shared Features  Fix Topology Error Tool

Topology
Topology: ‘Bodenbedeckung_Topohj % a‘b

Topology to edit Construction features Validation Error Inspector
2. In der Topology-Toolbar die zu prufende Topologie auswahlen

3. Mit den Validation-Tasten lassen sich die topologischen Regeln validieren.
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Specific areas Entire topology

Current extent
4. Suche nach Fehlern und Ausnahmen: Button Search Now @ im Error

Inspector ® anklicken. Es 0Offnet sich eine Liste mit allen topologischen

Fehlern:

Show: | <Errors from all rules> | sermors E}
(2) sexchtion | W Erors ™ Exceptions ¥ Visbie Extent only
Rule Type Class 1 | Class 2 | Shape | Feature 1 ] Feature 2 ] Exception o
Must Be Properly Inside Huetten Gebaeude Point n False A
Must Be Properly Inside Huetten Gebaeude Point Zoom Te 3
Must Be Properly Inside Huetten Gebaeude Point PanTo
Must Be Properly Inside Huetten Gebaeude Peoint 3
Must Be Properly Inside ~ Huetten Gebaeude Point 2 Select Features
P:'::#annlv Inside  Huetten _G.E'.'!B_?_l_l.di’ - _gmr.l.f L Show Rule Description... ;
— Delete
Mark as Exception
Mark a5 Error

5. Durch klicken auf einen der gefunden Fehler in der Fehlerliste wird das
dazugehorige Objekt auf der Karte angezeigt.

6. Mit einem Rechtmausklick auf einen Fehler & werden die
Fehlerbehebungsmethoden angezeigt. Die geeinigte Methode auswéahlen.

7. Wenn der Fehler nicht korrigiert werden soll, kann er als Ausnahme markiert

werden (Mark as Exception).

@arc .
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9 Datenanalyse

9.1

Vektor GIS Analysen - Allgemeines

Bei der Datenanalyse sind zwei Methoden zu unterscheiden. Methoden, die keine

neuen Daten erzeugen und die vorhandenen auch nicht verdndern, werden als

Abfrage (Query) bezeichnet. Werden neue Daten hergeleitet oder die Originale

verandert, so spricht man von Manipulation.

GEODATEN

in digitalisierter Form vorliegend
Raster- oder Vektorformat

INPUT (1 - n)
DIREKTE ABFRAGE MANIPULATION
Daten bleiben Daten werden
unverandert verandert
Shape ID | Baumart Vorratm3/ha Shape ID | Baumart Vorrat m3/ha
pogon_| 4 | s che oo - e :
Untermenge der Gesamtmenge der Daten in Neue geographische
der Datenbankt wird extrahiert Informationselemente werden erzeugt

INFORMATIONSAUSGABE

9-1
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9.2 Direkte Abfragen

Die Unterteilung der Geoinformation in Geometrie, Topologie und Thematik

charakterisiert die Abfrageformen, wie dargestellt in der folgenden Abbildung.
GEODATEN

in digitalisierter Form vorliegend
Raster- oder Vektorformat

INPUT (1 - n)

DIREKTE ABFRAGE

Daten bleiben

unverandert
I I 1
Geometrische Topologische Thematische
Selektion Selektion Selektion

Geometrische Topologische Thematische
Information Information Information

N2

9.2.1 Thematische Selektion

Man unterscheidet zwei Arten von thematischen Abfragen:
¢ Einfache Abfrage, wo Selektionen unter Verwendung von nur einem Attribut

formuliert werden.
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Parzelle mit
Eigentimer = ,Muller*
e Verschachtelte Abfrage, wo Selektionen unter Verwendung von mehreren
Attributen formuliert werden.
Parzelle mit
Eigentimer = ,Miller“ und Bodennutzung = ,\Wiese*
Fur solche Abfragen werden LOGISCHE OPERATOREN verwendet, die logische
Ausdrucke (mit zwei moglichen Werten ,wahr* oder ,falsch*) verbinden. Solche
Operatoren sind AND, OR, XOR, NOT.

Legende:

Falsch

AND-Operator: ,Welche Parzellen haben Larche als Baumart UND einen Vorrat

grosser als 110m®/ha? «

4

Shape ID Baumart Vorrat m3/ha

Polygon 1 Fichte 250
Polygon 2 Tanne 250
Polygon 3 Kabhlschlag 0
Polygon 4 Larche 120
Polygon 5 Buche 300
Polygon 6 Fichte 130 1AND 2
Polygon 7 Larche 100

OR-Operator: ,Welche Parzellen haben Larche als Baumart ODER einen Vorrat

grosser als 110m®/ha? «
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Shape ID Baumart Vorrat m®/ha

Polygon 1 Fichte 250

Polygon 2 Tanne 250

Polygon 3 Kahischlag 0

Polygon 4 Larche 120

Polygon 5 Buche 300

Polygon 6 Fichte 130 10R2
Polygon 7 Larche 100

XOR-Operator: ,Welche Parzellen haben ENTWEDER Léarche als Baumart ODER

einen Vorrat grosser als 110m3/ha? “

Shape ID Baumart Vorrat m®*/ha
Polygon 1 Fichte 250
Polygon 2 Tanne 250
1 Polygon 3 Kahlischlag 0
5 Polygon 4 Larche 120
Polygon 5 Buche 300

2 Polygon 6 Fichte 130 1XOR 2

6 7 Polygon 7 Larche 100

NOT-Operator: ,Welche Parzellen haben Larche als Baumart, ABER KEINEN Vorrat

grosser als 110m3/ha? “

Shape ID Baumart Vorrat m®/ha

Polygon 1 Fichte 250
Polygon 2 Tanne 250
Polygon 3 Kahlischlag 0
Polygon 4 Larche 120
Polygon 5 Buche 300
Polygon 6 Fichte 130 1 NOT 2
Polygon 7 Larche 100

9.2.1.1 Thematische Selektion in ArcGIS

Selektionen kdnnen manuell durch Anklicken der entsprechenden Objekte oder der
Reihen in der Tabelle erzeugt werden oder sie entstehen als Resultat einer
Datenbankabfrage. Thematische Abfragen werden mit Hilfe des Tools Selection >
Select by Attributes durchgefuihrt.

In der folgenden Dialogmaske werden Bedingungen fur die Attributwerte von
Datenséatzen formuliert. Dabei kann unter Method gewé&hlt werden, ob eine neue

Selektion durchgefiihrt, die Daten zu einer Selektion hinzugefiugt oder entfernt oder
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nur aus einer bestehenden Selektion ausgewahlt werden soll. Die entsprechenden

Objekte werden immer graphisch in der Karte und in der Attributtabelle markiert.

[ Select By Attributes (2] = |
laye: [ Fluesse =
I~ Only show selectable layers in this list
Method:  |Create a new selection |
"OBJECTID" a
i
"SHAPE_Length”
= | o ke | [Atenbach -
‘Ammertenbach’ 3
> I >=| Andl ‘Bummerebach’ |"
ol
< [[<=|[or | [uebicn
_[%] _0 | Mot | | Fschweng Bach -
LI Get Unique Values |GoTo: I
SELECT * FROM Fluesse WHERE:

“Name" = Alenbach’ OR "Name" = Engstigen’

’
[{] Attributes of Fluesse

OBJECTID* SHAPE Name Breite Klasse | SHAPE_Length -
» 1 | Polyline | Engstiigen 8 7 701.026813 E
2 | Polyine | Chuebachii 10 10 1239.669962 ﬂ

3 [Polyine | Engstigen 8 7 1082.678235

4 [Polylne | Stebach 9 9 577.131411

5 | Polyline | Stigelbach 10 1 1886.842342

6 | Polyline | Allenbach 9 8 1760.10197

7 | Polyline | Alienbach 9 8 1241.291478

8 | Polylne | Allenbach 8 8 1983.89226
9 | Polyine | Allenbach 9 8 1212.249193 =
Record: 14 « | 1 »|m|  shows[ Al Selected |  Records (9 outof 32 Selected) Options ~

9-5
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9.2.2 Topologische Selektion

Topologische Selektionen werden in der folgenden Art ausgedrickt: ,Selektiere alle
Gebaude die weniger als 200m von den selektierten Flissen entfernt liegen, oder
~Selektiere alle Geb&ude die innerhalb einer bestimmten Flache liegen“. Die
Beziehungen zwischen Flachenobjekten und anderen geometrischen Objekten dienen

oft als Analysekriterien.

9.2.2.1 Topologische Selektion in ArcGIS

Topologische Abfragen werden mit Hilfe des Tools Selection &> Select by Location...
durchgefihrt.
In der folgenden Maske kann man schon vorbereitete Bedingungen fur die

topologische Selektion benutzen.

' ™
Select By Location ? P4

Lets you select features from one or more layers based on where they are
located in relation to the features in another layer.

I want to:
Iselect features from LI
the following layer(s):

O Huetten

[ Bergspitze

O wanderwegabschnitte

O Bergbahnen

[ verkehrsweg

O Fluesse

¥ Gebaeude

O Bodenbedeckungsfiaechen

[ Only show selectable layers in this list

that:
Imtersect j
the features in this layer:
I@ Fluesse LI
I us - (0 features selected)
¥ Apply abuffer to the features in Fluesse
of: [so | Meters ~|
Hep | ok | sy | Close
L o

Mdogliche Abfragekriterien sind:
e Intersect - Verschneiden
e Are within a distance of — Befinden sich innerhalb einer gewissen Entfernung
e Completely contain — volilstandig enthalten
¢ Are completely within — vollstédndig innerhalb

¢ Have their centroid within — haben den Schwerpunkt innerhalb
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9. Datenanalyse

Share a line segment with — teilen Liniensegmente mit

Touch the boundary of — bertihren die Grenze von

Are identical to — sind identisch zu

Are crossed by the outline of — werden gekreuzt von den Aussenlinien von

Contain - enthalten

Are contained by — werden enthalten von

Die entsprechenden Objekte werden graphisch und in der Attributtabelle markiert.

.

i ) a g, g ¥
\ o908 s
] Re o {
\ l o Jo8
\ o o e *
G ad <SG __/_ =)
- il N vy * ”aéosolén e N ]
a A L L \
;r o / ° D %n o !
/ ° & o (@ \
P ) Q}lf) 2 "?} \
’ g [ \
1] / o a u( o ~. @
y Y
Attributes of Gebaeude [ESRIE
OBJECTID * SHAPE * Art Nummer| SHAPE_Length | SHAPE_Area -
9 | Polygon Z_Gebaeude| 4371236 360.56179 8108.64
10 | Polygon Z_Gebaeude| 4371240 319.963437 6393.97
11 | Polygon | Z_Gebaeude| 4271266 384.78281 9160.405
12 | Polygon | Z_Gebaeude| 4271283 379.261036 8863.42
| 13 | Polygon | Z_Gebaeude| 4371305 368.11694 8416
14 | Polygon | Z_Gebaeude| 4371310 399734218 9873.01
15 | Polygon Z_Gebaeude| 4371323 395.642337 9651.09
16 | Polygon Z_Gebaeude| 4371337 384.784669 9146.97
17 | Polygon Z_Gebaeude| 4371339 392.796296 9576.69 =
Record: 14 «|| 1 v Show: [ Al Selected | Records (20 out of 123 Selected) Options  ~
9.2.3 Geometrische Selektion

Die Suchkriterien fur geometrische Selektionen kdnnen die folgenden sein:

9.3

Objekte in einem Koordinatenfenster

Flachen von Flachenobjekten

Langen von linienférmigen Objekten

zusatzliche Funktionen wie Buffering (Puffer und Umgebungsflache: siehe
Kapitel 9.3.4)

Manipulationen

Manipulationen haben die Eigenschaft, aus bestehenden Geometrien volistandig neue

Geodaten zu erzeugen.

9-7
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9. Datenanalyse

9.3.1 Allgemeines zu den Analysewerkzeugen (Analysis Tools)

In der ArcToolbox @ stehen unter Analysis Tools einige Analysewerkzeuge zur
Verfiigung. Die verschiedenen Werkzeuge sind in vier Gruppen unterteilt:

e Extract (Ausschnitt)

e Overlay (Uberlagerung)

e Proximity (Umgebung)

e Statistics (Statistik)

£8 ArcToolbox
@ 3D Analyst Tools
= % Analysis Tools

# & Extract

% & Overlay
#-& Proximity
& % Statistics

Im Folgenden wird auf einige haufig verwendete Analysewerkzeuge etwas naher

eingegangen.

9.3.2 Extract (Ausschnitt):

Unter Extract (Ausschnitt) sind folgende Funktionen zu finden:
e Clip (siehe Kapitel 9.3.2.1)
e Select
e Split
e Table Select

9.3.2.1 Clip

Bei der Clip-Funktion dient ein Feature als Maske. Es wird eine neue Feature Class
erzeugt, welche die Teile des Input-Features enthélt, die sich mit dem Clip Feature
decken.

Der Unterschied zwischen dem Clip- und dem Intersect-Werkzeug ist, dass beim

Clip-Werkzeug die Attribute des Clip Features nicht weitergegeben werden.

INPUT CLIP FEATURE OuUTPUT

ArcToolbox - Extract - Clip
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9.3.3  Overlay (Uberlagerung)

Unter Overlay (Uberlagerung) sind folgende Funktionen zu finden:
e Erase (siehe Kapitel 9.3.3.1)
o Identity (siehe Kapitel 9.3.3.2)
e Intersect (siehe Kapitel 9.3.3.3)
e Spatial Join
e Symmetrical Difference
e Union (siehe Kapitel 9.3.3.4)
e Update (siehe Kapitel 0)

9.3.3.1 Erase

Erase erzeugt eine neue Feature Class indem zwei Feature Classes Ubereinander
gelegt werden. Die Flache des Erase-Features definiert die Geometrie der Flache, die
aus dem Input-Feature geléscht wird.

Input-Features kdnnen Punkte, Linien oder Flachen sein. Das Erase-Feature muss
eine Flache sein. Die Output-Feature Class ist immer vom gleichen Geometrietyp wie

die Input-Feature Class.

INPUT OUTPUT
ERASE FEATURE \ /

- 2 ot

[N e, N

ArcToolbox - Analysis Tools - Overlay 2> Erase

9.3.3.2 Identity

Identity erzeugt eine geometrische Verschneidung vom Input- und vom ldentity-
Feature. Der Teil des Input-Features, der mit dem ldentity-Feature Giberlappt, erhélt

zuséatzlich alle Attribute des Identity-Features.
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INPUT OUTPUT

IDENTITY
FEATURE

ArcToolbox - Analysis Tools > Overlay > ldentity

9.3.3.3 Intersect

Intersect erzeugt eine geometrische Verschneidung von verschiedenen Features. Es
werden die Attribute von allen Features im Uberlappenden Teil in die Output-Feature

Class geschrieben.

INPUT

OUTPUT

A\ 4

INTERSECT
FEATURE

ArcToolbox - Analysis Tools - Overlay - Intersect
9.3.3.4  Union

Union erzeugt eine geometrische Verschneidung von verschiedenen Features. Es

werden alle Features mit allen Attributen in die Output-Feature Class geschrieben.

INPUT OUTPUT

ArcToolbox = Analysis Tools > Overlay = Union
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9. Datenanalyse

Update

Update erzeugt eine geometrische Verschneidung des Input- und des Update-
Features. Die Attribute und die Geometrie des Input-Features werden durch das
Update-Feature aktualisiert. Das Resultat vom Update wird in die Output-Feature

Class geschrieben.

INPUT OUTPUT

\
] -
O

UPDATE
FEATURE

ArcToolbox - Analysis Tools - Overlay > Update

9.3.4  Proximity (Umgebung)

Unter Proximity (Umgebung ) sind folgende Funktionen zu finden:
e Buffer (siehe Kapitel 9.3.4.1)
e Create Thiessen Polygons
¢ Multiple Ring Buffer (siehe Kapitel 9.3.4.2)
e Near

e Point Distance

9.3.4.1 Buffer

Buffer erzeugt eine Pufferflache mit einem vorgegebenen Abstand um das Input-
Feature herum.
Beispiele:
Man kann zwei Buffermdglichkeiten unterscheiden:

¢ Einfacher Buffer - eine einheitliche Distanz (Linear Unit) fur alle Elemente

o Buffer mit Attributwerten - Die Distanz des Buffers ist bei jedem Element

abhangig vom Wert, der beim gewéhlten Attribut (Field) angegeben ist.

In der Dialogmaske kann man auch verschiedene weitere Optionen definieren: Buffer
auf beiden Seite des Objektes oder nur auf einer (Side Type), runde oder flache
Grenzen (End Type), Ergebnisse mit oder ohne Vereinigung der Flache (Dissolve
Type).
ArcToolbox = Analysis Tools = Proximity - Buffer
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9.3.4.2  Multiple Ring Buffer

Mit dem Tool Multiple Ring Buffer kann man mehrere Bufferringe um Objekte
machen. Unter Distances koénnen die gewlnschten Abstdnde der Bufferringe
angegeben werden.

ArcToolbox - Analysis Tools - Proximity - Multiple Ring Buffer
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10. Arbeiten mit Rasterdaten

10 Arbeiten mit Rasterdaten

10.1 Georeferenzierung von Rasterdaten

Die Aufgabe der Georeferenzierung ist es, einem Datensatz, welcher noch keine
Realweltkoordinaten hat, einen raumlichen Bezug zuzuweisen, d.h. ihn in ein
geodatisches Referenzsystem einzupassen. Dies geschieht mit Hilfe wvon
Referenzpunkten (Passpunkten), deren Lagen bekannt sind sowie einer
mathematischen Funktion. Die verwendete Funktion hangt von der Anzahl der
verwendeten Referenzpunkte ab.
Es gibt zwei Mdglichkeiten eine Rasterdatei zu georeferenzieren:
e Visuelle* Georeferenzierung, wenn bereits andere georeferenzierte Daten von
einem Gebiet vorhanden sind
e wenn die Koordinaten von einigen Punkten bekannt sind, kann eine
Rasterdatei durch die Auswahl dieser Punkte wund Eingabe der
Koordinatenwerte georeferenziert werden
Um ein Bild in ArcMap zu georeferenzieren, muss zuerst die zu georeferenzierende
Datei geladen werden (siehe Kapitel 4.5).
Ausserdem benétigt man die Toolbar Georeferencing (Rechtmausklick auf die Menu-
Leiste > Georeferencing oder im Hauptmenu View -> Toolbars - Georeferencing).
Uberzeugen Sie sich, dass das zu referenzierende Raster in der Georeferencing-
Toolbar unter Layer aktiv ist:

Rotate / Shift/ View Link Table
Scale |

Georeferencing

Lgeore{erencing . |Rasterjpg 4 _'/“ = |
Uedate Georeferencing =
Rectify... Add Control Points
Flip or Rotate 4
Transformation [

I Auto Adjust

I Update Display

Delete Control Points

Reset Transformation
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10. Arbeiten mit Rasterdaten

Um zu vermeiden, dass nach jedem neuen Punkt die Transformation gerechnet wird,
kann die Option Auto Adjust ausgeschaltet werden. Dies geschieht entweder via
Georeferencing > Auto Adjust oder im Link Table Fenster (6ffen mit Button View

Link Table) durch entfernen des Hakchens unter Auto Adjust.

10.1.1 ,, Visuelle” Georeferenzierung

Wahlen Sie fir die Georeferenzierung solche Punkte aus, die auf dem bereits
georeferenzierten Bild oder den georeferenzierten Vektordaten und dem zu
georeferenzierenden Bild einfach zu identifizieren sind (z.B. Koordinatenkreuze,

Strassenkreuzungen,...).

Waéhlen Sie das Icon Add Control Points Py aus der Georeferencing Toolbar aus und
klicken Sie auf den gewiunschten Punkt auf dem zu referenzierenden Bild: ein grines
Kreuz erscheint.

Falls die Position des grinen Kreuzes nicht richtig ist, kdnnen Sie das Kreuz mit der

Taste ESC wieder I6schen.
Anschliessend muss mit Hilfe der Option Zoom To Layer und den Bewegungstools W,
@- Q der entsprechende georeferenzierte Punkt gesucht und mit dem Werkzeug

Add Control Points v angeklickt werden: ein rotes Kreuz erscheint. Zwischen den
beiden abgesetzten Kreuzen erscheint ein Verschiebungsvektor.

Setzen Sie so einige Punkte. Diese sollten méglichst gleichmassig auf der Karte, die
Sie georeferenzieren wollen, verteilt sein.

Die abgesetzen Punkte kénnen mit View Link Table & angezeigt werden.

Sie konnen einen fehlerhaften Punkt mit dem Kreuz cben rechts im Link Table

Fenster l6schen:
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X Source Y Source X Map Y Map Residual
173.088452 -386.291391 604738.049991  146127.803782 5.69003
697.674345 -833.323404 609988.337598  141650.862712 2.32619
748.174107 -42.777561 610488.765719 149562.772296 2.87097

4.941622 -834.353283 603068.627969  141645.277247 3.3469%6
394.502157 -178.966813 606949.417691  148203.550307 6.19136
510.229740 -196. 1649662 608124.862631  148035.571778 13.03294

« 1 ] »

W Auto Adjust Transformation: | 1st Order Polynomial (A v|  Total RMS Error: | 6.65110

Load... Save... |

Manchmal kann es vorteilhaft sein, die Punkteliste als Textfile zu Speichern: in der
Link Table > Save... So kann diese Liste zu einem spateren Zeitpunkt wieder
geladen werden (Load...) und die Punkte mussen nicht mehr neu erfasst werden.
Wenn Sie genugend Punkte zugeordnet haben (mindestens 3 fur eine affine
Transformation), kdnnen Sie die Option Update Display im Georeferencing Meni
wahlen, um das zu referenzierende Bild zu bewegen (dies ist nur notig bei
ausgeschalteter Auto Adjust Funktion). Das neu referenzierte Bild sollte mit den
bereits referenzierten Daten Ubereinstimmen. Falls das Resultat nicht zufrieden
stellend ist, Uberprifen Sie, ob ein Punkt einen grossen Residualwert hat. Wenn ja,
hat sich wahrscheinlich ein Fehler oder eine Ungenauigkeit eingeschlichen. Die
Verlinkung kann geldscht und die Georefernzierung nochmals gerechnet werden.

Der RMS Error (Root Mean Square Error) zeigt die mittlere Lagegenauigkeit relativ
zur Referenzvorlage, die mit Georeferenzierung erreicht werden kann.

Wenn die Georefernzierung zufrieden stellend ausgefuhrt wurde, muss sie noch

gespeichert werden (siehe Kapitel 10.1.4).

10.1.1.1 Georeferenzierung ohne Anderung des Massstabs

Wenn das zu referenziere Bild nur eine Drehung, eine Skalierung oder eine
Translation benétigt (und keine Anderung des Massstabs), kann es auch mit den

Werkzeugen Rotate, Scale und Shift referenziert werden:
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10.1.2  Georeferenzierung durch EFingabe von Koordinaten

Klicken Sie mit dem Tool Add Control Points D auf den koordinatenmaéssig
bekannten Punkt, dann klicken Sie mit der rechten Maustaste ins Bild, wahlen Input

X and Y und fugen die entsprechenden Koordinaten hinzu.

InputX and' ...

Cancel Point

Wenn alle gewlinschten Punkte eingefligt sind, kann mit der Option Update Display
im MenU Georeferencing die Georeferenzierung ausgefuhrt und kontrolliert werden.
Wenn die Georefernzierung zufrieden stellend ausgefuhrt wurde, muss sie noch

gespeichert werden (siehe Kapitel 10.1.4).

10.1.3  Fine Georeferenzierung kontrollieren

Um die Georeferenzierung visuell zu kontrollieren, kann das obere Bild ein- und
ausgeblendet werden (Hakchen beim Layer setzen und entfernen)
-] £% Layers = £¢ Layers
+ Name gger = [0 Name
Eine andere Moglichkeit ist das obere Bild transparent darzustellen. Anleitung dazu
finden sie im Kapitel 4.8.5.3.

So kdnnen Sie kontrollieren, ob die beiden Bilder gut zusammenpassen.

10.1.4  Georeferenzierung speichern

Der Befehl Update Display fuhrt die Georeferenzierung aus, speichert sie aber nicht
ab.

Wenn die Georefernzierung zufrieden stellend ausgefuhrt wurde, muss sie noch
gespeichert werden: Sie kdnnen entweder eine World Datei produzieren mit
Georeferencing > Update Georeferencing oder neue Rasterdaten herstellen mit

Georeferencing > Rectify.
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10.2 Integer- und Floating-Point-Grid
10.2.1  Unterscheidung Integer- und Floating-Point-Grid

Bei Rasterdaten wird zwischen Integer- und Floating-Point-Grids unterschieden. Das
Grid vom Typ float besteht aus Gleitkommazahlen und wird fur kontinuierliche Daten
verwendet (z.B. DHM), wahrend das Integer-Grid aus Integer-Werten besteht und

kategorische/diskrete Daten reprasentiert (z.B. Bodenbedeckungsarten).

Floating-Point-Grid Integer-Grid

10.2.2  Value Attribute Table (VAT-Table) bei Integer-Grid

Jedes Integer-Grid hat eine Value Attribute Table (VAT) mit mindestens zwei
Elementen:

e VALUE: Wert der Zellen

e COUNT: Anzahl Zellen mit diesem Wert
Diese Tabelle ist nur bei Integer-Grids vorhanden, Grids mit Floating-Point Zahlen
haben also keine VAT.
Fur ein Bild ergibt sich eine Art Histogramm. Dabei kénnen zus&tzliche Attribute
hinzugefugt (z.B. ,,Soil“ und ,,Suit.”“ im Beispiel unten) oder mit der VAT assoziiert
werden.

Falls keine Information fur eine Zelle vorhanden ist bekommt sie den Wert NO DATA.

. Ceﬂiize Value Attribute Table (VAT)
%_ _ Value Count Soil Suit.

— . — 1 11 Water 0

o —_— 2 15 1d3 1

— 3 8 Sg 3

. — 4 6 1d2 1

Rows Columns—|—|—| — 5 8 Tn4 2

(0,0) X-axis
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10.3 Raumlichen Ausdehnung von Rasterdaten anpassen
10.3.1  Zusammenfiigen von Rasterdaten (Mosaic)
Bei einem Mosaic werden mehrere Raster in einem einzigen Rasterdatensatz

zusammengeflugt. Um ein Mosaic zu erstellen, 6ffnen Sie die ArcToolbox % Unter
Data Management Tools - Raster > Mosaic finden Sie das Werkzeug dazu. Zuerst
mussen die Raster angegeben werden, welche zusammengefigt werden sollen. Das
Target Raster muss ein schon existentes Raster Dataset sein. Dieses kann leer sein
oder auch schon Daten enthalten.

Die Funktion Mosaic eignet sich auch zum Zusammenfuhren von Rastern die
aneinandergrenzen und sich an den Randern uUberlappen. Man kann festlegen, dass
im Uberlappungsbereich nur die Werte eines oder der Mittelwert der angrenzenden
Layer genommen wird. Zudem eignet sich diese Funktion ebenfalls fir das

Zusammenfuhren von kontinuierlichen Daten wie z.B. digitale Hohenmodelle.

10.3.2 Zuschneiden von Rasterdaten

Gerade Rasterdaten decken oft einen grdsseren Ausschnitt ab, als wirklich fur die
Analysen noétig ist. Dabei wird unnétig Speicherplatz gebraucht. Um das zu

vermeiden, kann der gewiinschte Ausschnitt extrahiert werden.
10.3.2.1 Durch Angabe der rdaumlichen Ausdehnung

In der ArcToolbox @ unter Data Management Tools - Raster - Clip kann durch
Angabe eines Rechteckes ein Raster zugeschnitten werden.
10.3.2.2 Mit Hilfe einer Maske

Zuerst muss eine Maske mit der gewunschten Ausschnittgrosse erstellt werden. Als
Maske lasst sich dabei neben einem Raster auch eine Feature Class verwenden. Mit

folgendem Tool kann dann der gewuinschte Ausschnitt zugeschnitten werden: in der

ArcToolbox @ unter Spatial Analyst Tools - Extraction - Extract by Mask.

10.4 R&aumliche Rasteranalyse
10.4.1  Spatial Analyst Erweiterung

Fur Raster-Analysen bietet ArcGIS die Spatial Analyst Erweiterung an.
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A
Spatial Analyst ¥ |Lqm|dhm1125 P
~ Distance 3
Interpolate to Raster »
Surface Analysis »

Cell Statistics. ..

Neighborhood Statistics. ..
Zonal Statistics...

Raster Calculator...

Convert 3

e Erweiterung aktivieren: Tools - Extensions: MSpatial Analyst

e Toolbar einfiUgen: View > Toolbars > Y Spatial Analyst

10.4.2  Spatial Analyst Options

Bevor man eine Datenanalyse durchfuhrt, ist es empfehlenswert, einige
Vorbedingungen zu definieren. Klicken Sie auf Options... aus dem Spatial Analyst
Dropdown-Menu. In diesem Fenster kann man das Arbeitsverzeichnis, die
Analysemaske und die Auflésung der Ausgaben definieren.

Options 2] = |

General | Extent | Cel Size |

Working drectory: ~ |C:\Temp\

=
Analysis mask: [<None> ~ 3
Analysis Coordinate System

* Analysis output will be saved in the same coordinate
system as the input (or first raster input if there are
multiple inputs).

(" Analysis output will be saved in the same coordinate
system as the active data frame.

[v Display waming message if raster inputs have to be
projected during analysis operation.

OK Cancel

'Arc
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e Wenn die Analysen nur in einem bestimmten Gebiet durchgefihrt werden
sollen, kann unter Analysis Mask im Tab General dieses Gebiet als Maske
definiert werden.

e Analysis Extent im Tab Extent definiert einen rechteckigen Bereich, in
welchem die neuen Raster berechnet werden sollen. Die Ausdehnung eines
Layers sind die X/Y-Koordinaten fur die linke untere und die rechte obere
Ecke.

¢ Analysis Cell Size im Tab Cell Size definiert die Default-Grosse der Zellen des

Output-Rasters.

10.4.3  Reklassifizierung der Rasterdaten

Die Reklassifizierung ist eine Funktion, welche die Werte der Input-Zellen nimmt und
mit neuen Output-Zellen-Werten ersetzt. Diese Neueinteilung wird oft gebraucht um
die Interpretation von Rasterdaten zu vereinfachen indem man Wertebereiche
gruppiert und einem einzelnen Wert zuordnet. Z.B. ordnet man den Wert 1 allen
Zellen zu, welche Werte zwischen 1 und 50 haben, den Wert 2 allen Zellen die Werte
zwischen 51 und 100 haben, usw.

Es gibt zwei Mdglichkeiten Rasterdaten zu reklassifizieren. Die Erste berucksichtigt
nur die Legende und beeinflusst nicht die Datenstruktur und die Daten selbst. Die

Zweite erstellt im Gegenteil dazu ein neues Ergebnis.

10.4.3.1 Reklassifizierung OHNE Verdnderung der Daten

Rechtsmausklick auf das File - Properties... > Symbology - Classified
Hier kann man die Anzahl der Klassen wéhlen und die Beschriftungen jeder Klasse
bestimmen. Die Methode kann nur auf numerische Felder in der Tabelle angewendet

werden.
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Anzahl Klassen auswaéhlen

Layer Properties

General | Souce | Extent| Display Symbology | Fields | Joins & Relates |

Klassifizierung

Show:
joLic Values [Drmrastu- grouping values into classes \ Import... | sndern
| Classified _______| »
Stretched ~Fields '-‘sfkn&:n
Yalue: I'--‘nLI_IE v I :

I oo - 13716

B :716 - 17722 13716.00001 - 17722

B 17722 - 21711 82,0000

[ 21711 - 25985 21'711,00001 - 25'985 U

[ | 25'985 - 36'955 25'985,00001 - 36'955 Ees chriftung der
einzelnen Klassen

I~ Show class breaks using cell values Display NoData as ,| andern

I™ Use hilshade effect z i

re| ] [

Unter Classify... kdnnen die Klassifikationsmethode und die Wertebereiche verandert
werden. Mit Hilfe eines Histogramms kdnnen die Anzahl Klassen eingestellt werden.
Einen Uberblick Uber das verwendete Datenangebot kann man sich im Fenster
Classification Statistics verschaffen. Wenn Sie einen Teil der Features nicht mit in die
Darstellung aufnehmen wollen, kénnen Sie diese Uber den Button Exclusion...
ausschliessen. Unter Sampling... kann man die Grésse der Stichproben steuern,

welche zur Klassifikation herangezogen werden.
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Klassifikationsmethode und
Anzahl Klassen auswéahlen

Classificatin- _ﬂ!’l
BN
429
1604.693351
3®7W221.2
998 68089
2392980163
Wertebereiche
Cokmne: [100 = [~ ShowStd Dev. [~ Show Mean \, /festlegen
10008 -
38 2 2 i 7
8000-+
6000~
4000--
2000-+
0 T T T 1
429 7229249878 1016.849076 1'310.7748863 1'604.69995"

I~ Sneobreskstodatavalues Cancel I

10.4.3.2 Reklassifizierung MIT Verdnderung der Daten

Fur eine Reklassifizierung der Rasterdaten mit Veranderung der Daten:
Spatial Analyst > Reclassify... Hier kdénnen die alten Werte in Form von

Wertebereichen einem neuen Wert zugeordnet werden.

2]
Input raste [dhm1125 ~ =
Reclass field: [<Vabe) :I
Klassifizierung
~ Set values to reclassify 5 ndern
0ld values | New values @ Classity.. ]
423 . 600 2 ] r'|iq | I
600 - 800 3 .
800 - 1000 4 Add Entr
1000 - 1200 5 - —PI
g 0 - | _._|_' Delete Entries

™ Change missing values to NoD ata

=

Output raster: [<Temporary>

'Arc
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10.4.4 Local Functions (Cell Statistics, Raster Calculator)

Local functions berechnen ein Output Raster Dataset bei welchem der Output-Wert
jeder Zelle eine Funktion des Wertes/der Werte der Input-Zelle(n) eines oder mehrer
Raster ist, welche sich am gleichen Ort wie die Output-Zelle befinden. Dieser Wert ist
nicht von den Nachbarzellen beeinflusst.

Diese Funktionen kdnnen an einzelnen oder an mehreren Rasterdatensétzen
gleichzeitig angewendet werden.

Beispiele fur einzelne Eingabe: Trigonometrische Funktionen (z.B. Tangente,
Sinus).

Beispiele fur mehrere Eingaben: Die Berechnung des Mittelwertes oder der

Standardabweichung.

Input

Output

Diese Funktionen werden durchgefuhrt mit:
Statistik einer Zelle berechnen: Spatial Analyst - Cell Statistics...

Berechnungen durchfliihren: Spatial Analyst - Raster Calculator...

Im Raster Calculator Dialog-Fenster muss der ArcGIS-Syntax beachtet werden.
z.B. MERGE (<grid, ...., grid>).
Zu beachten ist, dass immer ein Ausgabename (Name fir <OUTPUT>) verlangt ist;
d.h.:
[<OUTPUT>] = MERGE (EINGABE1, EINGABE2, EINGABE3)

Berechnung mit Evaluate starten.

10.4.5 Focal Functions (Neighborhood Statistics)

Focal functions erstellt ein Output Raster Dataset in welchem der Output-Wert jeder

Zellenposition eine Funktion des Input-Wertes der Zelle an dieser Position und der

10-11 “GIS Anleitung ArcGIS FS11




10. Arbeiten mit Rasterdaten

Werte der Zellen in einer festgelegten Umgebung um diese Position herum ist. Der
Wert ist also von den Nachbarzellen beeinflusst.
Beispiele: Das Mittel, die Standardabweichung, die Summe oder der Wertebereich

innerhalb der direkten oder erweiterten Nachbarschaft.

Input

Output

Diese Funktionen werden durchgefuhrt mit:

Nachbarschaftsstatistik: Spatial Analyst > Neighborhood Statistics...

h(r,s)
Size of the FILTER-WINDOW
filter-window 4321001234

N=3 /

N
N
N

(]
O ~N W
\

\

\

]

Die Filter-Fenstergrosse kann verédndert werden. Die minimale Filter-Fenstergrosse
ist 3 x 3 Zellen.

10.4.6  Zonal functions (Zonal Statistics)

Zonal functions berechnet ein Output Raster Dataset bei dem die Output-Werte jeder
Zelle abhé&ngig sind vom Wert an dieser Position und der Beziehung, welche diese

Position mit einem kartographischen Bereich hat. Zonal functions sind &ahnlich wie

'Arc
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focal functions mit dem Unterschied, dass die Definition der Nachbarschaft der
Konfiguration der Bereiche oder Objekte eines anderen Input-Zonen Datasets

entspricht und nicht als Filter-Fenster definiert wird.

Input

Output

Diese Funktionen werden durchgefuhrt mit:

Statistik in einem Bereich berechnen: Spatial Analyst - Zonal Statistics...

10.4.7  Distance Mapping Funktionen

Die Distance Mapping Funktionen sind globale Funktionen. Sie fuhren Operationen
basierend auf der Eingabe des gesamten Rasters aus. Diese Funktionen berechnen
ein Output Raster Dataset, wo der Output-Wert jeder Lage potentiel eine Funktion

aller Zellen des Input-Rasters ist.

10.4.7.1 Straight Line Distance Funktion

Die Straight Line Distance-Funktion misst die direkte Liniendistanz von jeder Zelle
zum néachsten Bezugspunkt. Die Distanz wird von Zellenzentrum zu Zellenzentrum
gemessen. Das Resultat zeigt zu jedem Punkt den né&chstgelegenen Bezugspunkt
auf. Die Eingaben kdnnen Raster- oder Vektorfiles sein.

Funktion 6ffnen: Spatial Analyst - Distance - Straight Line...

'Arc
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10.4.7.2 Straight Line Allocation Funktion

Die Straight Line Allocation-Funktion ordnet jeder Zelle den Wert des
nachstgelegenen Bezugspunktes zu. Die Eingaben koénnen nur Rasterfiles mit
ganzzahligen Werten (keine Dezimalwerte) sein.

Funktion 6ffnen: Spatial Analyst - Distance - Allocation...

10.4.8 Density

Mit Hilfe der Density-Funktion kann angezeigt werden, wo Punkt- oder Linienobjekte
konzentriert sind.

Funktion o6ffnen: Spatial Analyst - Density...

Die Density-Funktion kann als Eingabe Vektor- oder Rasterdaten haben. Wenn kein
besonderes Attribut (Population Field) ausgewdahlt wird, berechnet die Funktion die
rdumliche Dichte der Eingabe. Wenn ein Attribut spezifiziert wird, berechnet die
Funktion die Dichte eines besonderen Wertes.

Es kann zwischen einer einfachen (Simple) und einer Kernel Density gewéhlt
werden. Bei der Simple Density werden Linien oder Punkte, die in die gesuchte
Distanz fallen (Search Radius), summiert und dann durch die Flachengrdsse der

gesuchten Distanz dividiert.

10.4.9  Formatskonvertierung

Mit diesen Werkzeugen kénnen Raster- in Vektordaten (Spatial Analyst > Convert >
Raster to Features...) und Vektor- in Rasterdaten (Spatial Analyst > Convert >
Features to Raster...) umgewandelt werden.

10.4.10 Die Héhenlinien berechnen (Contour)

Diese werden aus dem H6henmodell berechnet. Um das entsprechende Werkzeug zu
offnen klicken Sie: Spatial Analyst oder 3D Analyst &> Surface Analysis - Contour...
Das Intervall zwischen den Isolinien kann beliebig gewahlt werden.

10.4.11 Die Hangneigung berechnen (Slope)

Die Hangneigung kann in Grad oder in Prozent berechnet werden.

Spatial Analyst oder 3D Analyst > Surface Analysis - Slope

10.4.12 Die Exposition berechnen (Aspect)

Exposition berechnen: Spatial Analyst oder 3D Analyst > Surface Analysis > Aspect

Siehe zu diesem Thema auch Kapitel 10.5.3.3 Die Exposition berechnen (Aspect)
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10.4.13 Die Beleuchtung berechnen (Hillshade)

Beleuchtung des Modells berechnen: Spatial Analyst oder 3D Analyst - Surface
Analysis 2> Hillshade

Mehr zu diesem Thema auch im Kapitel 10.5.3.4 Die Beleuchtung berechnen
(Hillshade)

10.4.14 Die Sichtbarkeit berechnen (Line of Sight und Viewshed)

Es gibt zwei verschiedenen Operationen in ArcGIS die mit der Sichtbarkeit zu tun
haben, die Line of Sight und das Viewshed (Extension 3D Analyst):

Wird die Sichtbarkeit Uber Spatial Analyst - Surface Analysis > Viewshed berechnet
so wird ein Beobachtungspunkt bendtigt. Laden Sie dazu ein File mit einem
Beobachtungspunkt ins Projekt (Daten laden siehe Kapitel 4.5.1).

Falls nur Sichtbarkeitslinien gebraucht werden, kdonnen diese in der 3D Analyst-

Erweiterung mit dem Befehl Line of Sight eingefligt werden.

10.5 3D Rasteranalyse
10.5.1 3D Analyst Erweiterung

Fur 3D Analysen bietet ArcGIS die 3D Analyst Erweiterung an. Die dazugehorigen
Werkzeuge erlauben Oberflachendaten zu erzeugen, zu analysieren, zu modifizieren
und wirklichkeitsnah zu visualisieren. Man hat vielfaltige Madoglichkeiten zur

Erstellung, Bearbeitung und Analyse der 3D Daten.

[ 3D Analyst ¥ Layet:[‘%}dhm‘lwﬂ LI @’}0+&ég [ @

Create/Modify TIN ~ »
Interpolate to Raster

h

Surface Analysis »
Reclassify...

Convert >
Options...

e Erweiterung aktivieren: Tools = Extensions: ¥ 3D Analyst

e Toolbar einfiUgen: View > Toolbars > Y 3D Analyst

10.5.2 3D Analyst Options

Bevor man eine Datenanalyse durchfuhrt, ist es empfehlenswert einige
Vorbedingungen zu definieren. Klicken Sie auf Options.. aus dem 3D Analyst
Dropdown-Menu. In diesem Fenster kann man das Arbeitsverzeichnis, die

Analysemaske und die Auflésung der Ausgaben definieren.
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(a T ™
Options ? a| =

General |E>denl|CeIISize|

Working directory: |C:'\TemD\ EI
Analysis mask: I <None> LI E’
Analysis Coordinate System

¥ Analysis output will be saved in the same coordinate
system as the input (or first raster input if there are
multiple inputs).

" Analysis output will be saved in the same coordinate
system as the active data frame.

[V Display waming message ff raster inputs have to be
projected during analysis operation.

OK Cancel

~ -~

e Als Working directory den gewiinschten Ordner angeben

e Wenn die Analysen nur in einem bestimmten Gebiet durchgefihrt werden
sollen, kann unter Analysis Mask im Tab General das gewlnschte Gebiet als
Maske definiert werden.

e Analysis Extent im Tab Extent definiert einen rechteckigen Bereich, in
welchem die neuen Raster berechnet werden sollen.

e Analysis Cell Size im Tab Cell Size definiert die Default-Grosse der Zellen des

Output-Rasters.
10.5.3  Analysen von digitalen Gelindemodellen (Surface Analysis)
Weitere Informationen bezuglich der folgenden Analysen sind in der Webhelp von
ERSI zu finden (http://webhelp.esri.com/arcgisdesktop/9.2).
10.5.3.1 Die Héhenlinien berechnen (Contour)

3D Analyst > Surface Analysis > Contour

Der Befehl Contour interpoliert Hohenlinien aus dem Raster-HOhenmodell. Die
Aquidistanz und der Nullpunkt kénnen beliebig gewahlt werden. Das Ergebnis wird
als Shapefile gespeichert, welches in der Attributtabelle die zugehdrige ID und den

Isolinienwert enthalt.

10.5.3.2 Die Hangneigung berechnen (Slope)

3D Analyst > Surface Analysis > Slope
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Die Hangneigung wird auf Basis vom Raster-Ho6henmodell berechnet. Der Z-faktor

entspricht dem Uberhéhungsfaktor (1 = nicht Giberhéht).

Die Hangneigung an einer kontinuierlichen Oberflache ist die maximale Neigung in

Richtung des starksten Gefalles, d.h. in jeder Zelle wird der Unterschied zwischen

dem grossten und dem kleinsten Z-Wert ermittelt. Die Hangneigung kann in Grad

und in Prozent angegeben werden.

58
Degree of dope =9 Parcent of sloge = -

o rnse

Degree of sloge =

Percert of slope =

10.5.3.3 Die Exposition berechnen (Aspect)

3D Analyst » Surface Analysis - Aspect

Als Exposition wird die Ausrichtung der Zelle
bezeichnet. Die Gelandeexposition wird auf
der Basis des Raster-Hohenmodells berechnet.
Definiert ist die Exposition als Abweichung der
steilsten Gerade in der Zellebene von der
Nordrichtung. Das Output-GRID nimmt Werte
zwischen 0 und 360 Grad an. Die Messung der
Exposition erfolgt im Uhrzeigersinn, d.h. eine
Zelle mit Wert O ist gegen Norden, mit Wert
90 gegen Osten, mit Wert 180 gegen Siden

und mit Wert 270 gegen Westen exponiert.

10.5.3.4 Die Beleuchtung berechnen (Hillshade)

3D Analyst - Surface Analysis > Hillshade

und Altitude definiert.

Defaultwert von Azimuth ist 315 (NW).

Defaultwert von Altitude ist 45°.

EEEER |
- L

Mit dem Befehl Hillshade wird die hypothetische Beleuchtung
eines Reliefs dargestellt. Als Resultat erhalt man ein Grid mit
Werten zwischen O und 255, dargestellt in Graustufen von

schwarz bis weil3. Die Beleuchtungsquelle wird tGber Azimuth

10-17 ~GIS
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Beachten Sie, dass wenn der Winkel des Sonnenstandes
kleiner wird die Flachen welche im Schatten liegen

E zunehmen.

10.5.3.5 Curvature

ArcToolbox - 3D Analyst > Raster Surface - Curvature
Die Curvature berechnet die Neigung der Neigung (die
zweite Ableitung der Oberflache); daraus entstehen
konvexe und konkave Oberflachen. Konvexe
Oberflachen, wie Berggrate, sind exponierte Flachen.
Konkave Oberflachen, wie Rinnen, sind meist
Drainagensysteme.

Dieses Tool wird vor allem gebraucht fur die

Interpretation von Wasserabflussrichtungen und

Erosion.

10.5.3.6 Die Sichtbarkeit berechnen (Line of Sight und Viewshed)

Es gibt zwei verschiedenen Operationen in ArcGIS die mit der Sichtbarkeit zu tun
haben, die Line of Sight und das Viewshed.
Line of Sight:

Mit dem Befehl Line of sight 2 in der 3D Analyst Toolbar kann bestimmt werden, ob
der Beobachter von einem bestimmten Standpunkt bestimmte Flachen sieht oder
nicht.

Man muss eine Linie ziehen. Als Resultat erhalt man eine in rote und grine
Abschnitte unterteilte Linie. Die roten Teillinien kennzeichnen die hinter einer
Erhebung liegenden (unsichtbaren) Flachen, die grinen Linien sind vom Standpunkt
des Beobachters aus zu sehen.

Viewshed:

3D Analyst - Surface Analysis > Viewshed

Beim Viewshed handelt es sich um die Identifikation sichtbarer Zellen von einem
Punkt aus. Wird die Sichtbarkeit berechnet so wird ein Beobachtungspunkt bendétigt.
Laden Sie dazu ein File mit einem Beobachtungspunkt ins Projekt. Als Resultat erhalt
man ein Grid mit dem Wert 1 fur die sichtbaren Zellen und mit dem Wert O fur die

unsichtbaren Zellen.
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10.5.3.7 Surface Length

ArcToolbox - 3D Analyst - Functional Surface - Surface Lenght

l/]- '-l\\ Der Befehl Surface Length berechnet die effektive Distanz
= \ eines Features basierend auf einem Hohenmodell oder TIN.
 Z Fir eine  gewilnschte  Strecke ist somit diese

dreidimensionale Distanz grosser als die berechnete
/\ planimetrische Distanz.

=+ Sample Distance
10.5.3.8 Profil erstellen
Aus einem DHM koénnen an beliebigen Stellen Hohenprofile erzeugt werden. Mit

Interpolate Line = die Profillinie festlegen und mit Create Profil Graph = das Profil
zeichnen lassen. Diese beiden Buttons sind in der 3D Analyst Toolbar zu finden. Das
so entstandene Diagramm kann noch spezifisch beschriftet werde. Mit
Rechtsmausklick auf der Windows-Titelleiste Properties aufrufen und z.B. den

gewilnschten Titel eingeben.

Es kdnnen auch mittels ArcToolbox = 3D Analyst = Functional Surface - Interpolate

Shape die Ho6henwerte der gewilnschten Linien interpoliert werden (z.B.

Wanderwege) und von denen anschliessend ein Profil = erstellt werden.

10.6 Rasterdaten in eine Datenbank integrieren
10.6.1  Neues Raster Dataset in ArcCatalog erstellen

Ein Raster Dataset ist ein beliebiges gultiges Raster-Format, das in Bandern
organisiert ist. Mehrere Raster kdnnen mosaikartig in ein einziges kontinuierliches
Raster Dataset eingefligt werden.
Das Raster Dataset muss in einer Geodatabase erstellt werden: rechtsmausklick auf
die Geodatabase > New - Raster Dataset. Im Dialogfeld missen anschliessend die
Parameter definiert werden:

e In der Output Location die Geodatabase angeben

e Unter Coordinate system for the Raster das Koordinatensystem wéhlen
Anschliessend kénnen die Daten geladen werden: Rechtsmausklick auf das Raster

Dataset 2 load data.

10-19 “GIS Anleitung ArcGIS FS11



10. Arbeiten mit Rasterdaten

(In ArcMap wird der Vorteil die Daten in ein Raster Dataset integriert zu haben
sichtbar, indem man z.B. die einzelnen Hohenmodelle ladt und dann im Vergleich

dazu das Raster Dataset).

10.6.2  Neuer Raster Catalog in ArcCatalog erstellen

Bei einem Raster Catalog handelt es sich um eine Sammlung von Raster Datasets,
die in einem Tabellenformat angelegt sind. Ein Raster Catalog wird zumeist
verwendet, um Raster Datasets anzuzeigen, ohne dass diese mosaikartig in ein
grosses Raster Dataset eingefligt werden miussen.
Der Raster Catalog muss in einer Geodatabase erstellt werden: rechtsmausklick auf
die Geodatabase > New - Raster Catalog.
Im Dialogfeld die Parameter definieren:
e In der Output Location die Geodatabase angeben
o Definieren des Koordinatensystems der Schweiz
e Werden die Raster direkt in der Geodatabase verwaltet, so gibt man beim
Raster Management Type Managedan. Sollten die Daten aber nicht in der
Geodatabase gespeichert werden, so geben Sie Unmanaged an.
Anschliessend konnen die Daten geladen werden: Rechtsmausklick auf den Raster
Catalog - load data. Die einzelnen Raster kdnnen im Programm ArcCatalog mit der

Option Contents visualisiert werden.

10.6.2.1 Einen Raster Catalog in ArcMap laden

Ein Raster Catalog lasst sich wie ein Layer in ArcMap laden (Add Data). Im
Programm ArcMap kann man unter den Raster Properties den Darstellungsmassstab
wahlen (Properties > Display). Man muss beachten, dass ein Raster Catalog nur ein
Katalog ist. So ist es empfehlenswert nur die Polygone mit den eigenen

Beschriftungen (Properties - Label) anzuzeigen.
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11 Netzwerke

Um Analysen entlang von Linien durchfihren zu kénnen (kiirzeste Strecke,
schnellste Strecke etc.) muss zuerst ein Netzwerk erstellt werden. Dies geschieht im
Programm ArcCatalog. Die Analysen werden dann mit dem Programm ArcMap

durchgefihrt.

Es gibt zwei Arten von Netzwerken:
1. Versorgungsnetz (Utility Network)
e gerichtetes Netzwerk
e Fliessweg ist vorgegeben
e Fliessweg kann nicht durch das transportierte Objekt (z.B. Wasser,
Elektrizitat etc.), sondern nur durch aussenstehende Personen z.B.
durch Schliessen eines Schiebers verandert werden.

— In ArcGIS heisst dieses Netz: Geometric Network

2. Transportnetz (Transportation Network)
e ungerichtetes Netzwerk
e Material, Guter oder Personen, welche transportiert werden, kénnen Uber
die Richtung, die Geschwindigkeit und den Bestimmungsort frei
entscheiden.

— In ArcGIS heisst dieses Netz: Network Dataset

Im Folgenden werden wir nur auf den Aufbau eines Versorgungsnetzes eingehen.

Angaben zur Erstellung eines Transportnetzes finden sie in der ArcGIS Online Help.

11.1 Aufbau eines Versorgungsnetzes (ArcCatalog)

Das Erstellen eines Netzwerkes ist nur innehalb eines Feature Datasets moglich. Zum
Aufbau des Netzwerkes stehen dabei ausschliesslich die Feature Classes zur
Verfugung, die bereits im ausgewahlten Feature Dataset vorhanden sind.
1. Rechtsmausklick auf das gewiinschten Feature Dataset und ein neues
geometrisches Netzwerk erstellen: New - Geometric Network.
Es offnet sich ein Fenster, welches einen Uberblick tiber die Arbeitsschritte
zum Aufbau eines Netzwerks gibt.
2. Im zweiten Fenster stehen die unterschiedlichen Netzwerktypen zur Auswahl.

Waéahlen Sie Build a geometric network from existing features falls die Feature
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Classes, mit denen Sie ein Netzwerk aufbauen mochten, bereits vorhanden
sind. Sonst wahlen Sie Build an empty geometric network.
3. Im dritten Fenster werden der Namen des Netzwerks und die Feature Classes,

die zu dem Netzwerk gehoéren sollen, festgelegt:

=1 Build Geometric Network Wizard

Select your feature classes and network name
Select the feature classes you want to build your network from:
[] knoten

$Sen

Select All

Enter a name for your network:
ITransport_Net

Help

4. Im vierten Fenster kénnen Sie festlegen, welche lhrer Linien fir den Aufbau
sog. komplexer Kanten (complex edges) genutzt werden soll. Der Vorteil
einer komplexen Kante besteht darin, dass Ubergange (junctions) ohne
physische Teilung der Linie integriert werden kdénnen. Zudem kann eine
komplexe Kante zu mehreren unterschiedlichen Netzwerken gehdren.

5. Das funfte Fenster bietet lhnen die Maoglichkeit, Objekte aufeinander
einrasten (snap) zu lassen, bevor das Netzwerk aufgebaut wird. Dies ist zu
empfehlen, wenn lhre Geodatabase auf nichttopologischen Daten beruht
(zum Beispiel Shapefiles). Wenn die Endpunkte aneinander anschliessender
Linien nicht zueinander passen, werden Sie im Netzwerk nicht richtig
zusammengefuhrt.

6. Im sechsten Fenster kdnnen Sie Gewichtungen (weights) fur das Netzwerk
einrichten. Dabei sind zwei verschiedene Typen zu unterscheiden. Einer
bestimmt den Aufwand, der fir das Passieren eines Netzwerk-Abschnittes zu
leisten ist. Der andere, genannt bitgate, legt die verschiedenen Objekttypen,
die sich entlang oder durch ein gegebenes Netzwerkobjekt bewegen kdnnen,

fest:
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=1 Build Geometric Network Wizard E3 |

Do you want to assign weights to your network?

Weights are the 'cost' of traveling along an edge in a network. For example, in a
water utility network a weight can be the length of a pipe.

 No = Yes

Enter the names of your weights and their types:

Weight Name [ Type | Bitgate Size
LENGTH

Heb_| ok [T caen |

Do you want to assign weights to your network?

‘Weights are the 'cost' of traveling along an edge in a network. For example, in a
water utility network a weight can be the length of a pipe.

 No = Yes

Enter the names of your weights and their types:
Weight Name [ Type [ Bitgate Size

E{i=}

1| LENGTH

| [t [ || T ]

7. Im siebten Fenster definieren Sie die Verbindung der Gewichte zu den

Attributen:

'Arc
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=1 Build Geometric Network Wizard E3 |

Assign your weights to fields in your feature classes

Available network weights:

[LENGTH :: Double ~]
Assign the above weight to the fields you want in the following
feature classes:

| Associated field
strassen LENGTH

o _| o [T cows |

8. Das letzte Fenster fasst Ihre Einstellungen zusammen. Wenn Sie einen Fehler

bemerken, gehen Sie zum entsprechenden Fenster zuriick und beheben Sie
ihn.
9. Klicken Sie auf Finish, um Ihr Netzwerk aufzubauen. Dies kann einige Minuten

dauern.

11.2 Verbindungsregeln definieren

Die Kanten eines Netzwerks sind immer durch Knoten mit anderen Kanten
verbunden. Sie konnen im Programm ArcCatalog festlegen, welche Art von
Verbindungen zwischen welchen Komponenten erlaubt ist. Die Regeln fir die

Verbindungen werden gewohnlich zwischen Subtypes festgelegt.

11.2.1  Verbindungsregeln fir Kanten-Knoten

Um die Verbindungsregeln fir Kanten-Knoten-Ubergange festzulegen, klicken Sie mit
der rechten Maustaste auf das Geometric Network =1 und wahlen Sie dann

Properties:
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B O CityWater.mdb
=P Publicwater
{=7] Fittings
(%] MainLines
r puwvl-l._.. LIPS
é Publicy Copy Ctri+C
{&] service K Delete

] Tanks ename  F2
=] valves =

Geometric Network Properties K B3 I

General Connectivity | weights |
Connectivity rules for (feature class):
— Cardinality
@Fillings :I A
v Specify number of edges a junction can
Subtypes in this feature class: connect to
2 Y Descipt I I Min: Max:

Cap -6 2006 B g5 F —

Meter - 2" 3002

Tee-B"x6"x2" 1662

Teo-6"x6"x6" 1886 | Specify the number of junctions an edge can
connect to
Min: Max: @
o :I [2 :I

@ublwes in the Network: Junction subtypes:
@[  Fittings B[] Fittings
=  MainLines [0 Cap-8"
vl Mainline - 6" ] Meter-2"
=M Servicelines (0 Tee-6"x6"x2"
v Semwice line - 2" -] Tee-B"xB"xB"

#-[1 Tanks B[] Tanks

@[ Valves B[] Valves

-]  Publicwater_Net_Junctions @[] PublicWater_Net_Junctions
0K Cancel Aeply

Wahlen Sie den Connectivity-Tab aus.
1. Wahlen Sie unter © die Feature Class aus, fur welche die Verbindungsregeln

erstellt werden sollen.

11-5 “GIS Anleitung ArcGIS FS11



Fehler! Verweisquelle konnte nicht gefunden werden.. Fehler! Verweiscuelle konnte nicht
gefunden werden.

2. Unter @ werden die Subtypes der gewéhlten Feature Class aufgelistet. Klicken
Sie auf den gewinschten Feature Class-Subtype, flir welchen Sie die Regel
erstellen wollen.

3. Unter Subtypes in the Network ® kénnen durch Setzen eines Hakchens ¥
diejenigen Feature Classes ausgewahlt werden, welche mit dem unter @
gewahlten Subtype verbunden werden sollen. Durch Klicken auf * bei einer
Feature Class wird die Liste der Subtypes geotffnet. Die Subtypes einer
Feature Class konnen einzeln durch Setzen und Entfernen des Hakchens
verknupft oder entfernt werden. Durch Klicken auf einen Subtype kann dieser

aktiviert werden (nur so kénnen die Kardinalitat ® und ® eingeben werden):

Subtypes in the Network:
#-[3  Fittings
=™  MainLines
20 M air ine - 6"

4. Unter @ und ® konnen die Kardinalitaten gesetzt werden. Um zu
spezifizieren, wie viele der unter ® ausgewdahlten Komponenten mit den
unter @ ausgewahlten Komponenten verbunden werden kdnnen, aktivieren
Sie unter Cardinality ® die Box, die mit Specify the number of edges a
junction can connect to betitelt ist. Dort kdnnen dann unter Min: und Max:
die Kardinalitaten eingegeben werden (Achtung: Unter Max muss immer der
grossere Wert stehen als unter Min. Deshalb immer zuerst den Max-Wert
eingeben).

5. Wiederholen Sie die Schritte 3 und 4 um alle Regeln fur die ausgewéhlte
Feature Class festzulegen.

6. Wiederholen Sie die Schritte 1 bis 5 um die Regeln fur alle Knoten-Feature

Class des Netzwerkes festzulegen.

11.2.2  Verbindungsregeln fiir Kanten-Kanten

In diesem Schritt werden Sie nun die Regeln fur die Verbindung zweier Kanten durch
einen Knoten aufstellen. Kanten mussen durch einen Knoten miteinander verbunden

werden.Offnen Sie dazu wieder den Connectivity-Tab.
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Geometric Network Properties [ 2] X] |

General Connectivity I Weights |
Connectivity rules for (feature class):
@ MainLines
Subtypes in this feature class:
— Max:
2 ] Description - =
Main line - 6" i~ |
Max:
0 --—-I
=
@ubt}pes in the Network: Junction subtypes:
@[ Fittings Al | =M Fitings o
v MainLines (] Cap-8"
20 |1 2in line - 6 L] Meter-2"
=[]  Servicelines vl Tee-B"x6"x2"
Semwvice line - 2 V@ Tee-B"xE6"xE"
=M  Tanks #-[]  Tanks
W Water tank - 500,000 gallon +] Valves
=M Valves + Publicw ater_Net_Junctions
v Chutoaff wahea . B ;I
| 0K I Cancel Apply

Der Abschnitt ® wird nur aktiviert, wenn Sie die entsprechenden Kanten-Objekte in
beiden Bereichen @ und ® ausgewahlt haben, er wird speziell fir die Festlegung der
Kante-Kante-Regeln verwendet.

Sie werden also diesen Bereich fur die Auswahl des Typs der Knotenobjekte nutzen,
der die beiden Kanten miteinander verbindet. Wenn es mehrere Arten von Knoten
gibt, die fur eine Verbindung von zwei Kanten in Frage kdmen, markieren Sie alle,
setzen aber einen Typ durch einen Klick mit der rechten Maustaste als Voreinstellung
(Default):

Junction subtypes:
=  Fittings
(] Cap-8"
| Meter - 2"

Tee-6"xB"x2'

© Tee-B"xB6"xf

KD

<

[
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Bemerkung: Sie werden vielleicht einen Eintrag bemerkt haben, der Network-
Junctions heisst und sowohl in der Auflistung der beiden Feature Classes in ® als
auch der Subtypes in ® erscheint. Ein Kantenobjekt muss per Definition Knoten an
beiden Enden besitzen. Wenn Sie diese nicht erstellen, werden automatisch
generische Knoten eingesetzt. Typischerweise ist dies natirlich ein Fehler — Sie
haben z.B. vergessen, ein Endstick am Ende eines Rohres einzufiigen. Wenn Sie
aber einen generischen Knoten am Ende zulassen wollen, kdnnen Sie den Subtype

Network-Junction dafur nutzen.

11.3 Netzwerkanalysen (ArcMap)

Die Netzwerkanalysen werden im Programm ArcMap durchgefuhrt. Dazu missen
Sie die Toolbar Utility Network Analyst aktivieren:
Views > Toolbars - Utility Network Analyst

11.3.1  Allgemeines , Utility Network Analyst” Toolbar

Die Utility Network Analyst-Toolbar ist in zwei Teile aufgeteilt. Auf der linken Seite ©
kénnen das Netzwerk, mit welchem gearbeitet werden soll, und die Fliessrichtung
ausgewahlt werden. Auf der rechten Seite @ konnen die Optionen zur

Netzwerkanalyse eingestellt und die Analyse durchgefiuihrt werden:

Utility Network Analyst | x|
Metwork: ]rnem__Nelzwerk l] Flow * Qa,. Analpsis ¥ [ = TraceTask: IFind Path ;I ,{
~— = — r r —

Set Flow Direction L \
5 Solve
Add Junction Flag Add Edge Flag

Add Junction Barrier  Add Edge Barrier

11.3.2  Fliessrichtung bestimmen

11.3.2.1 Setzen von Sources und Sinks

Um eine Fliessrichtung festlegen zu kénnen, mussen zuerst Sources (Quellen) oder
Sinks (Senken) definiert werden. Dazu muss der Editor gestartet werden (siehe
Kapitel 8.2.1).
1. Rechtsmausklick auf den Knoten, welcher als Source oder Sink definert
werden soll > Open Attribute Table.
2. Das Attribut AncillaryRole von <Null> auf Sink oder Source (oder None)

wechseln.
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11.3.2.2  Fliessrichtung festlegen

Dann legen sie mit dem Set Flow Direction Q_“' Button in der Utility Network Analyst

Toolbar die Fliessrichtung fest.

11.3.2.3 Fliessrichtung anzeigen

Durch Klicken auf Flow - Display Arrows kann die Fliessrichtung angezeigt werden.

11.3.3  Analyseméglichkeiten: Pfadverfolgungsoperationen (Trace Task)

In der Utility Network Analyst Toolbar kann unter Trace Task aus folgenden
Pfadverfolgungsoperationen ausgewahlt werden:

o Alle Netzwerkelemente die stromaufwarts von einem gegebenen Punkt liegen
ermitteln (trace upstream).

o Alle Netzwerkelemente die stromabwarts von einem gegebenen Punkt liegen
ermitteln (trace downstream).

e Die Gesamtkosten aller ab einem bestimmten Punkt stromaufwéarts liegenden
Netzwerkelemente ermitteln (upstream accumulation).

e Ein Pfad stromaufwarts ausgehend von einem bestimmten Punkt im Netzwerk
ermitteln (find path upstream).

e Die gemeinsamen Features, welche stromaufwérts von mehreren
ausgewahlten Punkten im Netzwerk liegen ermitteln (find common
ancestors).

e Alle Features die mit einem gegebenen Punkt durch das Netzwerk verbunden
sind ermitteln (find connected).

e Alle Features die mit einem gegebenen Punkt durch das Netzwerk nicht
verbunden sind ermitteln (find disconnected).

e Wege von einem bestimmten Punkt aus ermitteln die wieder zu diesem Punkt
fahren (loops, Anfangspunkt = Zielpunkt) (find loops).

e Ein Weg zwischen zwei Punkten im Netzwerk. Der gefundene Weg kann einer
von mehreren mdoglichen Wegen zwischen den beiden Punkten sein, abhangig
davon ob das Netzwerk Schlaufen (loops) beinhaltet oder nicht (find path).

Dabei gibt es immer die Moglichkeit, das Resultat als Drawings oder Selection
anzuzeigen (siehe Kapitel 11.3.4).

Komplexe Kanten bestehen aus einzelnen Teilsticken. Damit bei einer Analyse nur
die einzelnen Teilstliicke und nicht jeweils die ganze Kante dargestellt oder selektiert
wird, muss unter den Analyseoptionen die Option Draw individual elements of

complex edges aktiviert werden (siehe Kapitel 11.3.4.1).
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11.3.3.1 Woeg finden

Es geht darum, einen mdéglichen Weg von einem Punkt zu einem anderen entlang
eines Netzwerkes zu finden.
Vorgehen:

1. Wahlen Sie in der Utility Network Analyst Toolbar unter Trace Task: Find Path

aus.

Klicken Sie auf Add Junction Flag e .

Platzieren Sie je ein Fahnchen auf den beiden Knotenpunkte, zwischen denen
Sie einen mdglichen Weg finden méchten.

4. Die Suche nach einem moéglichen Weg entlang des gewahlten Netzwerkes

kann mit Solve A ausgeldst werden.

5. Als Resultat wird einer von verschieden moéglichen Strecken angezeigt (um
eine Strecke anzuzeigen, welche gewisse Bedingungen erfullt: siehe Kapitel
11.3.3.3).

11.3.3.2 Einen Punkt im Netzwerk isolieren

1. In der Utility Network Analyst Toolbar ein Flag-Tool auswéhlen (Add Junction
I

Flag oder Add Edge Flag'r-) und in der Karte am zu isolierenden Punkt
absetzen.

2. Klicken Sie Analysis = Disable Layers und wéhlen Sie dort den/die Layer aus
welche gebraucht werden um den Punkt zu isolieren.

3. Unter Analysis = Options den Results Tab wahlen.

Unter Results format die gewilnschte Darstellungsart des Resultates
auswahlen (Drawings oder Selection, siehe Kapitel 11.3.4).

5. Unter Results content die Option Features stopping the trace auswéahlen und
Auswahl durch OK bestatigen.

6. Klicken Sie Selection - Set Selectable Layers in Hauptmeni und schauen Sie,
dass alle Layer, welche nicht fir die Isolation des Punktes im Netzwerk
verwendet werden, deaktiviert sind.

7. Wahlen Sie die gewinschte Pfadverfolgungsoperation (siehe Kapitel 11.3.3)

in der Trace Task Dropdownliste.

8. Dann klicken Sie auf den Solve A Button.
Die selektierten oder angezeigten Features koénnen verwendet werden um lhren

Punkt im Netzwerk zu isolieren.
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11.3.3.3 Bedingungen fiir gesuchten Weg definieren (weights)

Es soll ein Weg von einem Punkt zu einem anderen entlang eines Netzwerkes
gefunden werden, abhangig von einem Kriterium (z.B. kirzeste Strecke, schnellste
Strecke, usw.). Dieses Kriterium wird anhand von einem Gewicht (weight) in die
Analyse eingebracht.
1. Offnen Sie in der Utility Network Analyst Toolbar die Analysis Options:
Analysis - Options... 2> Weights.
2. Im Tab Weights kdnnen Sie wahlen, nach welchem Kriteriunn die angezeigte

Strecke ausgesucht werden soll.

Analysis Options K B3 I

General Weights lWeighl Fiter | Results |

i~ Junction weights
Weight for junction features:
I<None> ﬂ
i~ Edge weights
\Weight along digitized direction of edges (from-to weight}:
[LENGTH ~]

Weight against digitized direction of edges [to-from weight):
[LENGTH ~]

Cancel Apply

3. Anschliessend kann, wie im Kapitel 11.3.3.1 beschrieben, nach dem Weg

zwischen zwei Punkten gesucht werden.

11.3.3.4 Barriere platzieren

1. Um eine Barriere zu platzieren, klicken Sie auf Add Edge Barrier Tool M und
setzen Sie die Barriere am gewinschten Ort auf der Strecke zwischen zwei

Punkten ab.
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2. Anschliessend kann wie im Kapitel 11.3.3.1 beschrieben nach dem Weg
zwischen zwei Punkten gesucht werden. Als Resultat wird eine mdgliche

Umfahrung dargestelit.

11.3.3.5 Gewihlte Punkte und Resultate l6schen

Um die Eintrdge und die Resultate wieder zu l6schen wéhlen Sie im Menl Analysis 2>

Clear Flags, Clear Barriers und Clear Result.

11.3.4  Darstellungsart der Resultate auswédhlen

Es gibt zwei Optionen um ein Resultat darzustellen: Drawing (nur gezeichnet) oder

Selection (Elemente in der Datenbank selektiert).

11.3.4.1 Drawing

Das Resultat wird nur dargestellt, die Elemente werden dabei nicht selektiert.

1. Offnen Sie in der Utility Network Analyst Toolbar die Analysis Options:
Analysis - Options... > Results.

Unter Return results as die Option Drawings wahlen.

3. Bei der Option Drawings kann zusatzlich eingestellt werden, ob bei
komplexen Kanten die ganze Kante oder nur die betroffenen Teilstlicke
selektiert werden sollen (Draw individual elements of complex edges
aktivieren).

4. Ausserdem kann die Farbe ausgewahlt werden, in welcher das Resultat

dargestellt werden soll.

11.3.4.2 Selection

Um z.B. eine Statistik darstellen zu konnen (siehe Kapitel 11.4), muissen die
Resultate der Netzwerkanalysen nicht nur graphisch dargestellt sondern auch in der
Datenbank selektiert werden:

1. Offnen Sie in der Utility Network Analyst Toolbar die Analysis Options:

Analysis = Options... 2 Results.

2. Andern Sie die Einstellung von Drawings auf Selection.
Anschliessend kann wie im Kapitel 11.3.3.1 beschrieben nach dem Weg zwischen
zwei Punkten gesucht werden. Die Resultate sind dann nicht mehr nur dargestellt

sondern die Teilstrecken sind nun auch in der Datenbank selektiert.

11.4 Darstellung der Statistik

Um eine Statistik erstellen zu kénnen, muss zuerst nach einem Weg zwischen zwei

Punkten gesucht werden (siehe Kapitel 11.3.3.1) und das Resultat in der Datenbank
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selektiert werden (siehe Kapitel 11.3.4). Dann Kklicken Sie im Hauptmeni
Selection - Statistics und wéahlen den gewlnschten Layer und das Feld, von

welchem Sie die Statistik erstellen wollen.
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12 Das Programm ArcScene

ArcScene kD ist eine Erweiterung zu ArcCatalog und ArcMap und ermdglicht dem
Anwender eine effektivere Verwaltung von 3D Daten, die Durchfuhrung von 3D
Analysen, die Bearbeitung von 3D Features und die Erstellung von Layern mit 3D
Darstellungseigenschaften. In ArcScene kann man ausserdem realistische Szenen

erstellen und darin navigieren.

12.1 ArcScene starten

Das Programm ArcScene kann auf verschiedene Arten getffnet werden:

e Uber das Start Menlu - Programs > 08 GIS > ArcGIS > ArcScene R

e Direkt Uber den Button ArcScene in der 3D-Analyst-Toolbar im Programm
ArcMap
e Durch Offnen eines bestehenden ESRI ArcScene Dokuments (.sxd)
Pro gedffnete ArcScene-Session kann man aber immer nur an einer Karte arbeiten.
ArcScene schliesst die getffnete Karte bevor sie eine andere in der gleichen Session

offnet.

12.2 Aufbau

Das ArcScene-Dokument besteht ahnlich wie das ArcMap-Dokument neben den

Toolbars aus einem Karten- und einem Legendenteil (siehe Kapitel 4.2).

12.3 Projekt speichern
12.3.1  Kartendokumentseigenschaften setzen

Siehe Kapitel 4.3.1 ArcMap Dokumenteigenschaften setzen.

12.3.2  Speichern als ArcScene-Dokument .sxd

Unter dem Meni File > Save, Save As... oder Save a Copy... kann ein Projekt als
ArcScene-Dokument (.sxd) abgespeichert werden.

Es ist zu beachten, dass dieses abgespeicherte ArcScene-Dokument nur
Darstellungseinstellungen (Legende, Farben,...) beinhaltet. Es werden nicht die
Daten selbst, sondern nur die Pfade zu den verwendeten Daten abgespeichert.

Eine Anderung der Darstellung eines Layers wird also im ArcScene-Dokument
abgespeichert. Werden jedoch die Geometrie- oder Sachdaten eines Layers

verédndert, so wird diese Veranderung direkt im Datenfile gespeichert.
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12.3.2.1 Fiir alte Versionen von ArcGIS speichern

Mit ArcGIS 9.2 erzeugte oder gespeicherte Dokumente kénnen nicht direkt mit
einer zuruckliegenden Version gelesen oder verwendet werden.
Unter dem Menu File > Save A Copy... kann ein Projekt unter einem alten Format

von ArcGIS gespeichert werden.

12.4 Datensitze laden

Siehe Kapitel 4.5.

12.5 Hohenwerte fiir Layer definieren

Es gibt zwei Mdglichkeiten um einem 2D-Feature eine Basishohe zuzuordnen:

¢ Verwenden eines Attributes oder konstanten Wertes

e Features auf ein Oberflachenmodell (z.B. DHM oder TIN) legen
Punkte, Linien und Flachen koénnen zusatzlich noch extrudiert werden. Unter
Extrudierung versteht man Dimensionserhéhung einer zweidimensionalen Form
durch Parallelverschiebung im Raum. So erhalt man durch Extrudierung folgende
Geometrien: Aus einem Punkt wird eine Linie, aus einer Linie eine vertikale Flache
und aus einer Flache ein 3D-Koérper.
Diese beiden Anwendungen kénnen auch kombiniert werden. Wenn man z.B. eine
Stadt realistisch darstellen moéchte, definiert man zuerst die Basishdhe mit Hilfe

eines Oberflachenmodelles und erhdht dann die Gebadude mit Hilfe der Extrudierung.

12.5.1  Basishéhe mit Hilfe eines Attributes setzen

1. Rechtsmausklick auf den Layer - Properties....

2. Tab Base Heights > Use a constant value or expression to set heights for
layer.

3. Geben Sie einen konstanten Wert ein oder klicken Sie auf den Calculate-
Button.

4. Wahlen Sie das gewilinschte Attribut aus, welches als Z-Wert dienen soll. Es

kénnen auch SQL-Befehle verwendet werden.

12.5.2  Basishéhe mit Hilfe eines Oberflichenmodelles setzen

1. Rechtsmausklick auf den Layer - Properties....
Tab Base Heights - Obtain heights for layer from surface.
Waéahlen Sie das Oberflachenmodell aus, welches Sie als Basishdhe verwenden

wollen.
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12.5.3  Extrudierung der Elemente

1. Rechtsmausklick auf den Layer > Properties....
Tab Extrusion > M Extrude features in layer.

3. Geben Sie einen konstanten Wert ein oder klicken Sie auf den Calculate-
Button.

4. Wahlen Sie das gewinschte Attribut aus, welches als Extrusions-Wert dienen
soll. Es kénnen auch SQL-Befehle verwendet werden.

5. Wahlen Sie unter Apply extrusion by aus der Dropdown-Liste die Art aus, wie

die Extrusion hinzugefugt werden soll.

12.6 Toolbars
12.6.1 3D Analyst Toolbar

Die 3D Analyst Toolbar in ArcScene besteht aus verschiedenen Tools die auch in der
3D Analyst Toolbar in ArcMap vorkommen (Siehe Kapitel 10.5.1 3D Analyst

Erweiterung).

12.6.2 3D Effects Toolbar

Beleuchtung, Transparenz

Layer: [4» DHM_Dataset ] DB @7 &

12.6.3  Animation Toolbar

Animationen erstellen

Animation [ x|

Animation v | @ o

Mit dem Button Capture View (o] (oder der Tastenkombination Ctrl+A) kdnnen
gewilnschte Momentaufnahmen festgehalten werden. Diese Aufnahmen kénnen dann

als Animation laufen gelassen werden (Kapitel 12.6.3.1).

12.6.3.1 Animation Controls

Animationen Ablaufen lassen

Animation Controls [T B2

> | l| @l 0ptions>>|
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12.6.4 Tools Toolbar

Zoom- und Pan Funktionen

Tools [ x|

P~ Qe QeQQEITOPE R OM

12.7 Fliige erstellen

Mit dem lIcon Fly D von der Tools Toolbar kann man virtuelle Fliige Uber die 3D-

Landschaft starten. Der Flug kann mit der Taste Esc wieder beendet werden.

12.8 Darstellungsreihenfolge @ndern

In ArcScene wird die Darstellungsreihenfolge nicht gleich geregelt wie in ArcMap.
Die Daten werden dargestellt anhand der Layer-Prioritat. Haben zwei Layer die
gleiche Prioritat so verschmelzen sie. Um dies zu verhindern, missen den Layern
verschiedene Prioritaten zugeordnet werden: Rechtsmausklick auf den gewiinschten
Layer - Properties > Rendering. Unter Select the drawing priority of areal features,
related to other layers that may be at the same location. This helps to determine
which feature gets drawn on top of the other. kann die Prioritdt des Layers
ausgewahlt werden.

Ein andere Mdoglichkeit um die Layerprioritdt zu &ndern ist: Change Depth Priority in
der 3D Effects Toolbar.
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13 Der ModelBuilder

Der ModelBuilder ermoglicht als Teil des Softwarepaketes ArcGIS die Erstellung
komplexer Modelle von geografischen Zusammenhangen ohne Programmier-
erfahrung. Es werden einzelne Werkzeuge der ArcToolbox miteinander kombiniert,
so dass ein komplexer Arbeitsfluss entstehen kann.

Die Benutzeroberflache des ModelBuilders besteht aus einem Diagrammfenster, in
welchem der Arbeitsfluss des Modells abgebildet wird, aus einem Hauptmeni und
einer Toolbar (Werkzeugsleiste). Im Folgenden finden Sie eine Ubersicht und eine

kleine Beschreibung der wichtigsten Toolbars und Menus des ModelBuilders.

13.1 Vorbereitungen

Im Menu Tools &> Options... > Geoprocessing unter My Toolboxes kann angegeben
werden, wo die neuen Toolboxen erstellt werden sollen. Wenn Sie mdchten, dass die
Ausgaben immer wieder uUberschrieben werden durfen, setzen Sie im gleichen Tab

unter General bei Overwrite the outputs of geoprocessing operations ein Hakchen.

13.2 Eine neue Toolbox erstellen

ArcToolbox Fenster anzeigen und eine neue Toolbox erstellen: Rechtsmausklick auf

ArcToolbox = New Toolbox.

New Toolbox
# & Analy  Add Toolbox...
+ a Cato Environments...

+ & Conv

+ &P Cove |v Hide Locked Tools

= &P Data -

= & Geoc Save Settings 4
=@ Geos | 5ad Settings »
# @@ Linea -

#- & Spatial Analyst Tools
=@ Spatial Statistics Tools

13.3 Ein neues Modell erstellen

Rechtsmausklick auf die Toolbox, in welche das Modell abgelegt werden soll >
New -> Model...
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£§ ArcToolbox

& 3D Analyst Tools

= &P Analysis Tools

&P Cartography Tools

= @ Conversion Tools

[+ a Coverage Tools

#- &P Data Management Tools

+ a Geocoding Tools

+ &P Geostatistical Analyst Tools

+ & Linear Referencing Tools

# &P Spatial Analyst Tools

+ & Spatial Statistics Tools
M

i3 Tool:r' e

i) Paste

X Remove

Rename

13.4 Offnen eines bestehenden Modelles

Um ein bestehendes Modell zu bearbeiten, kann das Modell mit Rechtsmausklick »>

Edit... gedffnet werden.

13.5 Das ModelBuilder-Fenster

Das ModelBuilder Fenster besteht aus einem Diagrammfenster, in welchem das

Diagramm des Modells gebildet wird, einer Hauptmenu-Toolbar und einer Toolbar:
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Hauptmeni
Toolbar —»-

Toolbars—»| & &| ¥ |%|@| #| 52

13.51

Model Edit View Window Help
11::] @Qlojal=| |2 »]

»

Curvature

Daten “pefeh| Diagrammfenster

»

Hauptmenii

Das Hauptmenl besteht aus funf Pulldown-Menus:

13.5.2

Model: Beinhaltet Optionen um das Modell auszufiihren, zu speichern,
drucken, importieren, exportieren, schliessen etc.

Edit: Beinhaltet Optionen um Elemente im Modell auszuschneiden, zu
kopieren, einzufligen, zu I6dschen und zu selektieren.

View: Beinhaltet eine Auto Layout Option, welche die Einstellungen, die in
der Diagram Properties Dialog Box gemacht wurden, auf das Modell
anwendet. Ausserdem beinhaltet dieses Ment auch Zoom-Optionen.
Window: Beinhaltet ein Overview Window, in welchem man das ganze
Modell sehen kann, wéhrend man im Display Window in einem bestimmten
Teil des Modells hineinzoomt.

Help: Startet die ArcGIS Desktop Online Help und gibt Informationen zum
ModelBuilder (About ModelBuilder Box).

Toolbar

Fixed Continuous

Save Page Auto  Zoom In Zoom Run
Qut | Layout Zoom in | Select |

| | | | |
gl;v?j_allﬂ I B @I%“I"RI@;ITI nlﬁﬂ b |
Copy

_ Full Fixed Pan _ Add
Print Add Data Extent Zoom Out Navigate Connection

Save: Modell speichern.
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Print: Modell drucken.

Cut: Ein selektiertes Element ausschneiden.

Copy: Ein selektiertes Element kopieren.

Paste: Ein ausgeschnittenes oder kopiertes Element einfligen. Die Elemente kbnnen
mit Copy und Paste von einem Modell zum anderen kopiert werden.

Add Data: Projektdaten oder Tools ins ModelBuilder Fenster einfiigen®.

Auto Layout: Layout Preferences, welche unter Model Properties definiert wurden,
anwenden.

Full Extent: Ganzes Modell anzeigen.

Fixed Zoom In: Hineinzoomen (Zoomschritte konstant).

Fixed Zoom Out: Herauszoomen (Zoomschritte konstant).

Zoom In: Zum Ausschnitt im aufziehbaren Rechteck zoomen.

Pan: Verschieben des Fensterausschnittes.

Continuous Zoom: Stufenloses hinein- und hinauszoomen mit gedrickter linker
Maustaste und Vorwarts- und Ruckwéartsbewegung der Maus.

Navigate: Schritt fur Schritt durch ein Modell navigieren.

Select: Elemente, Verbindungslinien oder Labels selektieren.

Add Connection: Elemente im Modell verknipfen.

Run: Prozesse ausfiihren welche noch nicht ausgefiihrt wurden. Um alle Prozesse
laufen zu lassen, egal ob sie bereits ausgefiihrt wurden oder nicht, verwenden Sie
das Menu Model - Entire Model.

13.6 Modell-Eigenschaften definieren

Im Menu Model unter Model Properties... kbnnen die Eigenschaften des Modells
definiert werden (oder Rechtsmausklick auf das Modell in ArcToolbox oder
ArcCatalog > Properties...).

Im Tab General kann ein Name, ein Label und eine Beschreibung eingetragen
werden. Der Name wird spater verwendet, um das Modell in der Komandozeile oder
in einem Skript aufzurufen. Die Bezeichnung, welche unter Label eingegeben wird,
ist der Name, welcher in der ArcToolbox erscheint. Die Beschreibung erscheint im
Dialogfenster im Hilfe-Fenster auf der linken Seite.

Unter Parameters werden die Model Parameter aufgefuhrt (siehe Kapitel 13.7.2).

Hier wird die Reihenfolge der Model Parameter im Dialogfenster eingestellt.

9 Daten kénnen auch mit Drag & Drop vom ArcCatalog Tree oder vom Table of Contents und
Tools vom ArcCatalog Tree oder vom ArcToolbox Fenster ins Modelbuilder Fenster gezogen
werden.
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Im Tab Environment werden die Umgebungsvariablen des Modells gesetzt. Unter
General Settings kann z.B. unter Current Workspace der Pfad angegeben werden,
unter welchem die Daten abgelegt werden sollen (Hakchen bei Current Workspace >
Button Values... klicken).

Anschliessend die Einstellung fir das Modell speichern.

13.7 Modell erstellen

Um das Modell des Analyseverlaufes zusammenzusetzen, werden die noétigen
Werkzeuge mittels Drag & Drop aus dem ArcToolbox Fenster ins Modell verschoben

(gelbe Rechtecke). Werkzeuge aus den verschiedenen Toolbars kénnen leider dazu

+

nicht verwendet werden. Die Daten werden entweder Uber den Button Add Data ¥,
mittels Drag & Drop vom ArcCatalog Tree oder vom Table of Contents oder direkt im
Dialogfenster des Werkzeuges ins Modell eingefligt (dunkelblaue Ovale).

Durch Doppelklick auf ein Werkzeug (gelbes Rechteck) im ModelBuilder Fenster
offnet sich jeweils der dazugehdorige Dialog, in dem die erforderlichen Parameter
eingestellt und die Daten hinzugefiigt werden kénnen.

Um eine Verbindung zwischen den Elementen im Modell zu erstellen (z.B. um das

Raster R als Input der Funktion F zu definieren), kann man Add Connection a
auswahlen und in der Zeichenflache die entsprechenden Objekte wverknipfen. Dies
hat den gleichen Effekt wie wenn man die Ein- und Ausgabeparameter im
Dialogfenster des Werkzeuges angibt. Wenn alle Angaben sinnvoll sind, werden die

Rechtecke und Ovale farbig gefullt.

13.7.1  Variablen erzeugen

Es gibt zwei verschiedene Arten von Variablen in ModelBuilder: Variablen welche
Daten beinhalten (dunkelblaues Oval) und Variablen welche Werte beinhalten
(hellblaues Oval).

Wenn Sie den Werkzeugdialog verwenden, werden die Datenvariablen automatisch

dargestellt, die Wertevariablen jedoch nicht.

13.7.1.1  Variablen aus Parametern oder Umgebungseinstellungen

Aus jedem Werkzeug-Parameter kann wie folgt eine Variable erstellt werden:
Rechtsmausklick auf das Werkzeug - Make Variable - From Parameter -

anschliessend den gewlinschten Parameter auswéhlen.
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%

— Buffer

L Open...

Edit Documentation...
Run

Make Variable » Distance [value or Field]

Create Label From Environment »  Side Type
View Messages... End Type
Dissolve Type
A Cut Dissolve Field(s)
B2Copy
K Delete

Rename...

Switch to picture symbol

Display properties...

P& Properties...

Es kdnnen nicht nur die Parameter als Variablen gesetzt werden, sondern auch die

Umgebungsvariablen der Ausgabedatei (Make Variable = From Environment).

13.7.1.2 Unabhingige Variablen

Durch Rechtsmausklick ins Diagrammfenster - Create Variable... 6ffnet sich ein
Fenster, in welchem der Typ der Variablen ausgewahlt werden kann. Durch setzen
des Hakchens unter Multivalue kann auch eine Variable mit mehreren Werten gesetzt
werden.

Die unabhangige Variable kénnen anschliessend mit einem oder mehreren

Werkzeugen verbunden werden.

13.7.2 Model Parameter

Wenn Sie ein vordefiniertes Werkzeug offnen, sehen Sie alle Parameter welche das
Werkzeuges braucht. Diese Parameter konnen entweder eingetippt, aus einer
Dropdownliste ausgewahlt oder im Falle eines Datenpfades direkt mit Hilfe eines
Buttons gesucht werden.

Die Modelle welche Sie in ModelBuilder erstellen sind ebenfalls Werkzeuge. Sie
haben also auch die Mdéglichkeit Parameter auszuwéhlen, welcher der zukinftige
Benutzer des Werkzeuges selber setzen kann. Diese Parameter nennt man
Modellparameter (Model Parameter).

Es mussen jedoch nicht immer Model Parameter definiert werden. Es kann auch sein,
dass ein Modell bereits alle Informationen enthalt und ohne zusétzliche Angaben des

Benutzers laufen gelassen werden kann. Falls ein Werkzeug keine Model Parameter
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besitzt, sieht der Benutzer des Werkzeuges folgende Meldung: This tool has no

parameters.

13.7.2.1 Setzen von Model Parameter

Mit Rechtsmausklick auf die Variable > Model Parameter in ModelBuilder kann eine
Variable als Model Parameter festgelegt werden. In der Darstellung erscheint nun
neben der Variablen der Buchstabe P. Dieser Buchstabe zeigt auf, cass die Variable

im Dialog des Werkzeuges erscheinen wird.

~F

Buffer —

Distance

Wir bereits ein Defaultwert in ModelBuilder definiert, dann erscheint ein farbiges
Oval, d.h. wenn der Dialog gedffnet wird, ist bereits ein moglicher Wert oder
Datenpfad aufgelistet. Der Benutzer kann diesen Wert oder Pfad aber noch
anpassen.

Wird kein Defaultwert fir ein Model Parameter definiert, so bleibt das Oval weiss.
Der Benutzer sieht im Dialogfenster des Werkzeuges also keine méglichen Werte
oder Pfade und muss diese selber definieren.

Es ist meistens nicht nétig, dass der Benutzer alle Variablen als Parameter setzten
kann. Uberlegen Sie sich also vorher gut, welche Parameter als Model Parameter

wirklich Sinn machen.

13.7.2.2 Reihenfolge der Model Parameter im Dialog &ndern

Die Darstellungreihenfolge im Dialogfenster ist unter den Modelleigenschaften unter
Parameters sichtbar (siehe Kapitel 13.6). Ein markierter Modelparameter kann mit
Hilfe der beiden Pfeile in der Darstellungsreihenfolge nach oben oder unten

verschoben werden.

13.7.3  Variable als Intermediate setzen (Zwischenergebnisse)

Wenn ein Modell mit mehreren Prozessen laufen gelassen wird, wird fir jeden
Prozess mindestens eine Outputdatei geschrieben. Einige von diesen Dateien werden
aber nur geschrieben, um mit einem weiteren Prozess verbunden werden zu kénnen.

Diese Dateien sind also nur Zwischenergebnisse, wenn das Endresultat berechnet
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wurde, werden sie nicht weiter gebraucht. Solche Variablen kénnen in ModelBuilder
durch Rechtsmausklick und Hakchen bei Intermediate setzen als Zwischenergebnisse
markiert werden.

Die Zwischenergebnisse werden geléscht, wenn das Modell in ArcToolbox oder
ArcCatalog laufen gelassen oder in einem Skript oder in der Kommandozeile
verwendet wird. Wird das Modell in ModelBuilder laufen gelassen, bleiben die
Zwischenergebnisse gespeichert. Das hat den Vorteil, dass man in ModelBuilder auch
nur einen Teil des Modelles laufen lassen kann. Wenn die Zwischenresultate immer
geloscht wiurden, wirde dies nicht gehen.

In ModelBuilder werden alle abgeleiteten Daten automatisch als intermediate
markiert.

Die Zwischenresultate in ModelBuilder konnen uber das Menu Model 2 Delete

Intermediate Data gel6scht werden.

13.7.4  Setzen der Umgebungsvariablen der Ausgabedatei

Die meisten Werkezeuge setzen den Pfad wohin die Ausgabedatei gespeichert
werden soll automatisch. Es wird entweder der Pfadname der ersten Eingabedatei
oder die Werte der Umgebungsvariablen des Modells (siehe Kapitel 13.6) verwendet.
Will man fur die Ausgabedatei andere Umgebungsvariablen verwenden, so muss
man diese wie folgt definieren: Rechtsmausklick auf das Werkzeug - Properies... >
Environments. Diese Einstellungen uberschreiben die allgemeinen Einstellungen des
Modells.

Hier kbnnen neben dem Pfadnamen (General Settings - Current Workspace) auch
das Koordinatensystem (General Settings -2 Output Coordinate System), die
Ausdehnung (General Settings - Extent), die Zellgrosse bei Rastern (Raster Analysis
Settings 2 Cell Size) oder eine Maske (Raster Analysis Settings - Mask) definiert
werden. Einfach beim gewinschten Parameter ein Hakchen setzen, auf Values..
klicken und die Werte eingeben. Die Eingaben beziehen sich immer auf die

Ausgabedatei.

13.7.5 Umbenennen von Werkzeugen und Variablen

Mit Rechtsmausklick auf die Variable oder das Werkzeug - Rename... kann die
Bezeichnung verandert werden. Falls es sich um ein Model Parameter handelt, wird

die Bezeichnungen im Dialogfenster tibernommen.
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13.7.6 Label erstellen

Durch Rechtsmausklick ins Diagrammfenster - Create Label kann ein Label ins
Diagramm eingefugt werden. So koénnen die einzelnen Vorgdnge im Diagramm
beschriftet und beschrieben werden. Dies wird vor allem dann verwendet, wenn die

Modelle an andere Personen weitergegeben werden.

13.7.7 Dokumentation eines Modelles erstellen

Im Dokumentationseditor wird die Dokumentation zu den Werkzeugen,
Modellprozessen und Toolboxes abgespeichert. Diese Informationsquelle wird vom
Hilfesystem und von ArcGIS Applikationen verwendet.
Es gibt zwei Mdglichkeiten um den Dokumentationseditor zu 6ffnen:
e In ArcToolbox, Rechtsmausklick auf das Werkzeug oder die Toolbox - Edit
Documentation
¢ Im ArcCatalog Tree wird das Werkzeug oder die Toolbox selektiert >
Metadata Tab in Metadata Toolbar - Edit Metadata
Der ArcToolbox Documentation Editor besteht aus zwei Teilen: Auf der linken Seite
ist das Inhaltsverzeichnis (table of contents) und auf der rechten Seite der Bereich,
wo der Text zu den einzelnen Punkten abgelegt werden kann.
Achtung: Ein einzelner Prozess wird direkt in ModelBuilder Uber Rechtsmausklick

auf Werkzeug - Edit Documentation dokumentiert.

13.8 Modell ausfiihren

Das Modell kann durch Doppelklick oder durch Rechtsmausklick - Open... in
ArcToolbox oder ArcCatalog ausgefuhrt werden. Dadurch wird das Werkzeug
geodffnet und falls notig konnen die Parameter definiert werden (Definieren von
Model Parameter siehe auch Kapitel 13.7.2).

Hat man das Modell im Editiermodus gedffnet, so kann der vollstandige

Analyseverlauf auch Uber den Button Run 4 laufen gelassen werden. Will man nur
einen Teilprozess laufen lassen, so kann das mittels Rechtsmausklick auf das
Werkzeug - Run durchgefuhrt werden.

Welcher Prozess gerade ausgefuhrt wird, erkennt man daran, dass das Rechteck des
Werkzeuges rot eingefarbt ist. Wurde ein Prozess erfolgreich ausgefuhrt, werden das
Werkzeug und die abgeleiteten Datenelemente mit einem grauen Schattenrand
versehen. Das erstellte Output (grines Oval) kann direkt Gber Rechtsmausklick auf

das Oval - Add to Display in ArcMap dargestellt werden.
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13.9 Modell exportieren

Die eigenen (meist komplexen) Prozessabldufe kdnnen als Skripte exportiert werden
Model 2 Export 2 to Script. So ist ein Modellaustausch unter verschiedenen
Anwendern madglich.

Die anderen Benutzer kénnen die exportierten Ablaufe anschliessend in die eigene
Geoprozessingtoolbox integrieren (Rechtsmausklick auf My Toolbox = Add =2 Script).

So kénnen Zeit und Kosten gespart werden.

13.10 Bestehendes Modell 6ffnen

Die abgespeicherten Modelle werden in der entsprechenden Toolbox angezeigt. Diese

Modelle kénnen mit Rechtsmausklick =2 Edit... gedffnet und editiert werden.
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14 Datenmodellierung mit Visio

14.1

14.1.1

Voraussetzungen und Vorbereitung

Voraussetzung

Auf IThrem Computer muss das Programm Microsoft Office Visio installiert sein.

14.1.2

ESR/I Case Patch installieren

Kopieren Sie aus dem ArcGIS Installationsverzeichnis

».\Program Files\ArcGIS\CaseTools\Utilities” die folgenden beiden Dateien in die

entsprechenden Ordner:

Die Datei ,ESRI XMl Export.vsl“ in das Visio 2003 Installationsverzeichnis
»--\Program Files\Microsoft Office\Visio11\1033".
Die Datei ,,uml.dtd” in das Verzeichnis, in welches Sie spater auch das Modell

exportieren.

14.1.3  XM/-Exporter installieren

1. Laden Sie den Microsoft-Patch fir den XMl Export Prozess von der Microsoft
Downloadseite herunter (nach dem Begriff XMI suchen):
http://www.microsoft.com/downloads/search.aspx?displaylang=en.

2. Wahlen Sie die Seite zum Thema ,,UML to XMI EXport* far Visio 2003 und
laden dort die Datei XMIExprt.exe herunter und entzippen diese.

3. Kopieren sie die Datei ,XMIExprt.dll“, welche sich im entzippten Ordner
befindet, in das Visio 2003 Installationsverzeichnis ,,...:\Program
Files\Microsoft Office\Visiol1\DLL".

4. Wenn das ,,XMI Export Facility Tool“ das erste Mal installiert wird, setzen sie
die Makro Sicherheitsoptionen von Visio 2003 wie folgt:

e Starten sie Visio 2003 Professional und begeben sie sich in das Menl Tools
> Options...

e Wé&hlen sie das Security-Tab aus und klicken auf den Macro Security...-
Button

¢ Setzen sie das Sicherheitslevel auf niedrig (Low)

¢ Schliessen sie Visio Professional 2003

5. Starten sie Visio 2003 Professional erneut und begeben sich in das Menu
Tools > Options....
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6. Wahlen sie den Tab fur Advanced im Optionen-Dialogfenster und klicken sie
auf den Button fur File Paths....

7. Klicken sie auf den Browse-Button (..) fur das Add-ons Feld und selektieren
sie das Visio 2003 Installationsverzeichnis ,,..\Program Files\Microsoft
Office\Visioll\1033".

8. Bestatigen sie mit OK und schliessen sie das Dateipfad und das Optionen-
Dialogfenster.

9. Nach der erfolgreichen Installation des neuen Makros setzen sie die Makro-
Sicherheitsoptionen von Visio 2003 wieder zurick auf Medium (siehe
Ablaufpunkt 4).

10. Starten sie Visio 2003 Professional erneut, damit die Anderungen aktiviert

werden.

Sollten Warnhinweise von Visio 2003 erscheinen, wahlen sie stets ,,Makro

aktivieren”!

Referenz
http://support.esri.com/index.cfm?fa=knowledgebase.techarticles.articleShow&d=26105

(http://support.esri.com - Suchen nach “uml visio 2003")

14.2 Das Arclnfo UML Modell

Die ESRI Visio Templates fir die verschiedenen Versionen von Microsoft Office
Visio werden im Softwarepaket ArcGIS mitgeliefert und sind unter
..\Program Files\ArcGIS\ CaseTools\Uml Models abgespeichert.

Arclnfo UML Modell laden:

1. Das Programm Microsoft Office Visio starten.

2. Im Hauptmenu File > Open... klicken und das Arcinfo UML Model Template
File (.../Program Files/ArcGIS/CaseTools/Uml Models/Arcinfo UML Model (Visio
2003).vst) offnen.

3. Makros mussen aktiviert werden (Enable Macros).

Vorlage als eigene Visio Drawing Datei abspeichern (*.vsd).
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Das Arcinfo UML Modell enthédlt das Objektmodell und die relevanten

Komponenten, welche benétigt werden um mit dem Programm Visio 11:' mit UML
eine Geodatabase zu modellieren. Das Arclnfo UML Modell hat vier Packages:
Logical View, ESRI Classes, ESRI:Interfaces und Workspace. Diese UML-Packages
entsprechen Verzeichnissen, in denen unterschiedliche Teile des gesamten Arclnfo
UML Modells erhalten sind.

Das Logical View Package ist das Ubergeordnete Package und enthalt die anderen
drei.

Model Explorer E¢

Q Arcinfo UML System
=424 Arclnfo Uml Model
=44 Logical View
#-{_] ESRI Classes
@] ESRI Interfaces
#- (] Workspace

Ein Package enthalt beliebig viele UML-Elemente wie weitere Packages, Klassen
(classes), Verbindungen (interfaces) und Diagramme (diagrams). Beachten Sie, dass
das Workspace—Diagramm in der Zeichenflache zum Workspace-Package gehort.
Dieses Workspace-Package reprasentiert die Geodatabase. Es gibt keine Begrenzung

far die Anzahl der Packages, welche ein Arclnfo UML Modell enthalten kann. Sie
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miussen jedoch alle innerhalb des Workspace-Packages erzeugt werden. Es kdnnen

auch Feature Datasets, Object Classes (Tabellen) und Stand-Alone Feature Classes

unter dem Workspace-Package kreiert werden.

14.3

6.

14.4

Feature Dataset erstellen

Im Model Explorer auf Workspace klicken.

Aus der UML Static Structure Vorlage durch Drag & Drop das Shape

Package E] in die Zeichenflache einfligen.

Doppelklick auf das Package um die Eigenschaften einzublenden.

Benennen Sie das Package um.

Bei Stereotype aus der Dropdown-Liste Feature Dataset auswahlen und mit
OK bestatigen. Im Model Explorer ist nun ein neues Package mit einer
neuen Zeichenflache (Static Structure) kreiert worden.

Benennen Sie die Zeichenflache Static Structure des neuen Packages um.

Feature Class erstellen

14.4.1 Feature Classes kreieren

1.

Um die Feature Class im gewiunschten Feature Dataset zu erstellen, muss
man durch Doppelklick auf die gewinschte Static Structure im Model
Explorer in die entsprechende Zeichenflache wechseln.

Das Shape Object durch Drag & Drop aus dem Model Explorer unter ESRI
Classes in die Zeichenflache einfugen.

Das Shape Feature durch Drag & Drop aus dem Model Explorer unter ESRI

Classes in die Zeichenflache einfugen.

Merke: Unter ESRI Classes ist definiert, dass das Programm Visio automatisch

als Beziehung zwischen Object und Feature eine Vererbung (Generalization)

hinzufugt.

Aus der UML Static Structure Vorlage durch Drag & Drop eine neue

Klasse E (Class) in die Zeichenflache einflgen.

Doppelklick auf die neue Klasse und gewiinschten Namen der Feature Class
eingeben.

Um die Eigenschaftswerte wie z.B. die Geometrie zu definieren, siehe Kapitel

14.6 Tagged Values definieren.
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7.

Durch Drag & Drop eine Vererbung & (Generalization) in die Zeichenflache
einfigen und die neue Klasse mit dem Feature verbinden (der Pfeil sollte von

der Klasse zum Feature zeigen).

Merke: Die erstellte Feature Class wird die beiden Attribute OBJECTID und

Shape ebenfalls besitzen, da sie diese von den Klassen Object und Feature erbt.

14.4.2 Attribute zu Feature Class hinzufidgen

o hr W NPRE

14.5

Doppelklick auf die Klasse.

Unter Categories auf Attributes klicken.

New anwé&hlen um ein neues Attribut zu erstellen.

Attribut benennen.

Klicken Sie unter Type und wahlen Sie den gewiinschten Feldtyp aus (z.B.
esriFieldTypeString). Dieser Feldtyp kann auch lber den Button Properties...
unter Type eingestellt werden. Um die Eigenschaftswerte wie z.B. die Lange
einer Zeichenkette zu definieren siehe Kapitel 14.6 Tagged Values definieren.
Bestatigen mit OK.

Wiederholen der Schritte 3 bis 6 um weitere Attribute anzufltigen.

Object Class (Tabelle) erstellen

14.5.1 Object Class kreieren

1.
2.

Im Model Explorer auf Workspace klicken.
Aus dem Model Explorer unter ESRI Classes durch Drag & Drop das Shape
Object in die Zeichenflache einfugen.

Aus der UML Static Structure Vorlage durch Drag & Drop eine neue Klasse

% (Class) in die Zeichenflache einfugen.

Doppelklick auf die neue Klasse und gewiunschten Namen der Tabelle
eingeben.

Durch Drag & Drop eine Vererbung (Generalization) in die Zeichenflache
einfugen und die neue Klasse mit dem Object verbinden (der Pfeil sollte von

der Klasse zum Object zeigen).

Merke: Im Gegensatz zu einer Feature Class wird bei einer Object Class nur das

Shape Object hinzugefugt (keine Geometrie). Es wird daher nur das Attribut
OBJECTID "vererbt“. Ausserdem wird die Object Class auf der Stufe des

Workspaces und nicht auf der Stufe des Feature Dataset erstellt.
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14.5.2

Attribute zu Object Class hinzufiigen

Siehe Kapitel 14.4.2 Attribute zu Feature Class hinzufugen.

14.6

Tagged Values definieren

Eigenschaftswerte (Tagged Values) werden gebraucht um zuséatzliche spezifische,

charakteristische Eigenschaften der UML-Elemente zu definieren. Sie bestehen aus

einem Schlusselwort (Tag) und einem dazugehérigen Wert (Value). Es kdnnen

Eigenschaftswerte fir einzelne Attribute z.B. die Lange einer Zeichenkette (string

field) oder fur ganze Feature Classes z.B. die Geometrie eines Objektes definiert

werden.
14.6.1  Tagged Values fiir einzelne Attribute definieren
1. Offnen des Eigenschaftsfensters (UML Class Properties) durch Doppelklick auf
die gewiinschte UML Klasse in der Zeichenflache.
2. Unter der Kategorie Attributes das Attribut auswahlen fir welches der
Eigenschaftswert wie z.B. die Ldnge der Zeichenkette festgelegt werden soll.
3. Durch Klicken auf den Properties...-Button wird das UML Attribute Properties-
Fenster gedffnet.
In diesem Fenster die Kategorie Tagged Values anklicken.
Klicken Sie New um eine neues Tagged Value zu erstellen.
Schreiben Sie das Schlusselwort (im Beispiel der Lange der Zeichenkette das
Wort Length) in die Tag-Textbox und den entsprechenden Wert (z.B. die
Feldlange) in die Value-Textbox.
7. Mit OK bestéatigen.
14.6.2  Tagged Values fiir Feature Classes etc. definieren
1. Offnen des Eigenschaftsfensters (UML Class Properties) durch Doppelklick auf
die gewiinschte UML Klasse in der Zeichenflache.
Die Kategorie Tagged Values anklicken.
3. Klicken Sie New um eine neues Tagged Value zu erstellen.

Schreiben Sie das Schlusselwort (Im Beispiel der Geometrie-Definition den
Begriff GeometryType) in die Tag-Textbox und den entsprechenden Wert
(EsriGeometryPoint, EsriGeometryPolyline oder EsriGeometryPolygon) in die

Value-Textbox.
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! UML Class Properties [X]

Categories:
Class
Attributes Tags:
Operations documentation
Receplions T — |
Template Parameters location
Components persistence Duplicate... .
Constraints responsibility
& Tagged Values semantics Delete
Properties...
Tag GeometryType value:
E siGeometryPolygon =
=i

@ [ ok | cancel

5. Mit OK bestatigen.

14.6.3 Tagged Values (z.B. Geometrietyp) als Attribut im Diagramm anzeigen

Rechtsmausklick auf die Klasse und Shape Display Options... auswahlen. Im Fenster

UML Shape Display Options unter General Options bei Properties ein Hadkchen setzen.

14.7 Nonattributed Relationship Classes erstellen (Relationships 1:1;
1:m)
UML-Assoziationen sind Relationship Classes zwischen Feature Classes und/oder

Object Classes (Tabellen). Primér- und Fremdschlissel missen in den Klassen

enthalten sein (Priméarschlissel kann auch ObjectID sein).

KANTONE BEZIRKE
-Kant_ID -Name
- Name 1 ml. Bez_ID
- Sorache -Kant_ID
Origin Table Destination Table

In einem ersten Schritt wird die Verknupfung zwischen zwei Klassen erstellt, eine
Ursprungs- und eine Zielklasse festgelegt und die Multiplizitat (Kardinalitat) definiert.
In einem zweiten Schritt muss noch festgelegt werden, Uber welche Attribute die

beiden Klassen miteinander verknupft sind.
14.7.1 Assoziationen erstellen

1. Binary Association I aus der UML Static Structure Vorlage durch Drag &

Drop in die Zeichenflache ziehen.
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2. Verbinden Sie die gewlnschten Klassen. Das linke Ende der Verbindung ist
die Ursprungsklasse (origin table), das rechte Ende ist die Zielklasse
(destination table).

3. Doppelklick auf die Verbindung um das UML Association Properties-Fenster zu
offnen.

Die Verbindung benennen (z.B. Kant_Bez).
Unter Association Ends eines der beiden Enden auswéhlen und Properties
anklicken.

6. Benennen Sie das Ende der Verbindung (Name). Der angegebene Text wird
die Relationship Class Bezeichnungen sein (z.B.: gehort zu; besteht aus).

7. Unter Multiplicity dem Verbindungsende die entsprechende Multiplizitat
zuweisen. Weil die Multiplizitat einer Relationship Class in ArcGIS nur 1-1, 1—
M, oder M—N sein kann, sind die einzigen gultigen Multiplicity Values 1 und *
(= M, viele).

Mit OK bestatigen.

Punkte 5 bis 8 fur das andere Verbindungsende wiederholen.

14.7.2  Figenschaften der Assoziationen definieren

Die Bedingungen fur die Nonattributed Relationship Class werden in UML durch
Tagged Values festgelegt. Folgende Tagged Values muissen fur Nonattributed

Relationship Classes definiert werden:

OriginClass: the name of the origin class (z.B. Kantone)

OriginPrimaryKey: the name of the primary key field in the origin class
(z.B. Kant_ID)

OriginForeignKey: the name of the foreign key field in the destination

class (z.B. Kant ID)

Doppelklick auf die Assoziation.

Die Kategorie Tagged Values anwahlen.

New... anklicken.

Zum Beispiel ,,0OriginClass” in das Tag-Feld eintragen.

Schreiben Sie den Namen des Origin Class Feldes in das Value-Feld.

Mit OK bestatigen.

N o ok wDdhR

Die Schritte 1 bis 6 wiederholen, um andere Tagged Values fest zu legen.
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14.8 Attributed Relationship Classes erstellen (Relationships m:m)

SBBSrecke Abschnitte
= m m
-Name
Origin Table Destination Table

14.8.1 Assoziationen erstellen

1.

14.8.2

Die UML Assoziation muss wie im Kapitel 14.7.1 Assoziationen erstellen
erzeugt werden.

Class aus der UML Static Structure Vorlage anwahlen und durch Drag & Drop
eine neue UML Klasse in der Zeichenflache erstellen.

Doppelklick auf diese neue Klasse, um das UML Class Properties-Fenster zu
offnen.

Die neue Klasse benennen. Die Bezeichnung muss die gleiche sein wie der
Name der Assoziation (z.B. Strecke_absch).

Bei Stereotype aus der Dropdown-Liste RelationshipClass auswéhlen und mit
OK bestéatigen.

Folgen Sie den Schritten 3 bis 7 des Kapitels 14.4.2 Attribute zu Feature
Class hinzufugen auf Seite 14-5, um die Attributsfelder der Relationship Class

hinzuzufugen.

Eigenschaften der Assoziationen definieren

Die Bedingungen fir die Attributed Relationship Class werden in UML durch Tagged

Values festgelegt.

Achtung: Die Tagged Values werden in der Assoziation (Binary Association) und

nicht in der Klasse (Relationship Class) erstellt!

Tagged Values fir die Attributed Relationship Class enthalten:

OriginClass: the name of the origin class (z.B. SBB_Strecke)

OriginPrimaryKey: the name of the primary key field in the origin
class (z.B. OBJECTID)

DestinationPrimaryKey: the name of the primary key field in the
destination class (z.B. OBJECTID)

OriginForeignKey: the name of the foreign key field (linked wiith the
origin class) in the attributed relationship
(z.B. Strecke ID)

DestinationForeignKey: the name of the foreign key field (linked wiith the
destination class) in the attributed relationship
(z.B. Abschnitt ID)

14-9
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14.9 Domains erstellen
14.9.1  Erstellen von Range Domains

1. Workspace Package >

TemplateRangeDomain

im Model Explorer

auswahlen, Rechtsmausklick und Duplicate anklicken. Unter dem Workspace-

Package wird eine Kopie der Klasse TemplateRangeDomain erstellt.

Durch Drag & Drop diese Kopie in die Zeichenflache verschieben.

Doppelklick auf die Kopie in der Zeichenflache und den Namen der Domain

eingeben.

Die Kategorie Attributes anklicken.

Das erste Attribut FieldType auswahlen und auf Properties klicken.

Den geeigneten Datentypen, mit welchem diese Domain verknipft werden

soll, in die InitialValue-Textbox eintragen (z.B. esriFieldTypelnteger) und mit

OK bestatigen:

B UML Attribute Properties E3

LCategories:
P Attribute
Constraints Name: |FieldType tereotype: ot
Tagged Values . | 3 I :I
Type expression -
Prefix: l IESHI Types::esnFieldType LI
Suffix. | [ESRI Types::esiFieldType
Visibility: Ipubiic ZI Changeable: Inone LI
Multiplicity: ~ [1 | OwnerScope: [instance ~|
< !niliaNalue: Ies:iFieldTypelnteger > TargetScope: Iinslance j
Documentation:
| =
=l
Cancel

)

7. Das Attribut MinValue anklicken und Properties auswahlen.

8. Schreiben Sie den Minimalwert der Range Domain in die InitialValue-Textbox

und klicken Sie OK.

9. Das Attribut MaxValue anklicken und Properties auswahlen.

10. Schreiben Sie den Maximalwert der Range Domain in die InitialValue-Textbox

und klicken Sie OK.

Anleitung ArcGIS FS11
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11.Um die Attributstypen im Diagramm nicht mehr anzuzeigen: Rechtsmausklick
auf die erstellte Range Domain und Shape Display Options... auswahlen. Im
Fenster UML Shape Display Options unter Attribute Options bei Attribute

types das Hakchen entfernen.

14.9.2  Erstellen von Coded Value Domains

1. Workspace Package - TemplateCodedValueDomain im Model Explorer
auswahlen, Rechtsmausklick und Duplicate anklicken. Unter dem Workspace-
Package wird eine Kopie der Klasse TemplateCodedValueDomain erstellt.
Durch Drag & Drop diese Kopie in die Zeichenflache verschieben.

Doppelklick auf die Kopie in der Zeichenflache und den Namen der Domain
eingeben.

Die Kategorie Attributes anklicken.

Das erste Attribut FieldType auswéahlen und auf Properties klicken.

Den geeigneten Datentypen, mit welchem diese Domain verknlpft werden
soll, in die InitialValue-Textbox eintragen (z.B. esriFieldTypelnteger) und mit
OK bestatigen (siehe Bild im Kapitel 14.9.1 Punkt 6).

Das Attribut Codel anklicken und Properties auswahlen.

Benennen Sie Codel um (entsprechend der ersten Bezeichnung in der Liste).
Geben Sie unter InitialValue den zum Codenamen gehérenden Codewert ein.

10. Repetieren Sie die beiden vorangegangenen Schritte fur alle andere Codes
(so viele wie die Anzahl der Werte in der Liste).

11. Durch OK bestatigen.

12.Um die Attributstypen im Diagramm nicht mehr anzuzeigen: Rechtsmausklick
auf die erstellte CodedValueDomain und Shape Display Options... auswahlen.
Im Fenster UML Shape Display Options unter Attribute Options bei Attribute

types das Hakchen entfernen.

14.9.3  Domain in Klassen verwenden

Um die Domain mit einem speziellen Feld zu verbinden, spezifizieren Sie einfach den
Namen der Domain als Feldtyp in den Klassen (z.B. Kantone: Type = Workspace:

Sprache oder Staedte: Type = Workspace:Hauptort).

14.10 Subtypes erstellen

Zusammenfassung: Subtypes werden in UML als Unterklassen definiert, welche
durch Beziehungen mit der Oberklasse verbunden sind. Der Verwendungszweck

(Stereotype) dieser Beziehungen muss als ,,.Subtype” definiert sein.
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In der Oberklasse wird das gewilinschte Attribut als SubtypeField definiert. Es kdnnen
nur Subtypes erstellt werden wenn das Attribut vom Typ Integer ist. Ausserdem wird
in der Oberklasse ein Default-Subtypewert festgelegt.

Jede Subtype-Klasse hat einen eigenen Wert im Subtype-Feld. Der Name dieses
Subtype-Feldes entspricht dem Namen des Subtype-Feldes der Oberklasse. Weitere
Attributsfelder werden in der Subtype-Klasse nur hinzugefugt, wenn sich die Regeln
gegentber dem Feld in der Oberklasse unterscheiden (unterschiedliche Default-
Werte oder Domains). Es kdnnen jedoch keine Attributsfelder zu einer Subtype-

Klasse hinzugefligt werden, welche nicht bereits in der Oberklasse vorhanden sind.

ESRI Classes::Object
+OBJECTID : esriFieldTypeOID

|

ESRI Classes::Feature
+Shape : esriFieldTypeGeometry

|

Strasse{GeometryType = EsriGeometryPolyline }
«SubtypeField» -TYPE : esriFieldTypelnteger = 10

Autobahn «Subllype»

-TYPE : esriFieldTypelnteger = 10 ¢
«Subgype»

Zugang
-TYPE : esriFieldTypelnteger = 2  qu———m

14.10.1 Subtype-Feld einer Feature Class definieren

1. Im Diagramm Doppelklick auf die Klasse fir welche ein Subtype erstellt
werden soll.
Die Kategorie Attributes anklicken.

3. Attribut anwahlen welches das Subtype-Feld sein soll und auf Properties
klicken.
Aus der Stereotype-Dropdownliste SubtypeField auswéhlen.
Achten Sie darauf, dass der Feldtyp eines Attributes mit Subtypes vom Typ

esriFieldTypelnteger sein muss.
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6.

Tippen Sie den Subtypecode in die InitalValue-Textbox ein, der als

Defaultwert verwendet werden soll und bestatigen Sie mit OK.

14.10.2 Subtype-Klassen erstellen

1.

10.

11.
12.

Aus der UML Static Structure Vorlage durch Drag & Drop eine neue Klasse g
(Class) in die Zeichenflache einfiugen.

Doppelklick auf die neue Klasse und als Namen die Bezeichnung des ersten
Subtype-Codes eingeben.

Die Kategorie Attributes anklicken und ein neues Attribut erstellen. Das
Attribut muss gleich heissen wie das Subtype-Feld der Feature Class.

Dieses Attribut anwahlen und auf Properties klicken.

Achten Sie darauf, dass der Feldtyp dieses Attributes ebenfalls vom Typ
esriFieldTypelnteger sein muss.

Das Subtype-Feld jeder Subtype-Class muss seinen eigenen eindeutigen
Standardwert haben, welcher dem Subtype-Code entspricht (z.B. 1, 2, 3
...usw.). Tippen Sie den Subtype-Code in die InitalValue-Textbox ein und
bestatigen Sie mit OK.

Falls sich die Regeln fur Attribute aus der Feature Class bei der Subtype-
Klasse andern, kdnnen diese ebenfalls hinzugefugt werden. Es durfen jedoch
keine neuen Attribute hinzugefugt werden, die nicht bereits in der Feature
Class vorkommen.

Die Subtype Class wird durch eine Binary Association mit der Oberklasse
verbunden. Die Binary Association in der UML Static Structure Vorlage durch
klicken anwahlen, mittels Drag & Drop in die Zeichenflache ziehen und die
Klassen verbinden.

Doppelklick auf die Verbindung.

Die Subtypes Association Ends muissen nicht benannt werden. Die einzige
Eigenschaft die es zu setzen gilt, ist der Stereotype, welcher als Subtype
definiert werden muss.

Mit OK bestatigen.

Wiederholen Sie die Schritte 1 bis 11 fiur alle Subtype-Codes.

14.11 Geometrisches Netzwerk erstellen

Zusammenfassung: Geometrische Netzwerke werden in UML mit einer Klasse

modelliert, bei welcher der Verwendungszweck (Stereotype) auf GeometricNetwork

gesetzt wird. Die Feature Classes des Netzwerkes werden Uber Beziehungen mit dem

14-13
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Geometrischen Netzwerk verbunden. Dies muss alles im gleichen Feature Dataset
geschehen. Das Geometrische Netzwerk hat nur das Attribut in welchem der
Netzwerktyp definiert wird. Im Arclnfo UML Model ist ein Template fir

geometrische Netzwerke abgespeichert.

14.11.1 Aufbau Geometrischer Netzwerke

1. Zuerst muss ein Feature Dataset erstellt werden, in welchem das
geometrische Netzwerk aufgebaut werden kann (siehe Kapitel 14.3).

2. Anschliessend wird eine Kopie des Templates erstellt: Workspace-Package >
TemplateGeometricNetwork im Model Explorer auswahlen, Rechtsmausklick
und Duplicate anklicken. Unter dem Workspace-Package wird eine Kopie der
Klasse TemplateGeometricNetwork erstellt.

3. Durch Drag & Drop diese Kopie im Model Explorer in den Ordner des
Feature Datasets verschieben.

4. Im Model Explorer unter ESRI Classes durch Drag & Drop die Klassen,
welche zum Netzwerk gehéren (SimpleJunctionFeature, SimpleEdgeFeature,
ComplexJunctionFeature, ComplexEdgeFeature), in die Zeichenflache
einfugen.

5. In der UML Static Structure Vorlage durch Drag & Drop fur die Knoten

(Junctions) und die Kanten (Edges) mindestens je eine neue Klasse E (class)
in die Zeichenflache einfugen und diese benennen.

6. Attribute wie im Kapitel 14.4.2 Attribute zu Feature Class hinzufiigen
hinzufugen.

7. Durch Drag & Drop Vererbungen (generalization) in die Zeichenflache
einfugen und die neuen Klassen fur die Knoten mit der entsprechenden ESRI
Class SimpleJunctionFeature, SimpleEdgeFeature, ComplexJunctionFeature
oder ComplexEdgeFeatur verbinden (der Pfeil sollte von den Klassen zum
Feature zeigen).

8. Durch Drag & Drop eine Binary Association in die Zeichenflache einfliigen und

die neuen Klassen mit der Geometric Network Class verbinden.

14.11.2 Verbindungsregeln der Netzwerke erstellen

In einem Netzwerk gibt es zwei mdgliche Verbindungen zwischen den Komponenten:

die Kanten-Knoten- und die Kanten-Kanten-Regeln.

WICHTIG: Bereits erstellte Elemente kénnen durch Drag & Drop aus dem Model

Explorer in die Zeichenflache verschoben werden. Dabei werden jedoch die
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angeknupften Beziehungen automatisch auch gezeichnet. Wenn mehrere
Elemente so in die Zeichenflache eingefugt werden, kann das Ganze sehr
unubersichtlich werden. Deshalb werden vor dem Definieren der
Verbindungsregeln alle Elemente (normalerweise Subtypes der Klassen), welche
fur die Regeln verwendet werden, aus dem Model Explorer in die Zeichenflache
verschoben und die Verbindungspfeile, welche automatisch erscheinen, geléscht.

Sie werden dabei nur visuell geloscht, im Modell sind sie immer noch enthalten.

14.11.2.1 Kanten-Kanten Regeln erstellen

Eine Kanten-Kanten-Regel ist eigentlich eine Kanten-Knoten-Kanten-Regel, da

Kanten nur Gber Knoten miteinander verbunden werden kénnen.

Eine Kanten-Kanten-Regel wird mit Hilfe einer N-ary Association ‘_?_' Vorlage, welche

zwei Kanten mit maximum sechs Knoten verbindet, erstelit.
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TStueck10x10x10
-Verbindungstyp : esriFieldTypelnteger = 101010

5
o
)
Q
HL100 HL100
-Leitungstyp = 100 ConnRule» Leitungstyp = 100
TStueck10x10x04

-Verbindungstyp : esriFieldTypelnteger = 101004

TStueck10x10x10
-Verbindungstyp : esriFieldTypelnteger = 101010

5
@©
®
Q
HL100 HL100
-Leitungstyp = 100 «ConnRule» Leitungstyp = 100
TStueck10x10x04

-Verbindungstyp : esriFieldTypelnteger = 101004

1. Aus der UML Static Structure Vorlage durch Drag & Drop eine N-ary
Association in die Zeichenflache einfligen.

2. Doppelklick auf die Verbindung und bei Stereotype aus der Dropdown-Liste
ConnRule auswéhlen und die Anzahl der Verbindungen (End Count) anpassen.
Mit OK bestatigen.

3. Verbinden Sie die gewlinschten Klassen.

Wieder Doppelklick auf die Verbindung, unter Association Ends das Ende
auswahlen, welches als Default-Einstellung verwendet werden soll und auf
Properties klicken.

5. Unter Stereotype Default einsetzen.

. @arc
Anleitung ArcGIS FS11 “GIS 14-16



14. Datenmodellierung mit Visio

7.

Rechtsmausklick auf die erstellte N-ary und Shape Display Options...
auswahlen. Im Fenster UML Shape Display Options nur die Option Stereotype
eingeschaltet lassen.

Wiederholen Sie die Schritte 1 bis 6 fir alle Kanten-Kanten-Regeln.

14.11.2.2 Kanten-Konten-Regeln erstellen

Eine Kanten-Knoten-Regel legt alle Typen von Knoten fest, die mit einer Kante

verbunden sein kdnnen und auch wie viele sie von jedem Typ (cardinality) haben

mussen.
TStuecki0x10x04 HL100
-Verbindungstyp : esriFieldTypelnteger = 101004 -Leitungstyp : esriFieldTypelnteger = 100
0.2 2
TStuecki0x10x04 HL100
-Verbindungstyp : esriFieldTypelnteger = 101004 -Leitungstyp : esriFieldTypelnteger = 100
0.2 2
1. Aus der UML Static Structure Vorlage durch Drag & Drop eine Binary

6.

Association in die Zeichenflache einfligen.

Doppelklick auf die Verbindung und bei Stereotype aus der Dropdown-Liste
ConnRule auswéhlen und mit OK bestéatigen.

Verbinden Sie die gewlunschten Klassen.

Wieder Doppelklick auf die Verbindung und unter Association Ends den Enden
die entsprechenden Multiplizitat zuordnen. Falls diese in der Dropdownliste
nicht vorhanden sind, kédnnen sie ins Feld geschrieben werden.
Rechtsmausklick auf die erstellte Binary Association und Shape Display
Options... auswahlen. Im Fenster UML Shape Display Options nur die Option
End Multiplicities eingeschaltet lassen.

Wiederholen Sie die Schritte 1 bis 5 fir alle Kanten-Knoten-Regeln.

14.12 Ein Modell als XMI exportieren

Bevor Sie ein Geodatabase-Schema von ihrem UML-Modell generieren kdnnen,

miuissen Sie es zuerst als XMI exportieren. Die Werkzeuge, um das UML-Modell als

XMI zu exportieren, sind in Visio enthalten.

1. Tools in Visio Toolbar > Add-Ons - ESRI XMI Export anwahlen.
2. Ein Directory auswéahlen wo Sie das XMI-File speichern méchten.
3. Den Namen des XMI Files angeben.
4. Speichern um das UML-Modell zu exportieren.
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5. OK klicken.

14.13 Das Modell auf Fehler iiberpriifen

Mit dem Semantics Checker kdnnen Sie Uberprifen, ob ihr Model giltig ist.
1. Tools in Visio Mentuleiste > Macros - ESRI - SemanticsChecker anwahlen.
2. Selektieren Sie das Modell, welches Sie Uberprufen méchten und wéhlen Sie
dann Check.
3. Der SemanticsChecker Uberpruft nun ob ihr Modell gultig ist und gibt dann

eine entsprechende Meldung aus.

14.14 Schema in ArcCatalog generieren

Das Programm ArcCatalog enthalt die Werkzeuge um XMI-Files zu lesen.

14.14.1 Schema Wizard-Command in ArcCatalog einfiigen

ArcCatalog starten
Tools anklicken und Customize auswahlen
Commands Tab anklicken

CASE Tools in der Kategorienliste auswahlen

o hr wNPE

Durch Drag & Drop den Schema Wizard-Command in die Toolbar einfligen.

14.14.2 Arbeiten mit dem Schema Wizard
14.14.2.1 Das XMI File lesen
1. Eine neue Geodatabase erstellen.

2. Schema Wizard Knopf anklicken um den Case Schema Creation Wizard zu

starten. Weiter nach der kurzen EinfiUhrung mit Next.
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3.

" Schema Wizard

This wizard will help you create a geodatabase
Case schema for a UML object model

XMI or Object models are created using Object Oniented
R . Analysis and Design (00AD] tools, then exported to
epos 1to rg an intermediate format, the Microsoft Repository or

an XMl file.
GeoDB , _ _
You will be required to connect to the Repository or
Schema XMl file, then select the obiject model, and lastly.
defiﬁ the characteristics of each element in the
model

[~ Skip this screen in the future.

Cancel |

Gewilnschte XMI-Datei auswéahlen und auf Next klicken.

14.14.2.2 Raumliches Bezugssystem (Spatial References) definieren

1.

Klicken Sie auf das Feature Dataset fur welches Sie die Anpassungen
vornehmen wollen.

Klicken Sie auf Properties... um die Eigenschaften fiur diese Feature Dataset zu
setzen. In UML kénnen keine raumlichen Bezugssysteme (Spatial References)
modelliert werden. Darum miuissen diese nachtrdglich beim Exportieren
angegeben werden.

Klicken Sie Edit und geben Sie das radumliche Bezugssystem an.

Anschliessend durch OK bestétigen.

14.14.2.3 Héhen (Z-Values) und Distanzen entlang von Linien (M-Values) hinzufiigen

1. Klicken Sie auf die erste der beiden Feature Classes die durch eine Attributed

Relationship Class miteinander verbunden sind.
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2. Klicken Sie auf Properties, um die Eigenschaften dieser Feature Class zu
setzen.

3. Unter dem M/Z-Tab Shapes in feature class contain M values anklicken und
durch OK bestéatigen.
Die Schritte 2 und 3 fur die zweite Feature Class wiederholen.
Am Ende Next and Finish klicken.

Kontrollieren Sie das Modell in ArcCatalog.
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